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notes

With MOOSE PETERSON

Wildlife Photography: Staying True to the Craft

Moose Peterson
Wildlife & Aviation Photographer

Moose’s passion lies in photographing and bringing attention to endangered wildlife and  
preserving the role aviation has played in history. Along the way, Moose has been honored  
for his photographic passion as a Nikon Ambassador USA, Lexar Elite Photographer, and  
recipient of the John Muir Conservation Award. He shares his knowledge through his  

writing, being published in more than 143 magazines worldwide and authoring 28 books. 

The Craft and Rewards of Wildlife Photography
It was bone-chilling cold! Just grabbing the tripod out of the truck from the 
short ride up to the trailhead made it numbing to the hands when I set it up. 
Slowly, with gear set up and daypack packed, up the trail I headed into what 
appeared to be the clouds racing down to meet me. The minimal clothing I wore 
was still too much as I quickly warmed up, heading up the valley. I could see my 
desination up in the mist and it didn’t look inviting. It was Octber, snow was in 
the air, and that’s exactly how I wanted it!

After a couple of hours, I reached my perch overlooking the valley below. I set 
up my chair, got out my puffy jacket and gloves, and snuggled in for the wait. 
The binoculars were busy looking left and right, up and down, looking for my 
quarry. They can completely disappear, leaving only the slightest hint of their 
presence sticking above the grasses. Completely tuckered out by their nighttime 
activities, they rest up and save calories, sleeping the morning and much of the 
afternoon away. While this doesn’t help to take photographs of these incredibly 
majestic critters, that’s their biology this time of year. So I waited.

Then a sound echoed across the valley, and I could see movement. First, the ears 
of the resting giant started to spin, locating the moan echoeing off their large 
racks. Then the head turned; the ears were rigid. Finally, the seven-foot giant 
emerged from the foot-tall grass as it rose to investage the sound more closely. 
The Alaskan bull moose, within second, was now standing upright in front of 
me! To get that photo of this sentinial of Alaskan wilderness, a little cold, a bit of 
walking, and a parcel of waiting is required this time of year. But once they get 
busy with the rut, that all melts away and the camera’s shutter gets no rest tak-
ling all the photographs. That’s the craft and rewards of wildlife photography!
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Knowing Basic Biology
Where’s the best place to start absorbing basic biology? From that favorite arm-
chair, of course. Learning basic biology can be done by simply watching televi-
sion. In this day and age, there are lots of great programs (and some that really 
suck, especially on grizzly bears) that can aid you in your quest for knowledge. 
Though many nature programs are staged, the actions of the wildlife are none-
theless genuine. The learning that can be done from watching and observing is 
amazing! I still watch and learn from them.

There are many examples of great programming, such as numerous excellent 
programs on hummingbirds, one of my favorite subjects. By watching them on 
television, we can see how they approach and retreat from a flower when feed-
ing. We can also get a feel for how long they spend feeding on one flower. We 
can take this knowledge into the field and prefocus on and preframe a flower in 
preparation for the bird’s arrival. By understanding that they come in low to a 
flower and hover, we’ve increased our opportunities to successfully photograph 
them!

One area of photography most wildlife photographers don’t venture into is noc-
turnal. If you want to see what you’re missing, ideas of where to go, and when 
and what you might find, just watch any one of the many great programs on 
nocturnal wildlife. I have taped many of these programs strictly because of the 
insightful information they contain. It has saved me years of painful trial and 
error, working with a truly unseen subject!

There is more learning to be gleaned from watching television. The moving 
images on television provide insight into the animal’s behavior and how it uses 



7

Wildlife Photography: Staying True to the Craft
With MOOSE PETERSON	 notes

the

its habitat. It gives hints as to the time of day the species is active and any 
associated problems when photographing during that time of day. The obser-
vant TV watcher can see how the species communicates its actions prior to 
executing them, something that all wildlife does and that we can use to our 
advantage! It can even provide possible clues about where to go to photo-
graph that particular species.

You need to start filling the shelves of your mental library (and office library, 
as well) with what I term nature trivia. Reading is the best way to do this. 
There are, for example, many excellent magazines on birding. Birder’s World 
and Bird Watcher’s Digest are two excellent magazines that discuss the world 
of birds, where to find them, their habits, and in many cases, how others have 
gotten close to them. (Unfortunately, comparable magazines devoted to 
mammals aren’t available, but you might try Nature, Smithsonian, or Natural 
History for their occassional look at mammals.) 

These are great beginning references, but there are even more specialized 
magazines, called journals, which provide a wealth of information (many can be 
found on the webl). The AUK, The Condor, Journal of Mammology, and Journal of 
Conservation Biology, plus tons more, are written by the scientific community for 
peer review. It isn’t necessary to be a rocket scientist to understand what’s writ-
ten. The methods section of these papers are particularly useful.

In this day and age, the web can be a killer locale to find biological material. Do 
a search on the species name, birds or mammals in general, as well as the state 
game department where you live. The real trick to getting the most out of these 
pages is to read them carefully and explore the links they provide. Too many 
folks want instant answers from a website and do not take the time to read and 
explore them. I can guarantee you that the web is an incredible wealth of bio-
logical information you can find and trust. I know I do on a near-daily basis.

For example, suppose you want to photograph the nocturnal habits of a 
kangaroo rat. Look up kangaroo rat in general, or the specific species in the 
index, and find the papers that deal with that topic. Next, the method section 
in that paper will outline how kangaroo rats are found, what is used to lure 
them, what time at night they come out, what time of the year is best to see 
them, and if there are any special precautions needed to protect their welfare. 
Further reading might reveal such added insight as key behavior to anticipate 
and photograph. In fact, if you search this particular subject on the web, the 
majority of the time, you’ll find the articles illustrated with my kangaroo rat 
photos. The info is out there in book, magazine, journal, and web form. You’ve 
just got to do a little homework!

Reading specific books on a species to be photographed will further open 
doors to its biology. One of the wildlife photographer’s greatest resources is 
the library of the local natural history museum. I was very fortunate to have 
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one of the best in Santa Barbara, where I spent hundreds of hours reading. 
Librarians in these specialized libraries can point out the most current books 
on the species you’re researching, and in many instances know of current 
articles and other resources available to aid you. 

Many state wildlife departments (such as California Department of Fish and 
Game in my home state) and the U.S. Fish and Wildlife Service publish reports 
on a wide variety of topics, covering our natural heritage. Many of these free 
publications can add a great deal of understanding of basic biology. This is 
one of the greatest untapped resources available to everyone. They also have 
huge websites with many of their own journals and biological descriptions 
online. One note of caution: These sources are usually dated by the time you 
read them. Check the publish date of the books and the dates of the research 
in the journals. Even though the information was extremely accurate when it 
was done, don’t think of it as the final word on the subject. I can’t remind you 
enough, this is a constant learning process—no one has all the answers!

I personally have a huge library of reference books in my office (NHBS 
Enviromental Bookstore [http://www.nhbs.com/] is my secret source for 
books). There are a number of publications that only a crazed soul like myself 
would want, but others are basics, which all wildlife photographers should 
have on their shelves. The first is a bird identification book such as Sibley’s 
or the National Geographic’s. This should also include volumes on mammals, 
reptiles, or insects, if that’s your interest. Not only do these books tell how to 
identify a particular species, they also provide general biological information.

Those who are interested in birds must have A Field Guide to Nests, Eggs, and 
Nestlings of North American Birds. This book provides critical information on 
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the nesting biology of all the birds in North America. It gives nest location and 
season, incubation, nestling and fledging times, parenting behavior, and much 
more. This is a must in every wildlife photographer’s library!

Before you even leave the house, become a general expert on the species. 
Once you leave the house, you can compare what you’ve read with what 
you’re seeing and fill in the holes not covered in your reading. One thing most 
rarely gotten from booklearning is generally termed “reading sign.”

Reading sign is really no more than observing and understanding what wildlife 
are communicating. A good example involves raptors and their defecation. 
Just before a raptor (hawk, eagle, or owl) is about to leave its perch and take 
flight, it will get rid of a little extra weight by defecating. So, when approach-
ing a raptor, if it defecates, be aware it’s about to take flight and take the 
appropriate action.

On that same note are the clues whitewash leaves behind. You find a locale with 
lots of whitewash, what does that tell you? You know it’s a place where a raptor 
often perches. If you want to get the shot, you just need to wait. What about 
whitewash and little pieces of bone or skull? What does that tell you? It tells you 
that it’s a perch for an owl more than likely. What about finding a lot of white-
wash on the ground at the base of a tree? If you look up the tree to find the 
source of the whitewash and you find a nesting cavity, you’ve found an active 
nest. This is how I found a nesting northern saw-whet owl’s nest one year.

Reading sign doesn’t require putting on a coonskin cap and becoming Davy 
Crockett. Listening to the call of a bird, tracking its origin, and retaining the 
information is lots of fun. Learning calls can also be key in knowing if an owl 
is in the area and if jays are mobbing the owl. This is just one example of how 
easily detected and useful sign can be in photography.
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Reading sign also comes in direct forms. When approaching a wild animal, it 
communicates in no uncertain terms what it’s feeling about your encroach-
ment. The one thing we hope to see and have communicated to us is the 
single glance from the critter and then a return to activity. It is only by careful 
study and observation of the subject that we can safely and successfully get 
close to the subject! Getting close requires that you always, always, always 
watch the subject! They will always tell you, I guarantee you, just what they’re 
thinking. The trick, as it were, is to be able to read that sign!

I’ve already mentioned how raptors defecate before taking flight. Many birds 
will fluff up their feathers when they’re uncomfortable. Some birds will change 
which foot they are standing on prior to leaving. That’s if they don’t just start 
moving away. Many times, birds do what is called displaced aggression. When 
a bird is feeling stressed by an outside presence, it will act very nervously and 
take out its frustration on a mate, another bird, a twig, or a leaf. 

Mammals have various ways of showing their discomfort, most being com-
municated through the eyes and ears. If you’re working with a cow moose and 
she lowers her ears, you’d better know she is not just disturbed but is prob-
ably pissed off. No photograph is worth risking the welfare of any subject! 

Knowing basic biology enables you to understand the signs I’ve just men-
tioned, plus the hundreds of others that let us know we’re doing something 
right or wrong. This prevents careless accidents and injury to wildlife. As I said, 
knowing basic biology is just understanding what wildlife is communicating.

The biggest photographic benefit in knowing basic biology is getting close physi-
cally. By knowing what a critter might be communicating, you can act accord-
ingly, which includes knowing which direction to head or not, as well as how close 
you can get. You still might be wondering just how this all falls into place—basic 
biology and getting close physically—so let’s discuss a couple of scenarios.

During the spring, wildlife does what comes naturally, the birds and bees 
thing. During this time of courtship, males especially are interested in finding 
a mate. (Sex is one of the best things to have on your subject’s mind when 
you’re trying to get close physically.) During this time of, let’s call it preoccu-
pation, males throw caution to the wind, and for photographers, this means 
getting in close physically is a whole lot simpler.
 
Understanding the different bird species’ style of attracting mates is of enor-
mous value. Each species has a different methodology for attracting a mate. 
If it’s drumming from a particular log, then you have an idea where to set up. 
If it requires singing from atop a perch, once you find that perch, you know 
the male will constantly return to it. Males establish territories quite often and 
defend them against other males. They constantly traverse their territory, sing-
ing from chosen perches. Knowing this, you can find the best perch for pho-
tography and set up on it instead of chasing the bird.
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During the nesting season, knowing basic biology permits you to sleep in. 
Males tend to sing when there’s sun and it’s not windy or breezy. When that 
alarm clock goes off and you look out your window and you don’t see the sun 
or it’s breezy, you can go back to sleep, knowing that the males won’t be out 
singing. Just be sure that the weather where you’re staying is the same as that 
where the birds live and you’ll be okay. This doesn’t hold true, though, at other 
times of the year or for mammals. 

Certain species only display their special ornamentation during the breeding 
season. The male greater sage grouse only fans his tail and inflates his air sacs 
for a brief period during the spring. The male red-winged blackbird only flash-
es his red shoulder patches during the spring. If the goal is to capture these 
seasonal shows, you’d better understand when and how these species display 
to attract their mates.

Mammals are a little more difficult. Males don’t tend to flash bright colors or 
sing from atop a perch. Mating also takes place for many mammals in late fall, 
rather than in spring as with birds. Elk bugle for mates and have their shov-

ing matches in late fall. The mighty clashes of bighorn sheep ring through the 
mountains in late fall, as do the sounds of tangled mule deer antlers. Be aware 
that mammals with antlers (deer, elk, moose) shed their antlers in late winter 
to early spring. Photographs of a bull moose with a large rack are best shot in 
late fall, once they have shed their velvet and are in their prime. A bull without 
its rack, at first glance by the public, looks like a cow. If you want a bull photo, 
then you need to be at the right place at the right time to capture the rack!

You won’t miss events if you keep in mind that you live on a round planet. In 
Alaska, in the northern latitudes, for example, the breeding season for birds 
typically runs from June to July; whereas, in Southern California and Florida, 
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it’s more likely to be in early April. Doing basic research on the nesting or mat-
ing biology of a species will reveal such information, thereby preventing the 
mistake of traveling to a region for events that are past or have yet to occur.

There is really a threefold benefit to knowing basic biology: getting in close 
physically, getting better photographs, and protecting the welfare of the wild-
life. Getting in close physically is an obvious benefit to better photographs. 
Simply by cutting the distance between the subject and the camera by half, 
a 400mm lens can have the effective magnification of an 800mm lens. But 
understanding basic biology has other, potentially greater benefits than just 
getting in close physically for better photographs.

One of the greatest benefits of understanding basic biology is knowing when 
an event is going to happen. One of the biggest reasons I work with biologists is 
because their knowledge aids me in capturing those unique moments on film (as 
well as in safeguarding the species’ welfare). Let’s face it, only so many wildlife 
portraits can be taken. The most exciting photographs and challenges in wildlife 
photography come from capturing the wildlife in action. If, through basic biology, 
you can understand that the subject is communicating its next action, captur-
ing that action on film is not such a challenge. Knowing that a subject is going 
to move and having an idea what direction and when, you can have yourself and 
your gear ready in a heartbeat to capture it. You’ll find that learning basic biology 
not only benefits your photography, but also it’s fun!

This seems so obvious, yet it’s still one of the greatest untapped principles in 
wildlife photography. Set your camera’s motordrive to Continuous! 

A heron is in the Everglades, standing pefertly still in the water with its gaze 
piercing the surface. You’d better have that motordrive set to astro blast and 
the metering set, because at any second, that heron is going to stab in the 
water to catch a fish. This means you need to be prepared! You need the fast-
est shutter speed available, enough room in the frame for the neck of the 
heron to grab the fish and not be out of the frame, as well as any other com-
positional considerations you need to make prior to the action. Knowing basic 
biolgy has you prepared to capture the event!

A coyote prowls a meadow. Suddenly it stops and cocks its ears straight forward. 
Slowly it looks down, pointing its nose like an arrow. Once again, have the cam-
era’s motordrive set to astro blast, metering set, and room in the frame for the 
coyote to first jump up and then out. By its movements, the coyote is telling you 
it has heard a vole and is zeroing in on the noise. Homework done, you know coy-
otes pounce on prey like a cat, up and then out. Know your basic biology so this 
marvelous event goes home on film and not just as a memory!

You’ll get better photographs by knowing basic biology and properly select-
ing your equipment. You should only travel into the field with the equipment 
needed for that particular shoot. For example, you probably wouldn’t use a 
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600mm lens to photograph a hummingbird’s nest or try to use a 200mm to 
photograph an eagle’s nest. Likewise, going to photograph kangaroo rats, you 
wouldn’t go without a flash. Understanding the basic biology of the subject 
lets you prepare for any possible problems that might arise when photograph-
ing it. This, in turn, allows you to travel light, carrying only the equipment you 
need. The moral is: take all your gear with you to the locale, but only take that 
equipment into the field that solves the immediate problems of getting the 
particular photograph.

The welfare of the species is the biggest reward in understanding basic biol-
ogy. Ethics in wildlife photography is a gray area where there are no written 
guidelines for every possible situation. But the gray area never has to be a 
problem if you understand basic biology. You’ll never stress or harass wildlife 
(which is illegal and ends up showing in your photographs) if you understand 
what it’s communicating. You’ll never worry if you were responsible for a nest 
failure or a young calf being taken as prey if you understand basic biology. 
You’ll never have to worry that you’re part of this huge problem rather than 
part of the solution!

Basic biology can also add to your personal protection. A grizzly mauling a 
photographer is nearly an annual event and has always been the fault of the 
photographer doing something they should have known not to do. An elk or 
bison goring a photographer. A rattlesnake biting a photographer. These need 
never happen if the individuals understand basic biology. You can get close 
enough to bison in Yellowstone to photograph them with a 20mm, so why 
take the risk when you know they just love goring tourists? And for goodness’ 
sake, never chase a bear, especially a grizzly, over a ridge. Not only are you 
risking your own safety, but that of the griz if the grizzly does anything to protect 
itself from you. No photograph is worth risking the welfare of any wildlife!
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Techniques
Success in getting close to wildlife starts before leaving the house. Aftershave, 
perfume, scented deodorants, scented laundry detergent, and other unnatu-
ral scents won’t help in getting close. They don’t guarantee you won’t be 
able to get close, but they can make the difference when you’re working with 
an already shy subject. Picture the dirt cloud that surrounds Pig Pen in the 
Peanuts comic strip, and then imagine it as a scent, and you have an idea of 
the cloud of smells around you. I’m not saying to leave the house without 
showering or washing your clothes, or that you need to roll around in the dirt 
once on-site. I’m recommending unscented products. Leave smelling good for 
when you get back home. Rolling around in the grass or buying hunting scents 
is not required to get close. Just be neutral smelling.

The next consideration is the equipment you’re dragging—I mean carrying—
into the field. You should be carrying only the equipment you need for that 
particular photographic adventure. What about those times when you’re just 
going out to see what’s about and have nothing specific in mind to photo-
graph? You should still take what you’d use for photographing either birds, 
mammals, flowers, or bugs, but not your whole camera bag. The goal is to min-
imze our own profile so we blend in better with the world around us.

One of the great benefits of shooting digital is the ability to slim down. Not 
having to wear a photo vest, with bulging pockets of film sticking out from 
my side and making noise, is just fantastic! I can carry nearly the equavilant of 
100 rolls of film in a case that fits into a shirt pocket by shooting digital. I wear 
a small fanny bag that hides behind me so my profile is as small as it can be, 
while still leaving me able to operate photographically.

I once watched a photographer, loaded to the gills with equipment, approach 
an incredible scene with two gray foxes. They were completely wrapped up in 
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playing in the sun and had no idea that anyone was watching. Since the other 
photographer had seen them first and was already approaching them,  
I just stood back and watched the moment. Well, he got right up on the foxes 
and had a great shot in front of them. He slowly and properly took his tripod 
mounted rig from his shoulder and set it down. Just then the camera bag, 
hanging from his shoulder slipped down his arm. He jerked to catch it but it 
was too late, the foxes were alerted to his presence and were gone in a flash.

Limit what you’re carrying and how you’re carrying it. Fanny packs are a 
good example. Most are made of nylon, which is a drawback. Their buckles 
can be the biggest problem. The “click” noise of the buckle as it’s coupled or 
uncoupled is at the perfect frequency for mammals’ hearing. I don’t know if 
it’s the same as a snapping branch or just super-foreign, but they run from 
that noise lickity split!

Naturally, you might be asking if knowing basic biology allows you to just 
walk right up to wildlife. Well, not exactly. There’s a little more to it than just 
walking up and taking the photograph. In summation, it requires physically 
moving closer to wildlife, stalking.

Moving Closer to Wildlife: Stalking 
Stalking is a term with a fuzzy past and with connotations of having to be a 
ninja photographer. Traditionally, stalking is thought of as a process of mov-
ing closer to wildlife by using every rock, bush, and/or tree for cover, requir-
ing some elaborate zig-zag walking strategy to hide behind each obstacle. 
Who’s kidding who? Are most animals so stupid that they don’t know when a 
person is approaching them, especially a pesky photographer? Besides, what 
subject hangs around long enough for such antics?

Yes, there are times when wildlife turns a blind eye to the photographer. And 
thank goodness, or else we wouldn’t get the photographs we do. The point is 
to use sound basic biology and not some stalking voodoo to get close physi-
cally. This basically means that when I’m out shooting, I tend to walk straight 
towards the subject. And let’s face it, there are very few rocks or trees that 
are going to hide me, carrying a 600mm lens on my shoulder. I might use 
an available shrub or rock if it’s on the path towards the subject, but I don’t 
go out of my way to use them. The wildlife will either stick or flee with my 
actions hopefully putting the wildlife at ease and so remain. 

Before even starting the stalk, here are a few guidelines. First, do you have 
any camera straps dangling from your camera or lens barrel? These are 
strong vertical lines, something wildlife (especially wary mammals) look for. If 
it’s a shy subject and you have a strap swaying as you’re walking, you might 
not get close. Next, are there any natural obstacles between you and the sub-
ject? Water, holes, logs, or any other obstacle that must be circumnavigated 
determines, in part, your path. Mentally map out a path—one with the fewest 
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obstacles to hamper a graceful approach—and then select a stopping point 
where the desired image size can be captured. Lastly, we must make sure that 
our actions will not jeopardize the subject’s welfare.

With all of this thought through, we can start approaching the subject. Always 
keep in mind that, whether it’s a mammal or bird, at any moment it could 
just disappear and we’re skunked. That’s part of the game. More than likely, a 
higher precentage of stalks are successful if we’ve done our homework. This is 
due to the fact that each individual subject has its own zone of safety. When 
we recognize the sign of this zone, we avoid entering it and causing the sub-
ject to take flight. A knowledge of basic biology enables us to see the signs of 
flight before they happen, and gets us the best possible photographs from the 
situation. Right?!

Many people concern themselves with being up, down, or crosswind during a 
stalk. This may get them close, but maybe not. Make the most of the experi-
ence by approaching in the direction that gets the best photograph (generally 
determined by the light more than any other factor). What good is getting in 
close, coming downwind, if the resulting photograph fails because of lighting, 
background, or any other distraction? Hey, the whole purpose of photography 
is to have fun, so remember that sometimes the great photograph just won’t 
happen. With neutral smell and an understanding of basic biology, the chanc-
es are good for that close approach, no matter which way the wind blows.

When handholding the camera, stalking is a lot simpler. Walk with even, slow-
paced strides, avoiding at all costs fast, short, jerky steps. Smooth, fluid steps 
(avoiding any twigs, if at all possible) put the wildlife more at ease. The cam-
era should already be just below chin level so that the motion of bringing it 
to the eye is minimal. Raise the camera to your eye in a slow, fluid motion, 
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keeping elbows tucked in, focusing and operating the camera in a like manner. 
Any sharp, quick movements imitate the movement of predators just prior to a 
strike. As far as the subject is concerned, a stalking photographer is a predator. 
They’re unaware that no harm is intended.

The handholding photographer is able to walk a much easier path compared to 
one with a tripod rig. Thus, stalking is easiest when handholding, since there is so 
much more flexibility in movement. For example, walking over a fallen log is not an 
option available to the tripod-bound photographer. The speed of taking the shot 
is much greater for the handholding photographer as well, since they can have 
instant response time to any action on the part of the subject.

The advantage of the tripod-bound photographer is the tripod with its mount-
ed lens. The fallen tree, boulder-strewn stream, and other natural obstacles 
might impede progress, but the tripod and its shape more than make up for it. 
Wildlife generally understand that an upright shape with two legs is a human 
(predator). This frightens them. But with the tripod and lens in tow, that basic 
form is broken up, ever so slightly, but enough to decrease the chances of 
spooking the prey. This is especially true if you arm-press the tripod, carrying 
it directly in front of you. This really breaks up the human form, and in many 
instances, increases the zone around a critter in which it feels safe. This permits 
you to physically get closer.

There are two ways to physically carry a tripod-bound camera setup. For cov-
ering long distances, the “over the shoulder” approach is best. The tripod legs 
are either spread wide open, if space permits, or closed up. In either case, the 
legs are extended to the correct height for shooting. Before the shooting range 
is reached, slowly and smoothly lower the rig from the shoulder by lowering 
the body rather than lifting the rig high over the head. Lower it and set it up in 
a smooth fashion. Make sure everything is ready to shoot. (Note: When setting 
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the tripod down, avoid setting the legs on any small rocks that might give way, 
cause noise, and provide an unsteady platform to work from.) 

With the tripod set up and aimed at the subject, advance slowly. This is done 
by just raising the tripod slightly off the ground and moving it up slowly at 
arms length, setting it down, and walking up behind it. What’s going on is that 
the animal is connecting with the tripod and setting it as its safety zone limit. 
(Remember, this is a generalization from basic biology.) As long as the photog-
rapher stays behind the tripod, that safety zone is preserved. This will give the 
animal the feeling of being “safe.” This process of moving closer is carried out 
until the appropriate distance is reached (or the wildlife leaves). 

One thing to always keep in mind while approaching wildlife is that massive 
gazing eye, the lens. The front element of a 122mm- or 160mm-class lens is like 
a giant eye that, believe or not, winks. To observe this, set it up and look at it 
from the subject’s point of view. When your eye is behind the viewfinder and 
viewing through the lens, the “eye,” or lens, is just a big, dark circle. But when 
your eye is removed from the viewfinder, light streams through the viewfinder 
eyepiece and through the front element. Now the eye is a big white circle. Put 
your eye back to the viewfinder and it turns black again. It winks! Most photog-
raphers are constantly looking through their lens, then they’re not, then they 
are, then not. Black, white, black, white. This will make anything nervous and 
a shy subject flee! If there is any question that this is happening, just close the 
viewfinder eyepiece curtain when not using the viewfinder so that the “eye” is 
always dark.

Speaking of eyes, keep an eye open not only when shooting, but also when 
walking through an area. Normally, where there’s one subject, there are more. 
We’ve all heard the saying that there’s safety in numbers. Well, wildlife is no 
exception. It’s easy to be so completely and totally zeroed-in on the one subject 
that obvious secondary wildlife is totally missed! Basic biology won’t help here; 
good eyes and ears and a mind that’s open and alert to the environment will. 

This also means distinguishing the movement of wildlife when hidden. The 
breeze can play tricks on a stalking photographer whose concentration is on 
any movement. Be aware of the habitat and its response to a breeze. Most 
inanimate objects move in a fluid motion in a breeze. A bird, on the other 
hand, when moving about a bush, will cause the vegetation to move in a sharp, 
jerking motion as it passes from branch to branch. Sounds of mammals pass-
ing underneath brush make sharp noises rather than the mellow sounds of a 
breeze rustling the branches. Your ears are a critical tool for getting physically 
close to wildlife!

Listening is a very important part of stalking. This includes hearing the noises 
made by wildlife and your own noise. Each species of bird has its own identi-
fying call, plus a variety of other calls used for communication. Knowing the 
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difference between a normal call and a warning call is important. Many small 
mammals make very high-pitched warning calls that sound very much like 
bird calls. You need to be able to distinguish these sounds in order to take 
advantage of them for better photographs.

Sounds in the wild are also important in getting close physically. The sound of 
a branch falling on the ground as opposed to a branch being stepped on by 
a large predator, the sound of a distant creek and the wind whistling through 
the pines, the scraping on the pine tree caused by a limb rubbing on the bark 
rather than a northern flying squirrel scampering up that same tree—distin-
guishing among these is vital in stalking.

Biologists have devised a number of techniques for surveying native habitat. 
One method is directly applicable to photography. It has been determined 
that to accurately survey a particular location, the biologist must arrive at a 
spot and remain there silently for at least 10 minutes. This 10-minute adjust-
ment period is the time required for wildlife to adjust to the presence of the 
biologist before going back to a normal routine. 
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When traveling through any area where no wildlife is readily seen, stop for 
10 minutes. During this time, prepare the equipment to shoot. Listen for the 
area’s return to life as it adjusts to a foreign presence. Shooting opportuni-
ties should occur in a relatively short time or at a short distance away. This 
basic technique comes right from the methods sections of biological journals. 
It doesn’t guarantee great photographs, but does provide the best possible 
odds for taking a photograph.

Combine biology with technology, and using basic biology is the key to your 
success!
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With KAYLEE GREER

Secrets to Creating the Best Dog Photos

Kaylee Greer
Pet Photographer, Educator and Dog Whisperer

Kaylee Greer is an internationally recognized private and commercial pet photographer. She is 
living out her dream through a camera lens in gorgeous Boston, Massachusetts. She’s traveled 
the world teaching pet photography workshops and has seen her work published in many major 
industry editorial titles. Her images grace calendar lines, greeting cards, products, packaging and 

advertising campaigns throughout the commercial pet industry. Her photographic style is drawn directly from the 
inspiration she finds inside the soul of a dog. She is fueled by the joy, whimsy and unrelenting happiness that is so 
uniquely canine. Kaylee is known for her love of vibrant colors and unique process of capturing the comedy and 
character of dogs. Through her business, Dog Breath Photography, it is one of Kaylee’s strongest passions to give 
a voice to the voiceless by volunteering her time to local shelters and photographing the abandoned and home-
less animals who lie in wait for a second chance.

Why Dogs?
Why is it so important to capture the tiny moments that preserve the legacies of 
our best friends?

Speaking Dog: The Importance Dog Body Language
How to read and interpret 
canine body language for a 
successful photo shoot:

Because you know your own 
dog very well and he’s become 
comfortable with you and your 
energy, it’s possible that you 
may not notice many of these 
signs with him. However, it’s 
very important to know what 
to look for when working with 
dogs who you’re only just 
meeting for the first time. The 
chart below illustrates the most 
common canine body language 
signals that communicate fear 
and aggression.
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Real Life Example: Close Call
What body language do you see in this image that suggests territorial aggres-
sion or discomfort in the subject?

Choosing Location
When you’re choosing a location for a photo shoot with a dog, there are going 
to be factors you must consider that you may never have considered before. 
When working with dogs, it’s important to get to know a little bit about their 
personalities, strengths, and weaknesses before setting up your shoot and 
choosing a location.
						    
Tip: It’s helpful to begin by sending your clients a questionnaire before the 
photo shoot that they can fill out about their dogs. This way, you’ll be prepared 
with knowledge about the dog’s personalities, likes, dislikes, fears, etc. so you 
can come equipped with the proper ammo to keep your model safe, interest-
ed, and engaged. This questionnaire will also let you about what might distract 
your four-legged subject, what might most motivate them on-location, etc. 
This will all be extremely valuable knowledge that will help ensure a successful 
photo shoot.
						    
Once you know more about your dog model’s personality, you’ll choose a loca-
tion based on that. Unlike working with people, when you’re working with a dog, 
here are some new and different distractions that you will have to consider when 
choosing an ideal location:

1.  �Noise Level (Example: an urban location close to a freeway or areas with 
heavy traffic and car noises.)

With KAYLEE GREER

Secrets to Creating the Best Dog Photos
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2.  �Squirrels, birds, and other local wildlife (Certain breeds, especially hunting 
breeds like terriers and certain hounds will naturally be very, very distracted 
by animals that they consider small prey. It’s almost impossible to keep their 
attention when their primal hunting or ratting instincts kick in. So best to 
avoid areas with heavy natural wildlife population.)

3.  �Foot Traffic, Bicycles, Skateboards, Rollerblades, etc

4.  �Other Dogs (Contrary to what you might think - the dog park is almost 
always a very, very ineffective location for a photo shoot.)

5.  �Look for areas with ample shade/out of direct sunlight opportunities (In addi-
tion to the light of location also be aware of the temperature. Dogs tend to 
overheat very quickly due to their fur coat and inability to sweat. They are far 
more susceptible to heatstroke than you or I might be on a hot day. Tip: Bring 
plenty of water and give extra breaks on hot days!)

While we are dog lovers, we are also artists - and that’s why, in my opinion, num-
ber 6 is the single most important factor in choosing a location.

6.  �FIND SOMEWHERE BEAUTIFUL! It’s important to put in the effort to go 
beyond the backyard. Make your clients aware of how rewarding it will be in 
the final images to get creative with your location and seek out the perfect 
backdrop for Fido on his big day. :)

						    
Here are some examples of the very different impact that various locations can 
have in the final images:

With KAYLEE GREER

Secrets to Creating the Best Dog Photos
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The Importance of Warming your Four-Legged Model up to  
the Camera
						    
Click and Treat!					   
There’s a little trick in dog training called ‘positive reinforcement’. I utilize this 
concept at each and every shoot I ever do to create a positive association in that 
dog’s mind to my camera. Each time I click the shutter of the camera, I give the 
dog a treat (or, for non-treat motivated dogs, another type of reward will do.)
						    
Do not just jump immediately into snapping photos of your dog without effec-
tively warming him up to the camera first. To do so may be to cut the shoot off 
before it even starts by creating a fear reaction in your dog that he just can’t 
kick for as long as you have the camera out. Set yourself and your dog up for 
success!
						    
Tip: Be aware and understanding of the fact that dogs effectively ‘see’ the world 
through their noses. The strongest of their five senses, dogs noses are the medi-
um through which they interpret and make sense of the world around them. To 
understand how truly important a dog’s sense of smell is - take a look at this 
figure: Dogs possess up to 300 million olfactory receptors in their noses, com-
pared to about 6 million in humans. And the part of a dog’s brain that is devoted 
to analyzing smells is, proportionally speaking, 40 times greater than ours. What 
this all means is that it’s incredibly important to let your canine subject smell 
you, your bags, and (most definitely) your camera!
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Once the shoot begins, be sure to maintain an even, calm and positive energy. 
Dogs feed directly off of the energy of those around them. For this reason, it’s 
very important not to bring nervous, overexcited, or negative energy. It’s impera-
tive that you communicate this to your human clients as well to be sure they 
arrive happy and prepared.
						    
When I meet a dog, I feel so much joy that I think my head might pop off - all 
I want to do when they walk my way is squeal with delight and roll all over the 
ground with them. However, in reality - here’s what I have to do. Stand calmly, 
talk to the owner, let the dogs sniff me to their heart’s content, and then slowly 
make my way down to their level for a calm hello.
						    
Camera Settings
Due to the nature of dogs and their average speed of 75 gazillion miles an hour, 
it’s incredibly important that you always have your settings locked in and ready. 
Unlike photographing a person, you can’t ask the animal to stand in great light 
or look into your lens - he’s going to do only what he’s going to want to do and 
nothing more. BE READY.
						    
Keep your shutter speed fast
Ideally, I shoot all my natural light images at 1/1000th of a second or higher. This 
is precisely because I never know when a dog is going to defy gravity next and I 
need my shutter speed ready to freeze action and insatiable joy at any, unscript-
ed moment.
						    
Here are a few examples of spontaneity in dogs and why I was so grateful to 
have a fast shutter speed dialed in:



26

Secrets to Creating the Best Dog Photos
With KAYLEE GREER notes

the



27

Secrets to Creating the Best Dog Photos
With KAYLEE GREER notes

the

	
Set your aperture for artistic preference
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Single Focus Point on the Eye
Keep in mind that the shape of a dog’s face is very different than a humans. A 
canine snout is typically long and projects outward from their eyes. When you’re 
shooting at a wide open aperture, the dog’s nose and eyes are going to be on 
wildly different planes of focus. In order to nail an image, (with a few very rare 
exceptions) you’re going to want the eyes in focus. This is why it’s imperative 
not to allow the camera to choose the focus point for you - and why you should 
always set your camera to a single focus point that you manually place directly 
on the eye.
						    
Here’s an example of focus on the snout vs. focus on the eyes:

Lens Choice
						    
n �  �50mm (More traditional focal length. Arguably, the most similar focal length 

to the natural view of the human eye)
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n �  �16-35mm (Super fun wide angle! Bobbly head! A close up 16mm shot gives an 
image a sense of comedy and drama)

n �  �11-24mm (Somehow, even more extreme! Super ultra MEGA wide!)
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n �  �35mm (Slightly wide angle with tack sharpness right on the eyes) 

n �  �70-200mm (Compressed, gorgeous, creamy, bokeh background!) 
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What’s in the Bag?!
Here’s what’s in the treat bag that I bring to every shoot! We’ll go over every-
thing in here and why it’s great in the next few sections!

Great Tricks to Keep your Wiggly Model in Place! 

n �  �Tether leash to something (tree, bench, fence, etc.) 
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n �  �Tether leash to stake that screws in the ground (note: this only works for soft 
ground and is less ideal for urban shoots where you’ll encounter lots of brick 
and concrete.)

n �  �Place your dog up on high object such as a rock / bench / etc. (Many dogs 
will plant their feet atop a high object and will not jump down or get dis-
tracted as easily as they would if they were on the ground. It’s a great way to 
keep them in place for slightly longer than if you were working directly on the 
ground. Always use good judgement and make safe choices when placing a 
dog on top of something.)
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n �  �Treats! (Do note that sometimes treats are so enticing that they have the 
opposite effect and actually encourage your model to move towards you to 
get those glorious cookies!)

						    
How in the World do I get a Dog to Look at Me / ‘Smile’ for the 
Camera?!

Use Sounds					   
n �  �Duck Call
n �  �Kazoo
n �  �Squeaker / Toy
n �  �Your own voice
n �  �Trigger Word (learn these before session starts! This might be a great ques-

tion for your questionnaire that gets sent to the client!)
n �  �Regular or Training Whistle
						    
It’s incredibly important not to overwhelm the dog by overusing sounds. If 
sounds are used too much, you risk stressing your model out and rendering 
any further sounds ineffective. (In this same vein, prepare the dog owner and 
onlookers they’re planning to bring by informing them of the importance of not 
overusing sounds as well.)
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Use Toys

Use Treats
						    
Use the Owner
Leverage the beautiful connection that the dog has with his owner and use it 
to your advantage. Often, having the dog’s owner stand behind you is a surefire 
way to get him to look in your direction.

Question and Answer Time!
Use this space to write a question to ask Kaylee! Anything at all!
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The Power of Color Grading for Mood, Atmosphere & Impact

Within Photoshop there are countless techniques and tools for colorizing pictures: 
Levels, Curves, Hue/Saturation, Selective Color adjustment layers, and the list 
goes on. The techniques you use, as is always the case with Photoshop, depend 
a lot on your personal preference, so there’s no right or wrong way as long as 
you can get the results you’re after.

That said, I do have a preferred ways to colorize my pictures and create a spe-
cific mood and atmosphere; Color Lookup Tables (LUTs) in Photoshop. In this 
session I’ll show you how I typically use LUTs but we’ll also look at what colours 
scheme to use depending on the mood you’re after, how to take color from 
Movies and Still Images to use in our own pictures and a few other little tricks 
and workarounds.

During the time I’ve used Photoshop I’ve tried many different methods for col-
orizing my images to achieve the mood and atmosphere I’m after. I still make 
use of Curves, Selective Color Adjustment layers, and the Color Efex Pro 4 Plug 
In, but more recently with the introduction of Color Lookup Tables I’m finding 
I choose to use them more than any other method. I love how I can create my 
own bespoke looks by combining a number of Color Look Up Table Adjustments 
layers, and also by adjusting their opacity and experimenting to see how they 
change with different Blend Modes.

Let’s start by looking at where you’ll find them and a simple recipe combining LUTs…

•	With a file open in Photoshop (this is my friend 
Paul) (Figure 1.1) click on the Color Lookup icon 
in the Adjustments panel (Figure 1.2) to add an 
adjustment layer. In the Properties panel, click 
on the 3DLUT File drop-down menu and select 
TensionGreen.3DL (Figure 1.3). In the Layers 
panel, lower the Opacity of this adjustment layer 
to around 30% (obviously these settings are 
according to my own taste; you can set them to 
whatever you prefer).
 
 

 
 Glyn Dewis 
Photographer, Retoucher and Trainer 

Glyn Dewis is a professional photographer, retoucher, and trainer based in England. Glyn’s  
photography and retouching sees him working for national and international clients ranging from 
the BBC, Sky TV and Air New Zealand to athletes, musicians, and other industry professionals. 
A Photoshop World Dream Team Instructor, KelbyOne Instructor and Adobe Influencer, Glyn 

also teaches his own series of workshops, provides one-on-one coaching and presents  
at events around the World covering all aspects of Adobe Photoshop from basic to advanced techniques.  
See his work at glyndewis.com and find videos on his YouTube channel at youtube.com/GlynDewis.
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• Add a second Color Lookup adjustment layer, and this time choose EdgyAmber. 
3DL from the 3DLUT File menu. Lower the Opacity of this adjustment layer to 20%. 
 
• Add a third Color Lookup adjustment layer, choose FoggyNight.3DL, and lower 
the Opacity of this layer to 20%. 

• Set the foreground and background colors to their defaults of black and white 
by pressing D on your keyboard. Then click on the Gradient Map icon in the 
Adjustments panel to add an adjustment layer (Figure 1.4). This gives us a pretty 
nice black-and-white image straight out of the bag (Figure 1.5); however, in this 
case I want to use it to desaturate the image slightly, so reduce the Opacity of 
the layer to 20%.

 
 
 
 
 
 
 
 
 
 
 

 
• I’m loving how all the adjustments we’ve just added (Figure 1.6) change the 
overall mood of the image; however, I’m not so keen on how the adjustments 
have affected Paul’s skin, so I want to reduce the effects a little in that area. First, 
let’s organize the adjustment layers into a group. Click on the uppermost layer, 
then while holding down the Shift key, click on the first adjustment layer. This 
will highlight all of the adjustment layers in in the layer stack (Figure 1.7). Now 
go to Layer > New > Group from Layers. (You could also click on the Layers 
panel menu icon in the top-right corner of the panel and select New Group from 
Layers.) Name this Group color and click OK (Figure 1.8).  

With GLYN DEWIS
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Figure 1.2 Figure 1.3

Figure 1.4 Figure 1.5
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• Add a layer mask to this group by clicking on the Add Layer Mask icon at the 
bottom of the Layers panel (Figure 1.9). 

 
You might be inclined to think that all we 
need to do to reduce the colorizing on 
Paul’s face is to paint with a black brush 
on the layer mask attached to the group, 
and you’d be kind of right, but also kind of 
wrong. Let me explain. 

Let’s say you want to reduce the colorizing 
effect by 30%. You choose a simple round 
brush with a black foreground color, set 
the Opacity of the brush to 30%, and 
begin painting the effect away. The 
problem here is that if you lift off and 
then continue brushing again, there’s a 

high possibility that you will go over areas again, building up the opacity and, 
in turn, reducing the colorizing more in some areas than others.  

You can see this in the layer mask view shown in Figure 1.10, 
where I have tried to reduce the effect by brushing with a lower 
opacity. Different shades of gray means the colorizing from 
the adjustment layers is showing through in different amounts 
across Paul’s face.

So how can we do this better? Well, there’s 
actually a slider we can use with layer masks 
that makes this so much easier, and it’s called 
Density. You’ll find the Density slider in the layer 
mask Properties when you click on the layer 
mask and make it active (Figure 1.11). 
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Figure 1.6 Figure 1.7

Figure 1.8
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Make sure the layer mask attached to the color group is active, and then choose a 
round brush with a black foreground color and set the Opacity to 100% (Figure 
1.12). Paint over Paul’s skin and hair to conceal (hide) the colorizing effect com-
pletely from this area. Now drag the Density slider down to 70% (Figure 1.13). 
You’ll notice that when you do this the colorizing effect on Paul’s face and 
hair is reduced. 

 
Colorizing like the Movies (Creative Cloud Only)
This technique is a perfect example of taking a “what would happen if…?” 
approach to using Photoshop and, in this case, Premiere Pro CC as well. A short 
while back whilst experimenting in Photoshop an update was released across 
the Creative Cloud for Premiere Pro CC (which is the software I use for editing 
my videos). This update introduced a function called Color Match, which is  
different in so many ways from the Match Color command in Photoshop. It not 
only works different, but the results are way better.
 
Earlier I explained how I use LUTs (Look Up Tables) to colorize my images; well, 
this takes it a step further. The idea behind Color Match in Premiere Pro CC is to 
be able to make video footage from a number of different cameras look similar 
in the final edit. For example, the main footage for a short video may have been 
filmed with one camera, such as a Canon, but other angles and B-roll footage 
may have been filmed with a GoPro or maybe even a mobile phone. Therefore, 
the ability to make the footage from each camera match (as much as possible) 
provides much more continuity and creates a better viewing experience.

Sounds great, right? What if we approach this update with the mindset of “What 
would happen if…?” If it works with moving images, what about still images? For 
example, what if we could make one of our own pictures match the look of a still 
from a movie?

Figure 1.12

Figure 1.13 Before Density Slider After Density Slider
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Well, let’s see… 

• With Premiere Pro CC open, go to File > Import. Navigate to a flattened ver-
sion of the file you are currently working on and also to a still from a film or TV 
show and click Open. Here I’m using a photograph from my World War 2 Project 
as well as a screen grab from a film trailer on YouTube. 

• Drag your still image onto the 
timeline and then drag the screen 
grab onto the timeline. Position 
the files so that film screen grab 
is first and the still image follows 
(Figure 1.16).

 
• Drag the play head onto the still image in the timeline so that it’s visible (Figure 1.17). 
Click on Color in the toolbar at the top of the screen, and then click on Comparison 
View in the panel on the right (Figure 1.18).

 
 
 
 
 
 
 
 
 
 

 
Of course, we’re experimenting here so this isn’t perfect. We can adjust the 
shadow, midtone, and highlight areas to fine-tune the color a bit more, but I 
think just seeing this is incredibly exciting. And it gets better… 
 
• Click on the Lumetri Color menu icon at the top of the panel on the right and 
choose Export .cube from the menu (Figure 1.21). Navigate to where you’d like 
to save the file, name it something like film, and click OK (Figure 1.22). I saved 
mine to my Desktop. 

Figure 1.17 Figure 1.18

Figure 1.21 Figure 1.22
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Now comes the magic part… 

• In Photoshop, open your 
still image file and add a 
Color Lookup adjustment 
layer (Figure 1.23). 

• In the Properties, click 
on Load 3D LUT in the 

uppermost drop-down menu (Figure 1.24), and then navigate to where you 
saved the file from Premiere Pro CC. Select the file and click LOAD, and the 
coloring created from the film.jpg file is now applied to the image of Peter 
(Figure 1.25). Isn’t that cool?! 
 

 

Of course, it doesn’t stop here. We could add more Color Lookup adjustment 
layers, use Opacity or blend modes, or add any other color adjustments, but it’s 
stuff like this that really excites me and gets me thinking about future possibilities. 

At the time of discovering this there is third-party software available that per-
mits you to do something similar, but you’ll have pay for most programs. This 
technique makes use of what you already have! 

If you do give this a try I’d love to hear how it goes. Maybe try using it to match the 
color or tone of other pictures you’ve seen? Will it work with black-and-white images?  

If you’re into creating composite images could this be useful? One of the most 
important things to do so that the image looked much more believable is to 
match the colouring / tone between the background scene and the person / 
object being composited in right?

Figure 1.24 Figure 1.25
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What about using this Look Up Table creation technique in Premiere Pro CC to 
create a LUT of the background that you can then apply to the person / object 
being composited in, in Photoshop? When you have created the LUT in Premiere 
and imported into Photoshop, you could then add the Color Look Up Table 
Adjustment Layer and then create a Clipping Mask so that the LUT only affected 
the layer directly below i.e. the one containing the cut out.

The possibilities just by experimenting I find incredibly exciting and hey if they 
work they work and if they don’t … well, at least you tried it.

Remember … What would happen if?!?!
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Glyn Dewis 
Photographer, Retoucher and Trainer

Glyn Dewis is a professional photographer, retoucher, and trainer based in England. Glyn’s pho-
tography and retouching sees him working for national and international clients ranging from the 
BBC, Sky TV and Air New Zealand to athletes, musicians, and other industry professionals. A 
Photoshop World Dream Team Instructor, KelbyOne Instructor and Adobe Influencer, Glyn also 

teaches his own series of workshops, provides one-on-one coaching and presents at events around the World 
covering all aspects of Adobe Photoshop from basic to advanced techniques. See his work at  
glyndewis.com and find videos on his YouTube channel at youtube.com/GlynDewis.com 

So what is Frequency Separation? 

It’s basically a retouching technique that allows us to work on different parts of 
a picture and by that I mean, in simplistic terms, pictures are made up of two 
things, the color and the detail. So if we are able to split our pictures into those 
2 parts it means we would be able to work on one without affecting the other. 
Sounds kind of strange but all will become clear…trust me.
 
If you’re anything like me, at some point you’ve used something like the Healing 
Brush to remove a mark say on someone’s face that is on their skin right near 
to their hairline and as you have done the result looks like a smudgy mess. Well 
that’s because when you are trying to remove the mark (detail), Photoshop is 
bringing in nearby colour; Frequency Separation would prevent this from  
happening because we would be able to have the color on one layer and the detail 
on the other…as an example of just one of the many things we can do with it.

To show you what I mean, here’s a portrait where I have separated the color 
and the detail. Figure 1.1 is the color layer and yes you can see that it’s a 
portrait however there are no defined edges or sharpness; it’s basically an 
arrangement of color right? 

Now Figure 1.2 is the detail where you can see no color but can clearly see the 
defined edges and sharpness within the portrait showing through. 
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I guess we now need to look at exactly how we separate the color and the con-
tent in our pictures. Now there is a slightly different way to do this depending on 
whether you’re working on a 16Bit or 8Bit image. I’ll cover both during the ses-
sion but for now let’s look at the method for a 16Bit image.

1. With your image open in 
Photoshop, create 2 copies in the 
layer stack by holding down CMD 
(Mac) / CTRL (Windows) and press-
ing J two times. Rename the first 
copy color and the second copy (top 
layer) detail.

2. Turn off the detail layer by clicking 
on the layer eye icon and click on the 
color layer (Figure 1.4). Now we’re 

working on a high resolution image, so to have a layer with just color and no 
sharpness / detail we go to Filter > Blur > Gaussian Blur (Figure 1.5) and input a 
Radius of around 5 pixels (Figure 1.6) (If we were using a low resolution file then 
we would look at maybe 2 or 3). Click OK  

 
 
 
 
 
 
 
 
 
 
 
 

 
3. Now turn on, and click on the detail layer 
to make it active. Go to Image > Apply Image 
(Figure 1.7) We’ll discuss all the settings and 
options within the Apply Image dialog box  
during the session but in Figure 1.8 you can see 
what you need to input. 

Note: Make sure that in the Layer drop down 
menu you choose your color layer about in class.
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Figure 1.4   Figure 1.5

Figure 1.6
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Tip: If you’re  
working on an 8Bit 
image then in the 
Apply Image dialog, 
you would not tick 
the Invert check-
box, in Blending 
you would choose 
Subtract and for the 
Offset, you would 
input 128. 

 
4. When you click OK, in the Layer Panel you need to change the Blend Mode 
of the detail layer to Linear Light (Figure 1.9); this keeps the detail on the layer 

but makes the layer visible by  
hiding the grey.
 
5.	 Now we’ve split our picture into 
it’s color and detail, let’s put the 
technique to use. Let’s just say I 
want to remove some of the stray 
hair on Sophie’s forehead. Now this 
is exactly what I meant earlier about 
sometimes getting smudgy result. 
To remove the hair we’ll click on the 
detail layer. Then choose the Clone 

Stamp Tool from the Tool Bar and in the options at the top of the screen make 
sure that Sample is set to Current Layer. 

 
 
6. Now using the Clone Stamp Tool, choose an area on the forehead where 
you want to remove some stray hairs (Figure 1.11), hold down the Alt / Option 
key and click to sample an area of clean skin then trace over the stray hair. 
Notice how when we do this, we can remove the hair without smudging. 
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Figure 1.7 Figure 1.8

Figure 1.9
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Note: On the detail layer we will always tend to use tools like the Clone Stamp 
Tool or Healing Brush; on the color layer we’ll tend to use tools such as Brushes, 
Smudge Tool, Gradients.

See how quickly and effectively we can work using this technique to remove  
distracting elements.

Now let’s look at how we can use the color layer to remove something like skin 
shine. Of course there are many other ways we can do this, but Frequency 
Separation works so well and so quickly.

7. Click on the color layer and add a new blank layer above it. Rename this layer 
skin shine (Figure 1.13). Choose the Gradient Tool from the Tool Bar and then 
in the options at the top of the screen choose the Foreground to Transparent 
Gradient from the Gradient Picker (Figure 1.14) and then choose the Radial 
Gradient option (2nd gradient from the left) (Figure 1.15)

 
 
 
 
 
 
 

 
 
 

8. Now choose an area of shiny skin, hold down the Alt / Option key to click and 
sample an area of non-shiny skiny as close to the shine as possible (Doing this 
places the sampled colour as the Foreground Color in the Tool Bar). Then click 
down and drag to cover over the shine (Figure 1.16). Make a few more samples 
around the shine if necessary and drag over to remove it completely. 

 
9. You can also use this technique 
to maybe reduce bags under eyes. 
Hold down the Alt / Option key to 
sample an area of skin underneath 
the eye (not the bag) and then 
drag over the area with the gradi-
ent (Figure 1.17) 
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Now you might notice that as you apply 
a gradient, it does tend to cover more 
area than maybe you want. This isn’t a 
problem as it allows us to work quicker 
and looser. When done we can simply 
use a layer mask to control where the 
gradient covers.

10. Hold down the Alt / Option key and 
click on the Layer Mask icon at the  
bottom of the layers panel. This now 
adds a black layer mask to our skin shine 
layer (Figure 1.18) and hides what we 		

                                   have just done in the last couple of steps. 
Now simply choose a soft edged brush and with a white foreground color 
brush over the shine areas you have just covered over and the eye bags to 
only reveal the covering that you want and for it to not appear / spill onto any-
where else (Figure 1.19)

 

Sharpening Eyes
I just love using Frequency Separation for sharpening eyes. It works so well 
adding impact to the eyes but without any halos, colour shift, artefacts etc…

1. Click on the 
detail layer 
and then 
using the 
Marquee Tool, 
make a rough 
selection that 
includes the 
eyes (Figure 
1.20) 

Figure 1.17

Figure 1.18

Figure 1.19
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2. Hold down 
CMD / CTRL 
and then J 
to put this 
selected area 
up onto its 
own layer 
and rename 
this layer 
eye sharpen 
(Figure 1.21) 
 
 
Here we can see the Before (Figure 1.23) and After (Figure 1.24) sharpening. 
Of course if you want even more sharpening you could simply duplicate the 
eye sharpen layer and use opacity to control how much sharpening.
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Selections, Edits, & Masking

Mark Heaps
Executive Director, Heaps LLC, a digital communications studio 

Mark has taken care of clients for over twenty years offering solutions for boutique businesses 
and top listed Fortune 500 clients alike. He’s an Adobe Community Professional and Certified 
Expert, an Adobe MAX Masters Award Recipient, a past Senior Instructor of Brooks College, a 
traveled musician, dad of two great kids, husband, dog owner, and foodie.

Selections, also known as temporary masks, are an imperative part of the editing 
process. It’s something that all photographers who delve into the digital dark-
room need to become comfortable with. When it comes to making finite edits, 
or just working on a particular zone of an image, Selections, Tone based edits, 
and Masking are the keys to modifying the parts of your image that improve its 
visual appeal.

During this session we’ll look at some of the tools for selections and things you 
can do with them. Assuming that you’ve played with most of these tools before, 
we’ll skip past the basics in these notes and dive straight into some areas of 
importance.

The decision as to how we make a decision is usually based on a few factors. Is 
there a distinctive visual component that easily isolates those pixels? This could 
be a red shirt worn by someone in the middle of a green field. These sort of 
visual separations make the process of selecting pixels easier.

Because we have tools that have thresholds for how sensitive they are we can 
make selections based on a sample value. There are some easy ways to do that 
based on color. For example: scene then that is always my preference.



49

notes

the

Magic Wand Tool
Quick Select Tool

Each of these tools have an option 
to increase or decrease their level of 
sensitivity which impacts how much 
pixel data gets selected, relative to 
how similar it is to the sample point. 
This is very clear to see in the Select 
Color Range option because the 
mask increases and decreases.

We can also manipulate/influence 
this sample point by adding more 
than one sample point at a time to 
the selection. If we want to add to 
an existing Selection it’s as simple as 
holding Shift when we click on a part 

of the image to increase the sample value mix. The opposite of this being that 
we hold option to subtract or reduce part of the sample.

But not all edits necessarily require a selection at all. For example, if we wanted 
to change a color of the red shirt, that doesn’t really require a selection. In fact, 
that can be isolated using some of the threshold controls in our image adjust-
ments. For example, using a Hue and Saturation image adjustment, and choos-
ing the appropriate color range from the pull down menu, allows you to isolate 
pixels of that value, and then change the existing hue.

Since this range of pixels are going to be changed due to their isolation as 
a color group, that 
being the threshold, 
we can slide the Hue 
slider to a new value 
to change the color.

There are other tools 
that isolate based on 
a color value like this. 
The Black and White 
image adjustment for 

With MARK HEAPS
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example allows you to mix those color values into new shades of gray to help 
create a more elemental isolation in your black and white image. But that mixed 
with a Luminosity blend mode, makes it possible to change the exposure of an 
isolated Hue without the image being made into a Black and White image. 

When needing to keep an isolated area of an image without losing all 
the efforts of creating your selection or edit, you’ll usually want to apply 
a mask. Whether that mask is for cutting out part of an image, like on 
a Layer Mask, or if you need it to segment a part of an image that you 
wanted to edit. We simply need to paint with Black, or White, to define 
where we apply our edits. Shades of gray allow you to have partial impact 
from the mask. Whether that is the level of transparency, or opacity, that 
we see in a mask cutting out an image, or the ability to fade the edits 
from an Image Adjustment. 

With MARK HEAPS

Selections, Edits, & Masking
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It’s common, when making selections, we follow this order.
• Get the starting “bulk” selection. 
   • The largest amount of pixels we want with the least amount of effort
• Refine and clean up the selection.
   • �Usually using add or subtract controls with a selection tool, or we modify  

the selection once it is converted to a mask.

Many people make a distinction between Selections and Masks, but they are 
essentially the same thing, just viewed and utilized in different ways. For exam-
ple, you can toggle back and forth between an active selection and a temporary 
mask mode called a Quick Mask. Why would you do this? Because you can paint 
on a mask and many people prefer refining their selections with the control of 
a paintbrush, and the clarity it offers. In other instances, some users prefer the 
surgical precision of using the vector based Pen Tool to draw Work Paths, and 
convert those to a selection.

Newer techniques are also now becoming integrated into Photoshop. In this 
example; we’ll look at how to use Select Subject and Select and Mask to refine 
the selection. Eventually outputting to a Layer Mask from the editing mode for 
this refinement.

Example Case Study:
Here’s our smiling model image from Adobe Stock. Light blond hair, back/side 

lighting, with a light yellow and green hue 
filled background environment that blends 
with her hair. Start by choosing Select 
Subject from the Select > Select Subject 
menu item, it gives us this as a result 
(depicted by the green overlay to show the 
selection it creates). Very  
impressive as far as a single click first 
pass is concerned. But the challenge here 
are the hairs on her head flying all over the 
place and some of that back/side lighting 
is accentuating textural details along the 
edges of her arms.

This means it’s time for Select and Mask. 
This is our first time discussing this feature 
of Photoshop, which is an evolution from the 
previous tools like Refine Edge and others.

Now that you have your starting selection active, based on pressing the Select 
Subject button. You’ll see your marching ants around the boundary of your sub-
ject. Up in the options bar area, right next to the Select Subject button, choose 
the Select and Mask button. 
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This will launch an editing mode that allows you to modify and refine your exist-
ing selection. Within this mode you are allowed to use paint brush-like tools that 
evaluate any area you paint and it decides that within the bounds of your brush 
strokes, what should or should not be added to your selection. If you are familiar 
with Quick Masking I refer to this as an intelligent form of Quick Mask. It’s look-
ing for defined edges through contrast, pixel value differentiation, contiguous 
lines, etc.

If this is your first time playing in this mode, a few things are foundation  
requirements for you to understand with hopes of avoiding frustration.

Top right: This is your preview area. You can see a little thumbnail. Change this 
to suit your needs based on the image you’re working on. I like to use the solid 
black or white when first testing my selection and mask results. If you have 
images on layers below this one, choose the On Layers option to see a preview 
of your composite quality. You will toggle between these constantly depending 
on the context of what you are selecting.

Top Left: These are your selection / masking adjustment tools. First is the Quick 
Selection Tool that works exactly the same way it does in the regular mode of 
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Photoshop. You paint with that brush and it look 
for similarities in pixel values to make a binary 
yes/no selection choice. There is no blending or 
intelligence here, just an add or subtract to the 
Selection. And as always, if you want to subtract 
an area from the selection, just hold the Option 
(ALT) key when painting to remove elements. Our 
other tools here are things like a regular paint-
brush, lasso, etc. 

Next is the Refine Edge Brush. This is really pow-
erful, because wherever you paint it will evaluate 
the pixels only within that painted area and decide 
what to add or subtract or blend. With this tool, we 

can paint around the fly away hairs on our subject’s head, around the edges of 
her arms, and we’ll see improvements in the selection results. Adjust the size of 
your brush to help control the amount of pixels you’re refining the edge around. 
To refine the quality of Refine Edge, we move to the other side of the window. 

Middle Right: Here we can adjust the thresholds for the edge quality of the 
mask. Spend a lot of time exploring here after you have painted around the 
edge of your selection. For this image, some small adjustments to Radius, with 
Smart Radius checked, Contrast, and Shift Edge help improve the overall quality. 
In most cases, shifting the edge to a negative value will bring in any glowing or 
soft elements enough from the originating selection. If it’s too soft and glowing, 
increase the contrast to add some definition back to your mask.

Bottom Right: Here is where you choose your output preferences. Whether you 
want to load your changes as a selection, as a layer mask, etc. Tip: I recommend 
always using Layer Mask. Because there is something tangible that you can 
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select and paint on afterwards, or relaunch into this editing mode again, if  
necessary. If you output just to a Selection, and for some reason lose those 
marching ants by an accidental click, or cat walking across your keyboard, it  
was a wasted effort.
 
The final result is good enough for us to start compositing in other back-
grounds and experimenting with colors to finalize the image.

 
 

As you progress in your skills making Selections, Masking, and editing parts of 
an image; the key thing to remember is that good selections usually take time, 
practice, and refinement as you build them. Look at each image and decide 
what type of edit you want to make, and then let that inform how you should 
isolate those pixels. Sometimes that will require a selection, and in other cases, 
it’ll really be about the tone or color that you need to manipulate.
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Terry White
Terry White, Worldwide Design and Photography Evangelist - Adobe Systems Inc.

Terry has been with Adobe for over 20 years. He has extensive knowledge of Adobe’s Creative 
Professional product line. In his current position as he leads the charge in showing customers 
Adobe’s Creative Solutions around the globe. Terry has been active in the industry for over 25 
years and is the founder and past president of MacGroup-Detroit – Michigan’s largest Macintosh 

users group and columnist for Photoshop User Magazine. He is also the author of “Secrets of Adobe Bridge”, 
“InDesign CS2 Personal Seminar” and co-author of “The iPhone Book” and  “InDesign CS/CS2 Killer Tips.” Terry 
is a key presenter at major industry shows around the world. Check out his extensive video tutorial collection 
on YouTube – terrywhite.tv His blog at terrywhite.com Follow him on Twitter @TerryLWhite and Instagram @
TerryLeeWhite  Like him on Facebook: http://facebook.com/terrywhitefans 

Adobe Lightroom can go beyond image management and basic non- 
destructive edits. 

Customizing Lightroom
If you’re like most Lightroom users you’re probably not using every feature or 
every module. You can streamline the Lightroom interface in a few ways. 

Step one: Right click on any of the Module names. This will bring up a menu 
allowing you to turn off any modules that you don’t use.

Step two: choose any modules that you don’t use to uncheck them and hide 
them from the interface 

Step three: You can also right click on the 
panels in the Develop Module to bring up a 
menu to disable any panels that you don’t use. 
 

 
 
 
 
Step four: If you’re tired of having to scroll up and down the long list of panels 
you can also enable Solo mode. When Solo mode is enabled any panel that 
you click on will automatically close any other panels. This way the list is always 
short because only one panel can be open at a time.
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Setup a Custom Identity Plate
You can change the upper left corner of Lightroom to display any text or 
image you want such as your company logo. 

Step one: Choose Identity Plate Setup from the Lightroom menu.

Step two: You can import a PNG file or use text to setup the Identity Plate 
the way you want. 

Split Toning
One of the most overlooked features in Lr is Split Toning. It’s really easy and can 
give your images a different style.

Step one: Choose your image and go to the Develop Module

Step two: Scroll down to Split Toning

Step three: Hit the letter V on the keyboard to convert your image to a black and white

Step four: Move the SHADOWS Saturation slider over and you’ll start the effect.

Step five: Adjust the Hue to change the color

Step six: Do either Shadows or Highlights but not both! If you do both you’re 
on your own. LOL 

With TERRY WHITE

Advanced Lightroom Techniques
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Build Presets for Output as well as Editing 
One of the more advanced things that you can do is to start building your OWN 
preset list. If you want to adjust images to have YOUR LOOK, then edit an image 
and save it as a preset so you can apply it to similar images going forward.

Step one: Edit an image in the Develop module

Step two: Choose Create Preset from the Preset + drop down

Step three: enable the features you want remembered in your preset

Step four: Name your preset and save it to the group that you want.

Step five: Click Create

Step six: Test the preset by choosing a different image and applying  
the preset.  
 
Create a default Import preset
After you’ve learned to create presets above, then you can make one for  
applying settings to future images that you import. The next time you import 
images you can choose that preset in the Import dialog 

With TERRY WHITE
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Editing Multiple Images at the Same Time – Tips
One of Lightroom’s best features is the ability to edit multiple images at the 
same time. It’s also cool to apply the same edits to the next photo.

Step one: If you want to always apply the same edits to all the images you 
have selected then switch to the Develop Module

Step two: Click the Sync switch at the bottom right to toggle to Auto Sync. 

Step three: Now when you select two or more images and make an adjustment 
in the Develop Module, all of the selected images will be modified the same way.  

Take advantage of Virtual Copies
Virtual Copies is one of my favorite Lightroom features. You can create as many 
Virtual Copies of an image as you want. Each Virtual Copy can be edited differently 
without any impact on your storage space. This is much better than duplicating the 
actual images because Virtual Copies only exist in your Lightroom Catalog. 

Step One: Select an image that you want to Virtually Copy

Step two: Choose Create Virtual Copy from the Photo menu. 

Step three: You’ll be able to tell the difference visably because the Virtual Copy 
icon will be dogeared. 

Step four: You can edit and export this Virtual Copy with no impact to the original. 

HDR (High Dynamic Range Images
You can combine two or more of the same image captured at different exposure 
settings (bracketed) to create a single new HDR DNG image.

Step one: Select two or more images that were shot at different exposure settings.

Step two: Right click on the images and choose photo merge HDR or CTRL H 
from the keyboard
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Step three: When the dialog box appears enable the Deghost option if there 
was something in your images that was moving (such as a flag waving). 

Step four: Click Merge.

Step five: The resulting HDR image will be next to the original three. From there 
you can go in and make further adjustments in the Develop module. 

Panoramas 
You can also stich two or more images together as a panorama. There will 
need to be some overlap between the images. 

Step one: Select two or more images, right click on them and choose Photo 
Merge Panorama or CTRL M from the keyboard.

Step two: When the panorama dialog box appears choose the projection 
method that looks best for your pano. 
Step three: Choose auto crop 

Step four: try the Boundary warp slider to see if it works with your pano.

Step five: Click Merge

Bring your Videos into Lightroom
Lightroom can also handle the videos from your camera. You can import them 
right along with your photos and manage them in the Library module. You can 
organize them into collections as well as use them in slideshows. Videos cap-
tured with your mobile devices and sync’d up to Lr Mobile will also be on 
your desktop version of Lightroom. 

You can do some edits in Quick Develop in the Library module.

You can also trim your video to make a shorter version
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Step one: double click on a video to bring it up in Loupe view.

Step two: Click the gear icon on the bottom right to expose the trimming controls.
Step three: To trim the beginning of the video drag the handle in from the left. 
To trim the end of the video drag the handle from the right.

Step four: At this point you can export your trimmed video from using the File 
Export command. 

Step five: You can also capture a frame from the video to use as a still image 
by clicking the frame icon to the left of the gear icon.  

History and Snapshots
All of the edits in the Lightroom develop module are non destructive. 

The History Panel shows every step/adjustment that you’ve made to any image. 

You can click back in time to reverse some of the edits. However, if you go back 
to any previous edits and make 
new edits then the edits that had 
previously existed will be replaced 
by the new edits. 
This is where Snapshots come in. 
If you want to be able to return to 
a specific way that an image looks 
take a snapshot of the image. 

Step one: Make any edits you want

Step two: Click the (+) sign on 
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the Snapshot panel to create a more permanent version of the photo in 
Lightroom.

Step three: Title the snapshot any way that you want. 

Now you can click on any of your snapshots to switch to any version of the 
photo you like.
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Color can make or break a great image. As trends and styles shift throughout 
media, we see a huge variance in how color is used to craft a final project. That 
side of the color discussion is heavily subjective. From trends like the retro-faded 
yellowish cast (ala old Polaroid/film) that is emulated and made popular by 
services like Instagram (#thatsafilter) to the impact of trends in movies like the 
orange-cyan-aqua gradients we saw in almost every comic/sci-fi movie in the 
last decade. What isn’t subjective is the science behind how we create this  
colors in a digital realm. 

There are lots of areas to talk about 
color in Photoshop, and digital media. 
If we were talking about cameras, 
we’d be talking about White Balance. 
We see this not only in our camera 
settings, but also inside of programs 
like Lightroom, or Adobe Camera Raw.

This shot was taken in the during a 
solar-noon, which means the sun was 
at the highest point. It gives harsh 
shadows, and very strong light when 
there’s no natural filter like clouds.

In programs like these, we can change the White Balance to either cool down or 
warm up the shot to emulate what the temperature of light would look like at 
various times of day. That is because white balance is measured in Kelvin, a  
temperature rating. You can see in the screenshot above how the temperature 
slider goes from a cool blue value on the left to a warm yellow end on the right. 
That means a shot like this one, could have the temperature shifted to emulate 
those other times of day.

In the three variations of the same image shown here, you can see the far left is 
the coldest temperature value we can apply, the middle is set to a natural day-
light balance which is 5500° and the far right is the warmest temperature value. 
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The goal, in a technical sense, and 
not stylistically, is to attempt perfect 
white balance. Which means if you 
had an object in your image that 
you knew was in fact some shade of 
gray, it can be white but gray is  
better, then the value for that item 
in an RGB measurement should 
be equal values of each channel. 
Because that implies gray, is in fact 
gray. In Photoshop if you entered 
128, 128, 128, for each of the RGB 
values, you would in fact have mid-
dle gray or 50% gray. Notice that 
the B (brightness) in the HSB values 
also says 50%.

This means color and lighting for a camera is directly tied to the temperature of 
the light you are shooting in. This is why when we walk around at night things 
have a blue tint, which is colder, and why as things get hot we see a warmer  
yellow cast on everything. Environmental factors can absolutely play an effect 
on color as well, smog, clouds, reflection off of nearby objects, etc.

When we are working in Photoshop, regardless of how you edit colors (Levels, 
Curves, etc) you should first understand the foundations of how color works. 
The primaries and secondaries of light. RGB, and CMY (K = Key  Black). Because 
our images are made up of the 3 channels when we edit in RGB mode, our 
most common working image mode. If all three channels use the same value, as 
mentioned earlier, you’ll get a shade of gray. When the numbers aren’t even and 
matched, this is where color is produced. Let’s look at how RGB breaks down 

With MARK HEAPS

Color Science: From Pop to Post 
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Red, Green, and Blue, are the 
primaries of light. This is why 
they make up our main channels. 
If you enter 255 (the brightest 
value) for any RGB individual 
color point, it produces the 
brightest value of that color 
frequency. The interesting part 
however is the secondary values 
that get produced.

In this RGB diagram, you can see 
that the value opposite of Red is 
a display of Cyan. The opposite of Green is Magenta, and the opposite of Blue is 
Yellow. Because we’re talking about colors in reference to light, we aren’t seeing 
that Cyan color because it’s a mix of Blue and Green overlapping. We’re seeing 
that piece of Cyan because Red light is missing from the area where 100% Blue 
and Green are overlapping.

As an example of this, just open any full color image and use Levels to make an 
adjustment. Go into the pull-down menu, and change it from RGB Master and 
set it to Red. Slide the middle slider (Gamma) to the right which darkens the red 

values. The result of this is a Cyan overcast.
 
Removing Red, darkening, is what allows the Green and Blue values to be 
brighter, and causes this color shift. In the reverse of this, if a color had a  
yellow overcast, you could increase the amount of Blue frequencies into the mix 
by brightening with an image adjustment and you can balance the color correctly.
 
 
 
 

With MARK HEAPS
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Mapping Color to Luminance
If you are editing colors with a feature like Gradient Maps, this approaches the 
image from a perspective of Luminance, or tone. The best way to understand 
this is to imagine your image as a Black and White, and then aligning a color 
value to the shade of Luminance. You align a color by editing the hue that is 
applied to a particular level of brightness, or gray shade, within the image. One 
of the areas we see this most commonly is within our RAW editors (ACR or LR). 

In Lightroom CC you can select the Shadows box, and then choose a color that 
will tint the shadows. In this example green is chosen for the shadows and red is 
chosen for the highlights. This gives us a Split Tone effect. The interface 
is slightly varied in Lightroom Classic and Adobe Camera RAW (seen here top 
right) where it shows up as two separate Hue & Saturation sliders that you can 
blend between for Shadows and Highlights.

For this image, when converted to black 
and white, we can see more easily how 
the colors are applied to the shadows and 
highlights of the image. Using an aqua 
green color for shadows and a tan/peach 
color for the highlights. This can be applied 
to a color image, but it’s much easier to see 
the effectiveness of it on a black and white 
image.

In Photoshop there is a more finite way of 
controlling this that goes even beyond the 
binary approach of Shadows and Highlights. 
It’s called a Gradient Map and it allows you 
to set values at any part of the Luminosity, 

or Brightness, range, and apply a hue/saturation value to that specific shade.
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You can apply a Gradient Map as an adjustment layer above your image. The 
interface shows it as a regular gradient, but it’s truly a luminance tone map rang-
ing from shadows to highlights. Add cursors along the gradient, you can assign 
a value such as a color and then that will tint that part of the image.

     1. Add a Gradient Map adjustment layer. 
     2. Select the black and white gradient for simplicity then click on the 	   
         gradient to bring up the Gradient Editor

 
      

 

 

     3. Click just below the gradient in the editor window to add a position 	  
         marker. Then click on the color swatch in the bottom left to add a color.
     4. Choose the color you want to be applied to that shade/brightness 	   
         region of the image. 
 
If you want these hues to apply as tints over the original color photograph, use 
blend modes like Soft Light with a reduced opacity value on the adjustment 
layer to blend for the best desired appearance

Selective Color
The last I often recommend is 
the Selective Color workspace, 
because it divides the image 
up by color, or by luminosity, 
and allows you to mix shades 
of color as if you were playing 

with inks in a CMYK press. It’s great for tinting 
parts of your image, or correcting out of gamut 
colors that won’t print correctly. Basically, isolat-
ing a particular frequency of color, or luminosity, 
and then letting you add or subtract an ink value 
to that isolated target. This is handy for cooling 

down shadows or warming up highlights. Just select that isolated target from 
the pull down menu, and then mix the CMYK sliders. 
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Karen Hutton
International landscape and travel photographer

Karen  is a Professional Fujifilm-X Photographer and has been featured in Talks at Google,  
Photo Plus Expo and on Stuck in Customs, TWiP, Macphun Software, Forbes.com,  
The Grid, and Rick Sammon’s DPE Podcast. Karen currently lives in the Sierra Nevada  
mountains of California.

Hi gang! I’m so thrilled to be here at  Photoshop World, sharing thoughts, ideas 
and inspirations that have made a huge difference in my life and art. I hope there 
are some nuggets here for you too!

In the description for this class, I posed the question: How many times have you 
stood in a gorgeous landscape, taken your best shot, only to be disappointed 
in all the ways it did NOT express what you were feeling when you pressed the 
shutter button? How do you translate that feeling of awe and wonder into a fin-
ished signature photo? Better still, how do you do it consistently?

Today, I’m going to leap like a gazelle right into the thick of it - and present a 
way of thinking and approaching the  “Arc of Creation” of a photograph, as I like 
to call it - from first gasp to final product.

This might not be exactly how you’re used to thinking about photography, but I 
invite you to journey with me into the strange and wondrous land of “inner land-
scape meets outer natural world”. Are you with me, my fellow gazelles?
 from the dark environment with Lightpainting. 

Meet Awe.

 
Awe is like the fairy dust of emotions. It’s magical, the way it sneaks up on you 
and instantly transforms the way you see not only the moment you’re standing 
in - but life itself - in an instant. It’s a feeling we know exists - we love the feeling 
of it -  and it’s a bit tough to describe.  
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You can think of Awe as a perceived vastness which reshapes - even turns the 
way you understand the world on its ear. 

Momentary experiences of awe invariably awaken a sense of wonder and  
curiosity, which has been shown over and over again to drive paradigm-shifting 
discoveries and new technologies which in turn, advance society. 

Awe is also good for the immune system. 

Turns out it’s SO important to human health and well-being, as well as  
society’s- that scientists at the University of California, Berkeley who  
specialize in the psychology of emotion are now studying Awe. Their findings are 
impressive. And of course, these findings confirm and lend even more credence to 
something we already know; that feeling Awestuck is like being touched by the 
Divine. You’re just never the same afterward. As Albert Einstein put it: 

“The most beautiful thing we can experience is the mysterious. It is the source  
of all true art and science. He to whom this emotion is a stranger, who can no  
longer and stand rapt in awe, is as good as dead: his eyes are closed.”

Scientists say it a bit differently, of course. And I’d like to use some of their  
ideas to illustrate what I’ve found to be the single most important ingredient in  
creating a “signature” piece of work. Being in Awe and telling your story about 
it - in your (visual) words.  

Awe shatters expectations.
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As an artist and a teacher; I can unequivocally say that expectations are one of 
the biggest roadblocks to creativity. What you expect of yourself, of your  
environment, of your gear, of your own creativity and capabilities - the list is 
endless.  Some expectations are positive (yay!), most are not (boo!).  

Why? Because ANY expectation takes you to the past or future - and right out 
of the present moment, which is where art (and life) are created. 

Mind bent yet?

Here’s the biggest trick: how to let ALL expectations go, so that something  
even better can present itself. Enter Awe. Awe walks in and - just like that -  
stops you in your tracks and shatters all expectations into a million pieces. 
Leaves you speechless in most cases. 

 

Personally, I think it’s Awe’s superhero name should be Quiet Storm. You don’t 
see it coming, you never expect it… and then BAM! You’re Awestruck and  
nothing will ever be the same again. You don’t know WHAT to expect next…  
so you’re just in the Now.

It flummoxes the mind, since Awe cannot be classified by anything we have  
ever seen, heard or experienced before. 

Rendering the mind quiet is goooooood. Awe does in a moment what years of 
meditation practice attempts. 
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Awe creates instant mindfulness.

 
People sometimes work daily for years - or their entire lives to be more  
mindful, in order to lead happier, less stressed lives. Then along comes Awe - and 
voila! You are suddenly seeing your world in such detail and with such meaning 
that you can’t even imagine why you didn’t see it before. It’s mindfulness on a 
grand scale - and it happens in a single gasp.

Awe alters how we see ordinary things
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Awe creates specificity
 
There is nothing “sorta”, “kinda” or “general” 
about Awe. It is a VERY specific feeling. It 
makes you see things in much greater detail, 
in very specific ways. Science is showing 
that it even makes you accurate in the data 
you process, engendering a state of being 
where there is no doubt - only Awe.

Here’s the cool part: 
Photograph from that state 
and your work will instantly 
be very different - and so will 
you! Your certainty, expansive 
vision, discernment, love, joy - 
are all upshots of the state of 
Awe. And it shows up in your 
work. Any artist who creates 
work from this state will have 
a very unique signature  
naturally embed itself within it.  
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Discernment alone is so genius! Imagine being able to easily discern the best 
shot from the more general, sloppier one. Discerning good advice from bad. 
Knowing who to listen to and whom to ignore. Knowing exactly when to press 
the shutter - and being certain about your settings. It’s calming, it takes  
attention away from ourselves and puts it into the world around us and what 
it’s trying to say to us. We can take in more of what’s actually going on around 
us. We experience less fight/flight and unsightly filtering of our current  
(present) experience through (past or future) expectation. 

Your body knows Awe
Awe comes with its own sympathetic nervous system indicators. In my photo 
retreats, I call them the “Gasp” response. They include responses like a literal 
gasp, your stomach might leap, your breath could speed up, you might sweat 
a little, your eyes might even leak. (It’s probably just dust in the air. heh.). I 
even teach people a process that allows them to photograph from this state of 
Awe consistently, because all by itself elevates the user by leaps and bounds. 

It makes sense that being in Awe when you photograph not only produces 
better images built from stronger and more specific choices, more meaningful 
compositions,  more pop - but it has MUCH more far-reaching effects too, like 
a clearer mind, feeling happier, healing from trauma, gaining new insights 
and perspectives on both photography - and life. 

Over the ages, the arts have sought to convey awe. Art created from Awe 
offers new ideas of possibilities. As with people engage with and respond to 
our Awe-invested works… we become part of a greater universe and connect 
in a greater way. 

By creating works from a state of Awe, we begin to put something greater 
into the world, something better, more expansive. We make a difference, a 
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pixel at a time. And we’re starting to have science on our side to prove this to 
anyone who can’t believe it can be this simple and this powerful!

PUT IT TO WORK FOR YOU 
We’re talking about a much more experiential approach to photography. 
Here’s a sequence you can put into practice right now to kick-start living 
inside the landscape of Awe. 

1. Preparation.
Every athlete, every performance artist knows that to be in the  
“zone” takes preparation. 

 
 
 
 
 
 
Certainly, it takes training. 
You have to learn your craft 
and understand your gear 
and settings reasonably well. 
Those are the basics. Then 
comes the moment when 
you have to put all that into 
practice; the basics are there, 
but they operate in the back-
ground. First: calm yourself. 
Slow down. Breathe more 
slowly and deeply - even 
leaving your breath out for 
a few seconds before taking 
the next one. 
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This simulates the body’s natural response to sudden, real-life moments 
that need supreme focus - and also happens to align with the state of Awe. 
Some listen to music, move more purposefully, intentionally let thoughts of 
everything else go, except what’s happening right now, or they focus on each 
breath. It’s meditative. 

2. Gear selection. 

(Using an iPhone 7s Plus)

Knowing what you want to see, need to see, love to see… what things awaken 
the Awe in you… will point you to your gear and then encourage you to work 
with what you’ve chosen without regret. For instance: 

Wider angle lenses put more in the frame and more is naturally in focus. You may 
or may not choose to show distortion, depending upon the effect you’re going for.

 

(Fujifilm X-T3, 16-55mm lens, ISO 400, f/18, 1/140 sec)
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(Canon 5DIII, 14mm lens, ISO 250, f/8, 5 secs. Also: Really Right Stuff Tripod) 

(Canon 5DIII, 14mm lens, ISO 640, f/8, 2.5 secs. Also: Really Right Stuff Tripod)

Macro/Telephoto lenses offer up a whole different landscape of possibilities. 
The nature of this way of seeing the world is also full of Awe. Less is in frame, 
it focuses the viewer’s attention differently than normal vision, its heightened, 
it shows details, compression, is very specific - and there’s the option for 
greater depth of field. 

In this scenario, an epic or grand approach might fill you with Awe, or perhaps  
a more surreal and trippy one does it for you. (Wide angle lenses can do  
either or both.) 
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(Canon 5DIII, 14mm lens, ISO 250, f/8, 5 secs.  
Also: Really Right Stuff Tripod)

 
These images can feel intimate, delicate, dreamy, up close and personal, they 
let you examine a more internal vastness of Awe. 

3.Composition: Specificity and choice
Awe is very specific. So is the best photography. The stronger your composi-
tion choice, the more specific you make them… the more a sense of Awe can 
come through. General feelings, general thoughts, general choices don’t pop 
like the ONE moment, the ONE element, the single selection of precise  
elements that took you breath away and made you weep with Awe. Use body 
sensations - goosebumps, a gasp, a tingling sensation, a unbidden giggle or 
even laughter, tears - to guide you to that exact composition. No more, no less.  

(Fujifilm X-H1, 100-400mm, ISO 320, 
f/6.4, 1/1800 sec. 

Also: Really Right Stuff tripod)
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It’s a two-way street: Awe helps you be more specific… and learning to be 
more specific helps you step into Awe much more often and easily. 

4. Tell The Story 
Understanding the elements of good storytelling really help to bring your 
moment of Awe into even more focus. I go into that in my talk here at PSW 
called “Telling the Story”, so I won’t include it here. But this is where that fits 
into the bigger picture. 

POST PROCESSING
Of course, capturing the AWE moment is step #1. Step #2 is completing  
it in post-processing. For the sake of space, I’ll share just one here. 

THE MAGIC OF SURVIVAL
I’m a sucker for sur-
vivor stories. Winning 
against all odds. 
Facing the light and 
finding beauty no 
matter what. These 
stories take me to my 
knees every time. This 
image on Lake Tahoe, 
with this beautiful 
little tree growing 
right out of a chunk 
of granite, facing the 
light one Sunday 
morning in the church   

                                                                                       of nature is one of my  

							        “survivor” favorites.  

(Fujifilm X-T20, 50-140mm lens, ISO 200, f/6.4, 30 secs.)
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I knew I wanted to process it with a flavor of “Extraordinary Ordinary” when I 
took the shot. When you see it with your eyes, it doesn’t scream “LOOK AT ME!”. 

 
In fact, you have to 
know just where to 
look to see it at all. But 
what’s happening here 
in such an ordinary way 
completely knocks my 
socks off. I wanted to 
convey that. For me, 
that means really  
relating to a story, then  
seeing it with cinematic 
eyes. (Sometimes I even 
hear the score!)

To get started on my quest, I added a bit of Vibrance and Contrast  
in Camera RAW.

I’m both a Photoshop and an 
enthusiastic  
plug-in user - and a bit of a 
human cuisinart in that way. 
So next, I dipped into Skylum’s 
Aurora HDR 2018 palette for 
some signature radiant and 
detail, which swept us elegant-
ly into the ballroom of exag-
gerated reality. More color, 
detail, snap and radiance.

Then I slightly blurred 
the whole thing and 
used a layer mask to 
brush the tree and rock 
back in - so that the 
background was softer. 
This created more  
separation between  
foreground and  
background.
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Next up: one of my signature moves that deepens and intensifies colors and 
contrasts without 
stressing pixels. It’s a 
black adjustment layer, 
set to a “Soft Light” 
blending mode. Then 
I use a layer mask to 
brush the tree and rock 
back into their nicely 
sun-drenched state, 
while the background 
darkens so that it 
stands out a bit more. 

 
Into another of my favorite plugins: Alien Skin’s Exposure 4, where I used a the 
Kodak Ultra Color filter 
and modified it to  
my liking: 

Along the way, I make 
micro-adjustments to 
tone down areas that 
are too intense color 
or shadow wise, using 
either Camera RAW or 
NIK/Google’s Viveza 
plugin. 
 
Now I’m liking the over-
all pop of this image. It’s crossing the boundaries of “real” nicely - without break-
ing the bounds of believability - at least amongst Believers. ;)

For me, nothing says AWE like some heavenly light. I had a good start on the 
day I stood by the lake 
- but I wanted to take it 
further. So I went back 
to Alien Skin’s Exposure 
4 and added one of 
their light effects to the 
upper left corner (where 
the sun actually was), 
then brushed some of it 
out with a layer mask. 
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I made one more pass with a black adjustment layer set to “Soft Light” to  
deepen the mood even more… and again brushed the tree and rock back in, 
along with some of the water so that it looked like the light was spilling naturally.

The final touches are 
another signature 
move… two  
adjustment layers, two 
different colors. 

The first adjustment 
layer is in a dark blue 
tone (in this case HEX: 
03051a), set to a Screen 
blending mode at 100%. 

The second: an adjustment layer in a yellow tone (here, HEX ffcc00), set to 
Multiply blending mode at 8%.

Et Voila!

This approach satisfied the expression of my AWE moment by the lake that day. 
Senses heightened. Colors more vibrant. Light more heavenly. The survival story 
sharply in focus. It’s one of my faves - and makes me happy every time I see it. 
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Publisher of Photoshop User magazine, and is CEO and 
head of education for KelbyOne.com. He is co-host of 
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around the world. Scott is the author of more than 80 
books, including the #1 best-selling book in history on 
digital photography, it’s called simply “The Digital 
Photography Book.” For more on Scott, visit his blog at 
scottkelby.com

“Travel is the only thing you buy 
that makes you richer.”

2

creating gorgeous 
travel photos.

3

a sense of 
timelessness.

4 This is a technique I have been doing unconsciously for 
many years, and it wasn’t until my wife asked me what I 
was doing when I kept walking past boat after boat in 
the small harbor. She said, “Well, what’s wrong with this 
boat?” I said nothing, but there’s a big Evinrude 
Outboard motor hanging off the back, and that totally 
kills the timelessness of the photo. I don’t want my travel 
images time-stamped by things in the image, like a big 
outboard motor. I strive for a timeless look; a cute boat 
with oars, to  create a timeless looks where the image 
could have been taken 50 years ago, maybe a 80 years 
ago, but certainly not in 2019. 
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5 By excluding new things, and ads, and posters, and 
modern era things, you’re not distracted and can get lost 
in the romance and timelessness of the shot. 

6 This canal has looked like this for hundred of years. 
Maybe more. But if you saw the garbage barge with the 
crane hanging off the back, and the workers in modern 
clothes, and the water taxis full or tourist, it breaks the 
connection. 

7 Water and bikes. Nothing to give away the time frame. If 
you had a sign or poster or a Toyota Camry visible in the 
shot, it would lose that special something. 

8 Here I had to remove some signs and graffiti from the 
walls, and some minor stuff here and there in 
Photoshop, but for the most part, this retains that 
certain romance and timelessness I was after. Weird 
fact: this is my most-liked image ever on Instagram.  
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9 Here’s one of those same trolley cars, but by seeing the 
modern cars, and the very modern ad on the front of the 
trolley, it breaks the spell. 

10 That new Mercedes right behind the trolley (taken on 
the same street as that original shot; I just turned 
around and shot behind me when I heard the trolley 
coming) doesn’t have the same feel at all. Of course, the 
light isn’t as flattering because now the sun is up, but 
also the modern liquor ads on the side of the trolley 
aren’t helping us either.  

11 Sometimes you can create the timelessness you’re 
looking for through framing. Without the right framing, 
this quiet, solemn moment is seen in an entirely 
different light. 

12 Like seeing that she’s looking at an iPhone. It really loses 
something. 
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13 Or showing a gift shop selling modern sneakers and 
clothing…in an old town in Morocco. This shot could 
have been taken in New Jersey. 

14 Find that boat — without the big outboard motor, or 
other giveaways help the viewer connect. 

research.

15 I’ve had to learn this one the hard way over the years, 
but if you want to be successful at travel photography, 
you’ve got to do your research up front. You’re going to 
not only want to know where to shoot (and what it takes 
to get there; is there a hike involved? steep climbs?); but 
which locations are best for sunrise or sunset or midday; 
which are temporarily closed; which buildings are being 
renovated or under construction, and more. I generally 
use two sources for most of my upfront research:  

500px.com

16 Before you go on a trip, go to to 500px.com first, type in 
a name of the city or region you’re visiting, and you’ll see 
amazing photos, and often very descriptive and precise 
location information, for places you never knew existed.
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17 Just go to 500px.com; type in where you’re thinking of 
going, and you’ll see tons of great images, and ideas, 
from that area. 

18 This is my other go-to research site. What I love about 
Pinterest is that it’s curated. Someone has already 
gathered great images together for you. 

19 The one thing I don’t love about Pinterest is that there 
are a LOT of ads interspersed within the image. A lot. 

simplicity is king.

20 One of the great things about looking at both of these 
sites is that there’s a great travel photography lesson to 
be had to really studying the images. Not just for 
location, but for what makes them special and a big one 
of these is realizing that simple shots win. 
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21 For example, take a look at some of the most popular 
shots from Venice, Italy. 

22 Here’s another set, and they all have something in 
common. Simplicity. 

simple.

23 That simplicity is big. 

24 Notice how many shots where the water is smooth; the 
crowds are gone, the waterways are empty. 
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colorful.

25 Another thing they nearly all have in common is that the 
images are colorful. People love colorful images (the 
general public more so than photographers). The 
general public absolutely loves vibrant, saturated colors, 
even if photographers don’t, but since other 
photographers are never going to buy your 
photographs, maybe we should be worrying less about 
impressing photographers who won’t pay for our work, 
and instead start making images the public loves. 

26 Take a look at the color in these images. Rich blues, 
beautiful colorful skies, warm sunsets. Brightly colored 
buildings. 

clean backgrounds.

27 Also, take a look at their background. Clean. Simple. 

28 Look at the backgrounds. Simple. Clean. 
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interesting 
perspectives.

29 Many of them are also taken from interesting 
perspectives; not just all shot standing at eye level. 

30 Many are shot from down low (six of the 9 on this page 
alone), and some from up on a bridge. Changing your 
perspective, shooting from lower or higher than regular 
eye-level, makes a difference. Add them all up now: 
simple. Clean. Colorful. Smooth water. Uncluttered, and 
mostly shot at dawn or sunset when the shadows are 
soft and the light is beautiful. There’s a recipe for 
success there. 

which gear to take.

31 Here’s some of my suggestions for when you’re planning 
which gear to take on your trip. 

travel light.

Photoshop World Orlando 2019 32 The lighter you go, the happier your trip will be (and  
your photography will not suffer. Quite the contrary). 
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just one or two lenses.

Photoshop World Orlando 2019 33 If you can get away with just one lens, I promise your trip 
will much better, and so will your photos because you’ll 
always have the right lens on your camera. If you take 
two lenses, you’ll only have the right lens on about 50% 
of the time, and you’ll always be switching lenses. It’s a 
fact. 

Photoshop World Orlando 2019

Nikon Full Frame: 28-300mm

34 If you’re a Nikon shooter with a full-frame body, I 
recommend their 28-300mm. It’s a killer lens for the 
money, because it covers everything from wide to long 
telephoto, and it’s really sharp. I used to have this one 
myself, and I loved it. Highly recommended. 

Photoshop World Orlando 2019

Canon Full Frame: Tamron 28-300mm

35 If you’re a Canon shooter on Full Frame, Canon doesn’t 
have a modern 28-300mm, so I would instead 
recommend Tamron’s 28-300mm. It’s not super sharp, 
but it’s not soft either. It’s somewhere in the middle but 
the price and light weight are it’s killer features. I’ve got 
one of these myself, and it’s a great little lens. 

Photoshop World Orlando 2019

Sony Full Frame: 24-240mm

36 If you’re got a Sony full frame, check out their 
24-240mm, which I actually think is a better range than 
28-300mm because it’s wider on the wide end, and on 
the long end, you can crop to 300mm or more easily, but 
you can’t make a 28mm wider than it is, which is why the 
24mm end is an advantage. 
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Photoshop World Orlando 2019

Crop Sensor: 18-200mm

37 If you’re a crop sensor shooter, the equivalent lens 
would be the 18-200mm, and Nikon, Canon, and Sony 
(and Tamron and Sigma) all make their own. The price 
and weight are great, too. 

16-35mm 70-200m

1

2

Photoshop World Orlando 2019 38 If I was going to take just two lenses with me, it would be 
the 16-35mm and the 70-200mm. That way I can go 
super-wide (at 16mm) and I can also hit the landscape 
sweet spot in the 24mm to 35mm range. Then I pick it up 
again at 70mm all the way to 200mm on the long end. 
I’m only missing that small range between 35mm and 
70mm (basically a 50mm, which I wouldn’t use for travel 
photography anyway), so with these two lenses you 
cover an ideal range. Just a reminder; I’d get the f/4 
versions; half the price, less weight and still super sharp. 

You’d only be missing the 
range from 35-70mm

50mm

Photoshop World Orlando 2019 39 You’re missing such a small range — one that would be 
covered by a 50mm, but I couldn’t tell you should use a 
50mm for travel, so you’re covering a great range with 
just those two lenses. 

40 When you’ve got just one or two lenses, you can be 
really flexible. 
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41 How flexible? Embarrassing confession — I took that last 
shot from the back of an Uber in Dubai. I just asked the 
driver to pull over — I already had the right lens on 
because I didn’t bring a lot of gear — I rolled down the 
window and got the shot. OK, it’s a bit of a lazy way to 
shoot, but…well…I don’t really have a defense for it. 

Black 
Rapid 
Strap

42 I use a Black Rapid strap for travel because the strap 
goes across my chest making it very hard for a “snatch 
and grab” for a thief on the street. Plus, I can pull the 
camera up to my eye so quickly (I don’t have to take it off 
my shoulder like with a normal camera) that I don’t miss 
the shot. 

Think Tank Photo 
Turnstyle 10 V2.0 
Sling Bag

43 I’m done carrying huge backpacks, which is why I love 
this sling-bag from Think Tank Photo. It’s my go-to bag 
and on every vacation and shooting adventure I go on. 

44 It holds a surprisingly large amount of stuff for as small 
and lightweight as it is. It’s just a little larger than a Lens 
bag, and in mine I I keep my 2nd travel lens, a Platypod 
(more on it later in the class), A ballhead, my ND filter, 
cleaning cloth, and extra batteries. Pretty much 
everything I need. 
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45 You can sling it over your back, or you can do like I do 
and keep it on my side. 

Think Tank Photo 
Turnstyle 10 V2.0 
Sling Bag

46 When you need to get into the bag, it swivels right 
around front, so you have easy access to everything, and 
all it’s pockets. This is an awesome bag (and thanks to my 
buddy Jeff Leimbach who turned me onto it a couple of 
years ago). 

camera set-up

47 Before you start shooting, here’s a few things you might 
want to set-up in your camera for travel photography 
success. 

turn on auto ISO

Photoshop World Orlando 2019 48 It’s pretty heartbreaking to see that you “got the shot” 
and then later when you import the images onto your 
computer, find out that it’s out-of-focus. If the shot is 
soft, it’s most likely that you didn’t have enough shutter 
speed for the lighting situation you were shooting in, so 
you wind up with blurry shots. It’s incredibly common, 
and incredibly heartbreaking. Want this issue to go away 
completely? Turn on Auto ISO — that way your camera 
will make sure you always have a decent shutter speed 
even if it has to crank up the ISO to get there. 
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49 Once you turn on Auto ISO, next go and set your 
minimum shutter speed to 1/125 of a second, and you 
should be covered. Yes, it will raise your ISO if it really 
needs to, to keep your shutter speed at a minimum of 
1/125 of a second, but which would you rather have; a 
slight noisy image, or one that blurry? That’s an easy 
choice, because blurry shots go in the trash. 

getting sharp photos.

Photoshop World Orlando 2019 50 Whether you’re presenting to a big or small group - it 
means you have everything in place to give you the best 
chance of having your message connect with the 
audience.  
 

everything  
looks sharp small

51 The problem is: everything looks in focus on that tiny-
little LCD screen on the back of our camera. In fact, none 
of us has even a cell phone screen that is a small as the 
LCD screen we make our critical judgements about 
sharpness on.

50% size.Yikes!

52 You have to zoom in to at least a 50% magnification to 
check the sharpness DURING your shoot. If not, you’re 
likely to see a number of blurry photos when you see 
them full size on your computer screen later. If you zoom 
in and see it’s blurry now, you still have a chance to 
reshoot and get a sharp shot. 
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if you find out now 
you can still reshoot.

53 Here’s a side by side of what we see on the back of the 
camera by default, and what you realize if you take just 
2-seconds and zoom in. This is so worth doing, while 
there’s still a chance to take another shot where you’re 
really focused on making it sharp. 

54 Get your LCD zooming one button away 

This will be one of your biggest advantages. Set 
the playback button to be your zoom and it will 
now be one click away. Go to Google and search 
for the PDF of your manual. Search the PDF for 
the word zoom and you can find how to set up 
your playback zoom to be one click away. 

55 Look at the difference when you simply hit that zoom 
button. 

56 One click to zoom back out. 



57 Another one to zoom back in. If it’s that easy and 
accessible. 

Sharpen Every Photo.

58 Every photo you see in a magazine, in a pro’s portfolio, 
on the Web, and so on has been sharpened after the fact 
in Photoshop or Lightroom, or something else. It is a 
critical final step and I wouldn’t show ANY photo I’ve 
taken without this important step which brings back 
some of the sharpness lost in the process of creating a 
digital image. This is a must!

59 The shot on the left is the out-of-camera RAW image 
taken on a $5,000+ body with a $2,000+ lens. That’s 
what you get for $7,000, an image that isn’t nearly as 
sharp as what you see daily online, because they’re all 
sharpened in post production (like the image you see 
here on the right). 

standard

Amount:      120% 

Radius:         1  

Threshold:   3 

60 Here are the settings I use day in/day out for my own 
images. If I sharpen an image, 99% of the time it’s one of 
these three settings. If I use something else, it means I 
messed up when I took the shot so I had to crank the 
Amount up higher.
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Amount:     90% 

Radius:       1.5  

Threshold:     0 

heavy

61 If you have an image that is either visibly soft, or it’s an 
image with lots of small detail, like a cityscape, 
landscape, or something with lots of detail, it can take 
more sharpening, and this is a lot of sharpening, but it 
still looks good. 

Amount:       85% 

Radius:          1  

Threshold:    4 

resized for web

62 This is to replace the sharpness lost when you 
downsized the image for posting online. Occasionally, I 
use this one at a lower Amount setting of just 50% if I 
apply the sharpening to an image already resized down 
for posting on the Web, and I think the 85% amount 
looks a little too sharp. 

63 If you don’t use Photoshop, Lightroom’s sharpening 
presets are actually pretty decent (use the scenic one 
for travel images). 

location scouting

TRAVEL 
PHOTOGRAPHY 
WITH CANON EOS

Photoshop World Orlando 2019 64 This is one of the first things I do when I get to a new 
city. 
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65 This is a bigger, more important tip than it sounds. When 
you first arrive in a city, take a two-hour city bus tour 
just to go scouting for locations. Don’t take your DSLR, 
or you’ll turn it into a photo shoot — this is to find out 
which places are covered in scaffolding so you can skip 
it; which places to go back to you never knew about, and 
a chance to enjoy the city without just seeing it through 
your viewfinder like usual. Take your cell phone to take 
location scouting photos and name of places, buildings 
and streets you want to go back to. 

66 Here’s what I found on my scouting trip my first day in 
Rome. I found that, like most of anywhere these day, 
they are restoring the thing I most wanted to shoot at 
dawn the next day. At least I knew, so I could shoot at 
dawn somewhere else the next day. 

67 Yeah, the scaffolding this is pretty much everywhere. 

Long Exposures.

TRAVEL 
PHOTOGRAPHY 
WITH CANON EOS

Photoshop World Orlando 2019 68 Long exposures are not just for landscape photography 
— this is also a technique you will definitely want to add 
to your travel photography bag of tricks. 
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Smooth 
Silky 
Water

TRAVEL 
PHOTOGRAPHY 
WITH CANON EOS

69 Most cities you travel to will probably have some moving 
water: fountains or waterfalls or rivers or lakes or 
stream or canals, and adding movement smooths out 
choppy water, and makes waterfalls and fountains silky, 
and there’s a hidden benefit — really long exposures can 
also remove tourists. 

70 Here’s the choppy water turn smooth thanks to a long 
exposure, and if your clouds are moving; even better 
because you’ll get a sense of movement from them as 
well (well, as long as the clouds are moving). 

71 Here the river is totally smoothed out using a long 
exposure, and the cloud have that classic long exposure 
streak. 

72 It’s perfect for the canals of Venice because not only 
does it smooth the water, it removes all the water bus 
traffic, too. 
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CIRCULAR NEUTRAL DENSITY FILTER

ND 
FILTER

TRAVEL 
PHOTOGRAPHY 
WITH CANON EOS

73 To pull off these miracles of motion you need a Neutral 
Density filter (called ND filters for short). These are 
simply very dark filter that force your shutter to stay 
open for long amounts of time during daylight hours 
(like up to 10 or 12 minutes long), when you’d normally 
have a very short shutter speed in daylight (like 1/1000 
of a second or faster. Probably faster). 

3-Stop 10-Stop

74 They measure the darkness amount of an ND filter using 
“stops” so a 3-stop filter is kinda dark, and a 10-stop 
filter is really dark (and what you’d normally need for 
shooting in direct sunlight). I have both a 3-stop and a 
10-stop, and you can stack a 3 right on top the 10-stop 
when you want an even longer exposure. So yes, I 
recommend getting both (there are lots of brands to 
choose from, I use Haida ND filters). Here’s how to set 
up your camera to shoot long exposures. 

auto focus to set your focus.

1

75 Start by using your camera’s auto focus to set your 
focus. I generally shoot my long exposure images at f/16, 
to the make the exposures a little longer but without a 
visible loss of quality. 

switch lens to manual focus.

2

76 Once you have your focus set, on your lens turn off your 
Auto Focus button so it’s set to Manual Focus. That way, 
your focus won’t accidentally change when you go to 
take the shot.
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now put your ND filter on.

3

77 Now put your ND filter on in front of your lens. The 
reason we do this in this order is that on a DSLR, once 
you put a 10-stop ND filter on, it’s so dark your camera 
can’t focus, so we focus before we put the filter on. If you 
shoot a mirrorless camera, you won’t have this issue, so 
you can put on the filter right from the start. 

switch to 
BULB MODE:  
for exposures  
lasting more  
than 30-seconds.

4

78 Most cameras are limited to an exposure of 30-seconds 
long maximum, so you have to switch to a special camera 
mode that lets you keep your shutter open as long as 
you want (with no maximum amount of time).  It’s called 
“Bulb Mode” so switch your camera to bulb mode now. 

cover your viewfinder.

5

SKIP THIS STEP IF SHOOTING MIRRORLESS

79 With regular DSLR viewfinders, light can leak into your 
long exposure shot through your camera’s viewfinder. 
Some higher-end cameras actually have a little switch 
that puts a small door over the opening for you, but few 
cameras have this mini-door feature, so you’ll need to 
either put a piece of black gaffer’s tape over your 
viewfinder, or if you’re a Canon shooter…

TIP: There’s a  
viewfinder cover  
on Canon  
camera straps.

Photoshop World Orlando 2019 80 There’s actually a small black rubber viewfinder holder 
right on your Canon camera strap! (You always 
wondered what that was for). You slider the viewfinder 
cap off, and then slider this cover right over it. 
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figure out how long to keep  
your shutter open.

6

81 You can do the math, but honestly, there are apps that 
will do it for you, and they’re either cheap or free. 

82 You can try an phone app I use just for timing long 
exposure shots. It’s called “ND Timer” and you tell it 
what your shutter speed BEFORE you put the filter on, 
and then what type of ND filter you’re using (3-stop, 6-
stops, 10-stop or even stacking multiple filters) and it 
not only tells you the exact amount of time you’ll need to 
keep your shutter open for a proper exposure, it’s got a 
built-in timer, and alarm, to remind you when to close 
your shutter.

83 ND Timer” costs 99¢ for iPhone users. A similar app for 
Android phones, ‘ND Filter Timer’ is free. Sweet! :) 

Press cable release and lock.

7

84 Now take the shot by pressing the shutter button on 
your cable release and switch the shutter button lock to 
the ‘on’ position on your cable release so it’s locked into 
position (that’s better than standing there holding down 
the button for 8  or 10 minutes or so). 
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Wait patiently.

8 

Photoshop World Orlando 2019 85 Now you just kinda hang-out and do nuthin’ until the ND 
Timer app (or whatever you’re using to time your long 
exposure) tells you it’s time to release the shutter 
button lock, and when you do that, the shot is complete. 

86  I made a short video in the field recapping the steps for 
shooting a long exposure image. 

87 If you’ve shooting travel, tourists are always going to be 
a problem, but you just learned a technique that can 
remove tourists — long exposure. A very long exposure 
— one like six to 10 minutes. To get to that length of time 
you’ll need at least a 10-stop ND filter but more like a 
10-stop and then another 3 stop or more stacked in 
front of it but once you do that, anyone that doesn’t stop 
and stand in one place for a long period of time, will 
literally be removed from the scene. Here, we look it up 
a step by using that small puddle of water as a reflection. 
I didn’t have a Platypod with me, so we turned the 
tripod’s center column upside down (and the camera as 
well) to get down really low.

88 Here’s the shot we were taking. Notice everybody’s 
gone from the shot? There’s a little blur of people down 
off in the distance, but all the people casually strolling by 
our foreground are all gone, which is awesome, and that 
courtesy of our 11-minute long exposure. That tiny little 
puddle created a really nice reflection. Also, since we 
turned our center column upside down, the image was 
taken upside, so in Photoshop I just had rotate the image 
back 180° — piece of cake. Now, with my Platypod, the 
whole process is much easier, and it gets just a low (we 
tested it side by side with an upside down center column 
tripod shot. They look identical).  



104

tourists can kill the scene

Photoshop World Orlando 2019 89

90 Shots with lots of tourists pretty much kill travel shots. 
Want to avoid crowds of tourists?

91 Get there early. If you get to the most popular 
attractions in the early morning hours, everything will 
be pretty empty, often the ground or streets will be wet 
creating nice reflections and you’ll have a view of the 
city most people won’t bring back. Here’s what it looks 
like at the Taj Mahal about 30 minutes after it opens in 
the morning. An hour more later and there’s 5,000 
people milling around everywhere. But there’s another 
way to get rid of tourists. 

another method for 
removing tourists.

Photoshop World Orlando 2019 92 This one is part camera technique and part Photoshop. 
Stand in one place (if you have a tripod or platypod, use 
it); keep your camera up to your eye, and take a shot 
every 10 seconds or so. Try to move the camera as little 
as possible between shots. Take around 10 or 15 shots 
total (so you’re shooting for around 10 minutes). 
Photoshop will do the rest for you, as you’ll see in the 
video coming next. 



105

93 Here I show you the step-by-step way to have 
Photoshop automatically remove the tourists from 
those 10 or 15 shots you took. These I took in Miami 
Beach. 

File > Scripts > Statistics

For Stack Mode choose “Median”

Click ‘Add Open Images’ button

1

2

3

94 Here’s a recap of the steps: Open all 10 or 15 images in 
Photoshop so they’re open at the same time. Then (1) go 
under the File menu, under Scripts and choose Statistics. 
When the Scripts dialog appears (2) for Stack Mode 
choose Median. Then in that same window (3) click the 
“Add Open Images” button so it uses all those images 
you opened. Now just click OK and Photoshop will do 
the rest. As long as everybody was moving in the image 
(no one was standing still for the full two minutes you 
were shooting), all the tourists will be gone.  

what to shoot  
in bad weather

Photoshop World Orlando 2019 95 It’s part of travel — sometimes it rains. Sometimes it 
rains a lot, and you have to have a Plan B. The plan B for 
me usually is…

96 Don’t go shoot cathedrals, opera houses, markets, and 
ornate government buildings when you have beautiful 
weather. Save those for the inevitable rainy days — 
that’s a perfect time to capture these. 
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97 Save as much indoor shooting as you can for the last day 
— that way, if it does rain, you can move that shoots up 
sooner in your itinerary but if you wind up with great 
weather the whole time, then your last day is all indoor 
stuff. 

get the classic shots 
out of the way.

Photoshop World Orlando 2019 98 Even though you might find the classic monuments and 
scenes totally “played out,” friends and family back home 
absolutely expect to see these shots from you, and they 
like to see them right up front. 

99 Don’t disappoint them — shoot these early in your trip 
so you absolutely get them, get them out of the way 
now, and then spend the rest of the time trying to create 
the type of shots the photographer in you wants to take. 
When you get back and you’re sharing the images from 
your trip with family with friends, show this classic shots 
right up front, so they can relax knowing they’ve seen 
the classic shot they were waiting for, and now they can 
actually enjoy the rest of your images without any 
anxiety. 

think like  
you’re  

shooting for  
a magazine

100 If you want to come back with some “next level” shots, 
treat the shooting part of your visit to your chosen city 
or country like you were sent there on assignment by a 
magazine. This a great way to stretch and practice your 
visual storytelling skills. It kind of makes you take the 
type of images that really tell the story, and that’s what 
travel photography is really all about. So, which types of 
images actually wind up the most in magazines (you’re 
about to get your shot list): 
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photos of people.

Photoshop World Orlando 2019 101 Photos of people. You can’t show a city or country 
without capturing the people who make it what it is. A 
lot of us are uncomfortable photographing other people, 
but if you were on assignment, you know you’d have to 
come back with plenty of people shots, so this will help 
you make that happen. Your photos can be of your 
server in a restaurant or your local tour guide (and by 
the way, guides will often help you find and convince 
people to let them take their picture), or of a sweet 
vendor you just bought from fruit or flowers from. 

102 Shots of older people and kids can’t miss. Open the door 
by you giving them a big smile — it makes a huge 
difference. 

smile. shoot. share.

Photoshop World Orlando 2019 103 How to getting strangers to pose: Smile first, hold up 
your camera with a look on your face like “Is it OK to 
take a photo of you?” and more often than not, they’ll 
nod yes. Shoot quickly (don’t shoot them to death) and 
then show them the back of your LCD. Once they see it, 
they’re likely to let you shoot some more.

104 You can also take photos where your subject isn’t posing, 
and often times these make the best images, because 
when people pose for you, usually they give you a big 
“posed-looking” grin. Just kind of blend in with scenery; 
just stand there and see what walks by. Patience and 
staying in once place can really pay off here. 



108

color as your subject.

Photoshop World Orlando 2019 105 People love bright beautiful colors, which is probably 
why so many places feature bright colors. Look for 
contrasting colors as you’re strolling through the city or 
countryside.

106 If you see a brightly colored wall; park yourself across 
from it, and it probably won’t be long before somebody 
wearing a wonderfully complimentary color walks in 
front of that wall. Be ready for it.  

107 Bright, vibrant colors attract. 

108 The muted colors in this photos help convey a sense of 
place, as they were all taken walking around downtown 
Santa Fe, New Mexico.
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shoot the food.

Photoshop World Orlando 2019 109 Before you eat it...shoot it. The problem is having 
enough light to get a steady shot, and the trick is to ask 
to sit either outside or near the window so you have 
natural light right there.

110 Cafes, markets, bars and those charming places where 
we stop to eat, drink and relax make for wonderful 
photos, so put a few of these on your list. You don’t have 
to do anything more than to shoot the places you’re 
already going to be eating at. As a customer, they’ll 
pretty much let you shoot to your heart’s content. 

111 Sitting by a window in a cafe, these were all taken during 
the same meal. Lovely little dishes in great light. 

112 As far as camera technique goes: use a zoom lens and 
zoom-in really tight to only show part of the dish. Also, 
use a wide-open f/stop (like f/2.8, f/3.5, etc.) and 
sometimes try tilting the the camera (as I’m doing here) 
to add some energy to the shot.
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113 Here’s the shot I was taking in the previous shot (thanks 
to my wife Kalebra for taking the shot of me shooting). 

114 None of these shots are good enough to carry a page in 
your photo book or slideshow as a “hero shot,” but as 
“story telling” shots together in a group like this, they 
work really well. All taken during the same meal, and 
yes, we asked to sit near the window. That is key 
— either by a window or outside under an umbrella (so 
the light is soft).  

115 Having my lunch outside under an overhang. This 
appetizer is begging to be photographed. 

116 Zoom in tight; tilt the camera; shoot wide open at your 
lowest-number f/stop and you’re there!



111

117 This one is in really tight, but without the tilt. Still works. 
And yes, this simple looking sandwich was delicious. So 
were the fries behind it. Mmmmm. Fries. 

shoot building details.

Photoshop World Orlando 2019 118 It’s very hard to capture an entire building, and if you are 
able to capture it, it’s probably going to look very tiny, 
but by capturing just part, or the details, or an 
interesting building it not only suggests the whole but 
helps to capture the scale of the building. 

119 Shooting in tight like this avoids tourists, signage, power 
lines, the sadly ever-present graffiti, and other modern 
things that would otherwise spoil the shot. 

nighttime city shots.

Photoshop World Orlando 2019 120 Everybody loves color and night scenes in a city show 
lots of color.
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121 You’ll definitely want to be on a tripod for these night-
time shots and you’ll want to use a cable-release or 
wireless trigger so there’s no movement whatsoever 
while your shutter is open for long periods of time. 

what the locals  
are wearing.

Photoshop World Orlando 2019 122 It always come back to people. 

123 People love fashion and want to see what the local 
fashion is, and what the locals are wearing, so keep an 
eye out a fashionable-looking man or woman (or a 
couple) and capture them in their environment. 

cityscapes from a 
high vantage point.

Photoshop World Orlando 2019 124 This is a view that shows the vastness of the city and 
people love them. 
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125 This is a view that shows the vastness of the city and 
people love them. The trick to getting up high is finding a 
rooftop restaurant or bar. If you can’t find one before 
you leave, try staying in a high-rise hotel then asking the 
hotel Concierge to help you get the opportunity to shoot 
from a high view point in the hotel. They rely on tips so 
they’re often will to get management to give you access.

cafes and markets 

Photoshop World Orlando 2019 126 Cafes, markets, bars and those charming places where 
we stop to eat, drink and relax make for wonderful 
photos, so put a few of these on your list.

127 You don’t have to do anything more than to shoot the 
places you’re already going to be eating it — just bring 
you camera with you to dinner (well, that’s what I do 
anyway). As a customer, they’ll pretty much let you 
shoot to your heart’s content. 

cathedral interiors  
and exteriors 

Photoshop World Orlando 2019 128 Visits to Cathedrals, Mosques, Temples, etc. are popular 
stops are on almost every tour in every city. The 
craftsmanship in many of these beautiful places are just 
stunning…
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129 As is the light. The light in these cathedrals can be so 
dramatic and stunning. Make sure you take a tripod or 
something to keep your camera steady (if they don’t 
allow tripods, use a Platypod, or just steady your camera 
on whatever you can — a railing, a pew, a chair; whatever 
will keep your camera still for a few seconds. Also, this is 
a perfect place to shoot HDR to capture the detail inside 
the cathedral and detail and dimension in the stained 
glass as well. 

shoot for slideshows 
or photo books 

Photoshop World Orlando 2019 130 Don’t make the mistake of trying to take nothing but 
“hero shots” (the type of big sweeping epic shots you 
might enter in a travel photography contest); the story 
of your trip won’t be just mammoth cathedrals and long 
exposure shots of canals. Take the little detail shots that 
will help you tell the story. 

131 Take a look at this shot for example. Hmmmmm. It’s an 
old tin box with some wire sitting on what looks to be a 
trash can. Not exactly captivating on its own… 

132 …but pair it with some other shots from that area, and it 
helps tell the story. Not every shot can be a hero shot, 
and they don’t need to be. Capture the details; group 
these shots together and let them help tell the story of 
your trip. 
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133 Here are three totally unremarkable shots, but they 
really work well when you place them together. I 
remember that restaurant, I remember shooting that 
menu, and I absolutely remember how amazing that 
French Onion Soup was (of course, in Paris they don’t 
call it French Onion Soup. It’s just Onion Soup. If you ask 
for ‘French Onion Soup’ it’s like going to McDonalds in 
New Jersey and asking for ‘An American Big Mac.” 

travel photo recipes.

134 Here are some ingredients you can use to make better 
travel photos. 

135 It’s hard to get busy people leading their lives to stop 
and take time out to pose for you. Luckily it’s never been 
easier to hire a model (or in my case, two!). Thanks to 
Instagram and Facebook, finding professional male and 
female models in other countries is a breeze, and it’s less 
expensive than you’d think. I’ve had fantastic luck in 
hiring models (I always make sure up front that they 
speak English); and met some really nice, really 
photogenic folks in the process. We borrowed the 
umbrella from the doorman at the hotel.

136 In this case, I hired a model; rented a Venice Carnival 
dress and mask, and even rented the ballroom from a 
local hotel for two hours (for less than you’d think). 
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137 We’re done with our shoot, we’re walking out of the 
ballroom, down to the lobby, when I turned back to see 
this scene. I asked our model to stop for a moment so I 
could grab a quick shot — the contrast of her dress 
against the stairs, and the wonderful statues and 
staircase — I couldn’t resist. 

138 Here’s a super short BTS video. I was a lot close to our 
subject than it looks, but that’s because I’m using a 
super-wide angle lens — my buddies Tamron 15-30mm. 

139 A wonderful model/actress we found via Facebook. We 
asked her to dress in an old Italian style like from the 
classic old movies. We then rented an old Vespa and just 
rolled it into a nicely colored alley right next to the 
Vespa rental place. We never even started the engine. 
Our model was so patient and fun (and spoke great 
English).

140 Here’s a few more shots from just a few feet away from 
the alley (maybe 60-seconds?). 
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141 I saw this shot, but there were lots of people 
around. So I just waited. Finally, I had a short 
window –about three seconds - where nobody 
was in the frame and I made the shot you saw 
previously. If you see something that looks really 
interesting, but you need something to happen for 
it to reach your goal (in this case, I needed some 
people to walk away for a moment), take the time 
and see what might develop. It doesn’t always 
work out — in this case I got lucky, but I wouldn’t 
have got lucky if I hadn’t decided to wait it out in 
the first place. 

142 The key to this shot is called “being patient” (and 
getting pretty lucky, too).

143
This tip uses the concept of changing your 
perspective. If you are in a spot where there are a 
bunch of tourists, or a busy location, see if you can 
lower your camera and tilt up to capture scene 
and avoid all the tourists.

144 Same scene, but by getting really low with your 
perspective, it hides all the buses, tourists, signs, 
etc. 
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145 This is a mini-pano. Just two shots. That’s right — just 
two frames with a wide angle lens, and it makes a very 
compelling, super easy to shoot and stitch together final 
image.

146 Oh yeah, the rain on the concrete under the bridge 
which was reflecting the lights didn’t hurt either. Total 
luck. 

147 Whether you’re presenting to a big or small group - it 
means you have everything in place to give you the best 
chance of having your message connect with the 
audience.  

 

148 Whether you’re presenting to a big or small group - it 
means you have everything in place to give you the best 
chance of having your message connect with the 
audience.  
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my secret weapon.

Photoshop World Orlando 2019 149 Whether you’re presenting to a big or small group - it 
means you have everything in place to give you the best 
chance of having your message connect with the 
audience.  

 

platypod ultra

Photoshop World Orlando 2019 150 Whether you’re presenting to a big or small group - it 
means you have everything in place to give you the best 
chance of having your message connect with the 
audience.  
 

151 Whether you’re presenting to a big or small group - it 
means you have everything in place to give you the best 
chance of having your message connect with the 
audience.  

 

152 There’s my secret weapon — the Platypod Ultra taking a 
shot in the St. Peter’s Basilica — a place where tripods 
are forbidden and security is everywhere. In fact, they 
saw me placing my camera on a railing like this with my 
14mm super-wide angle and then didn’t say a word. I put 
it on railings like this, on barricades, and even on the 
floor, and I was able to get sharp, crisp shots in low 
lighting that would have been way too hard to hold still 
hand-holding. I set my f/stop to f/11 to everything would 
be in focus, and I even shot bracketed shot. It was a 
mirrorless camera, so I set the shutter to silent.  



120

153 Here’s the final image, taken from a barrier to keep you 
from walking through this area. 

154 This was taken down low using my Platypod during a 
public tour of the Venice Opera House. I just waited 
until most of the people from our tour had moved on to 
a different area. The low perspective made the seat look 
big and they totally hid some tourist sitting in some of 
the seats on the far left. 

155 Here I’m inside the beautiful library of the Admont 
Abbey Monastery, not far from Hallstatt, Austria. I 
found out about it researching on 500px and Pinterest 
before my trip there last year. When we walked it there 
was a tour group of about 40 people standing right in 
the center of the room, and about 20 other people 
wandering around, so we just waited them out. I’m 
always surprised when it works, but that technique 
works more often than not. Plus, you don’t need it empty 
for 20 minutes — just for about 1-1/2 seconds. 

156 Once everybody had cleared out, we had nearly 20 
minutes by ourselves without any tourists whatsoever. I 
set-up my Platypod with a 15-30mm Tamron super wide 
angle lens; placed it on the floor and aimed upward quite 
a bit (the ceiling it pretty awesome, but I also wanted to 
get some of this tile floor as well, so I shot it at 15mm). I 
took a series of bracketed exposures to get the shot you 
just saw a moment ago. 
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the secret to making 
more interesting pictures.

Photoshop World Orlando 2019 157 Joe McNally was teaching at a workshop where I was 
one of the guest instructors, and he said something that 
really stuck with me. It was something an Editor at Life 
magazine once told him. Joe’s Editor said, “If you want to 
take more interesting pictures, stand in front of more 
interesting things.” Think about it. That changes 
everything, and it has pushed me to travel to new, 
interesting new places…

158 Like Mont St. Michelle about four-hours outside of Paris. 
It rained all the way here for four solid hours — cats and 
dogs. It was still raining a bit when we got there. We 
walked the 30 minute flat easy road to get there and the 
clouds cleared and this was our scene. Incredibly lucky. I 
prefer blessed, but sure, luck is always welcome, too. 

159 You can’t tell, but I’m set-up behind a rope and 
stanchion, down on the ground to get this low 
perspective. This is inside the Sheikh Zayed Grand 
Mosque Center in Abu Dhabi, UAE. 

160 Dawn at the St. Charles Bridge in Prague. I had to 
compose the shot this way, because the rest of the 
bridge was filled with not only lots of tourists, but 
people who were totally hammered having just left a big 
party nearby. 
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161 Havana, Cuba in the old town section (well, it’s pretty 
much all an old town section, but an awesome one at 
that). We hired an old classic car, a driver and a 
translator for $50 total for the day). It was our rolling 
model. 

162 Over-looking Prague about an hour after dawn. 

163 The interior of the Sydney Opera House in Sydney, 
Australia taken with a super wide-angle lens. 

164 The Seine river in Paris about 20 minutes after a rain 
storm chased us into a small cafe. We had a sandwich 
and coffee, and when we came outside again, this was 
the scene. 
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165 In beautiful Prague again — in the lobby of an office 
building/hotel ; shooting straight up to the skylight 
above its light-bulb shaped spiral staircase.  

166 A small chapel in the Dolomites of Northern Italy.

167 The most amazing bookstore in Italy — one where 
gondolas glide by. 

168 Here’s a shot of the Dolomites. I made a large sized 
canvas of this and gave it to my brother Jeff as a gift. He 
was sitting right beside me, on a bench, while I took this. 
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169 The hall of Mirrors in Versailles, France. 

170 A small chapel on a hill overlooking Vik, Iceland

171 Hallstatt, Austria just after dawn. 

172 St. Christopher’s chapel, London. (Note: only four pews; 
it’s  probably the smallest chapel I’ve ever been in, bu 
the super wide angle lens makes it look epic). 



173 Walkway to the gardens at Dromoland Castle, Ireland. 

sharing your story.

174 I think I’ve found the best modern way to share travel 
images. Heck, any type of images, but I think it’s 
particularly well suited to travel. 

Adobe Spark Page

Photoshop World Orlando 2019 175 It’s called ‘Adobe Spark Page’ and it’s a free service you 
get as part of your Adobe Creative Cloud plan, and I’ve 
found it is hands-down the best way to share, not only 
your images online, but the story behind them as well. 
And it’s so easy to create your visual story because it’s 
all pretty much drag and drop.  

ScreenFlow of Spark Page here.

176 Here’s a quick video on how it looks when you view your 
images online. You get to decide how large to make your 
images (I make my “hero shots” full screen width, and let 
supporting shots that move the story along be the 
smaller, but still decent size, size).

125



spark.adobe.com

177 Go share one of your trips there tonight. It doesn’t have 
to be your most recent trip — it can be any trip at all. Try 
it once and you’ll be hooked. 

“I haven’t been everywhere yet, 
but it’s on my list.”

—SUSAN SONTAG

178 I love this quote. It’s on my list now, too. 

Thanks, everybody! 

179 Thanks for listening, and I wish you great adventures, 
lightweight camera bags, marvelous food, lots of good 
luck along the way, and some truly memorable images. 
Safe travels. 
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With MOOSE PETERSON

50 Tips in 60 Minutes

Moose Peterson
Wildlife & Aviation Photographer

Moose’s passion lies in photographing and bringing attention to endangered wildlife and  
preserving the role aviation has played in history. Along the way, Moose has been honored  
for his photographic passion as a Nikon Ambassador USA, Lexar Elite Photographer, and  
recipient of the John Muir Conservation Award. He shares his knowledge through his  

writing, being published in more than 143 magazines worldwide and authoring 28 books. 

We need to keep our mind, eye, and heart on just one thing when we’re shoot-
ing: the subject. This sounds so simple, but yet as we all know, photography 
brings a whole bunch of challenges to this simple task. So the more variables we 
can remove in the photographic process, the better we can concentrate on the 
subject and the better our visual storytelling. This is why time is such an impor-
tant ingredient in improving our photography. The more time you put in—as in 
years—the better you are at removing all those variables and concentrating on 
just the subject.

The 50 tips and techniques I have assembled here are really the most common 
variables that tend to get in the way when shooting. There are also ideas to push 
your photography further, and in doing so, possibly introducing new roadblocks. 
We must understand the weakest link in the photographic process is us, so if we 
can improve us, then we can improve our photography. This means that we need 
to practice so much of what we’re going to talk about that it becomes second 
nature, muscle memory, and subconscious action. It’s for this reason that every 
day, whether I’m shooting or not, the camera is in my hand. So, while some of 
these tips and techniques are a duh…understand that, for my own photography, 
I put great value on them and consider them important to my own photographic 
success.

This is all about your photography, so this is what you must do. You need to lis-
ten to what I have to offer and those ideas, concepts, and techniques that you 
think will apply to your photography, embrace them totally. And those ideas, 
concepts, and techniques that don’t apply to your photography, completely 
ignore them! One of the great beauties of photography is our ability to share 
with all and still stay an individual. Photography is all about how you take those 
memories, those subjects that are special to you, and how you share them with 
the rest of the world. You are all unique individuals and your photography, once 
you get past all these variables, will reflect just that, your unique visual storytell-
ing. Keep in mind, one of the goals I’m trying to instill in you is getting the image 
right in the camera and using your post-processing skills for finishing and not 
fixing. And just so we’re clear, these are all things that I do and implement in my 
photography every day.

Let’s dive in! (Note: These are not in any sort of order or priority.)



128

notes

the

Basic Hand-Holding – Wondering if your technique works? Simply open up your 
fingers, loosen your grasp on the camera, and if it doesn’t hit the ground, you’re 
doing it right. Otherwise, you want to do this: With your left hand, palm turned 
up, grasp the lens barrel as gravity presses it into your hand. With your right 
hand, firmly grasp the camera body (and with your index finger, roll your finger 
on the shutter release to first activate the camera and then fire it). Pull the cam-
era back against your face, preferably with an eyecup in place acting like a shock 
absorber. At the same time, tuck your elbows into your sides. This technique 
works for both static and moving subjects when panning is essential.

Embrace Failure! – Yep, failure happens, so don’t be afraid of it. Rather, embrace 
it and take it as another lesson you can learn from. There isn’t a photographic 
tip or technique that didn’t have some origin in failure. The reason that the tip or 
technique became valid is because the reason for the failure was figured out and 
solved. As my oldest son told me while trying to teach me how to cross-country 
ski, “Dad, if you’re not falling down, you’re not learning.”

The Mind’s Eye – Understanding how our vision works is essential and a chal-
lenge. Our eye and brain bring to life our world automatically and magically. Our 
cameras and computers don’t have the same tools, and definitely don’t have the 
same abilities. We need to understand how both systems work and then jump 
through the hoops to make them match our heart in the final image. For exam-
ple, it has been shown that we can see as much as a 14-stop range of light with 
one glance. Our mind’s eye seeks out visually light and bright above everything 
else. And our vision color corrects for nearly all light sources, where we know 
our cameras do not. The mind’s eye is something you need to grasp and master.

Tripod Center Column – The tripod is an essential tool that, like any tool, needs 
to be used correctly to maximize its potential. The three legs of a tripod meet at 

With MOOSE PETERSON

50 Tips in 60 Minutes
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a point, that point being the maximum point of stability. When you move the 
camera/lens from that point, you risk the possibility of an unstable platform. 
With faster shutter speeds shooting a rock, this isn’t really an issue. But when 
panning with a subject or shooting at a slower shutter speed (the time most 
photographers pull out a tripod), this might be an issue. It’s for this reason you 
will find most professional photographers don’t have a center column. This is 
because when you extend that center column, you move the camera away from 
the most stable point of the tripod. Also, when it comes to travel, you lessen 
the weight of the tripod and that can be a big benefit.

Shooting Buddy – A huge component of photography is the sharing, and this 
includes the actual shooting process. Finding a shooting buddy can make the 
whole process funnier and that can only improve your photography. Just like 
any aspect of photography, find that shooting buddy who will challenge you 
and who you will challenge. One way of doing this is every time you go out 
shooting, take turns deciding where and what you’re going to photograph. Mix 
it up and go after subjects that you might not even consider or do on your 
own. Photography is about light, so no matter the subject, you can always 
learn something and that’s the whole point. Having fun while learning always 
improves your photography!

Is the Center a Death Zone? – Common mythology states that placing the sub-
ject in the center of the frame is the worst and you’re facing death by doing so. 
But did you know that placing the subject in the center is the strongest compo-
sition we have? That’s if all the elements in the frame support it. That’s a big if.

ACR Preset – Adobe Camera Raw, whether used as a standalone or as the 
engine in Lightroom, is a powerful tool, making finishing easier. When we get 
the best possible capture from the start, post is a no-brainer! One of the quick-
est ways to standardize ACR, to use it as a learning tool as well as a finishing 
tool, is to create your basic preset. The mind’s eye, after 20 seconds of looking 
at a photo, replaces that last “memory reality” with what it’s currently seeing. 

With MOOSE PETERSON

50 Tips in 60 Minutes
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By creating that preset, you are beating the clock so the memory you have isn’t 
necessarily being replaced with a new reality. Of course, we all know that reality 
is not what we’re truly dealing with in photography, it’s all perceptions. But start-
ing at a point as close as to our own reality as we can helps with the learning 
and visual communication our photography potential has to offer.

DX Crop/Video Button – there are simply times when the lens we have attached 
to the camera isn’t enough and we either don’t have that longer lens or don’t 
wanna take the time to attach it. One of the features I love about the Nikon full-
frame cameras is the ability to go to DX Crop. I prefer to do and have, since day 
one, done all my cropping in the viewfinder, never in post. This feature sets the 
full-frame camera to DX mode, which crops the photo in-camera and increases 
the focal length of the lens in use by 50%. Because I use it so much, I have the 
Video start/stop button on the D4 set up so, by simply depressing it and rotat-
ing the subcommand dial, I can go right into DX Crop. I can do this without tak-
ing my eye away from the viewfinder and that is very important.

Set Time Zone in Camera – This is so obvious it gets overlooked. Our cameras 
have the ability to record the time and date in the EXIF data (location, as well, if 
you have a GPS unit) and you should take advantage of this. There is the obvi-
ous reason, which is the filing of our photos as time and date is the default sort 
for most DAM programs. But, more importantly, is what it can help us learn. Let’s 
say you go to new location and have some good shooting, but you know you 
can do better. You go back to that location a second or hundredth time and you 
want to know what time and date you went to a specific location? If you’re not 
anal about making sure you have the time zone set in your camera, you’ll have 
to take good paper notes. But with the time zone set, all you have to do is look 
at the EXIF data for that photo you want to improve, and you have all the info.  
I find this essential in my own photography!

Clean Sensor After Travel – There is nothing worse than dust spots! They are 
just annoying. Many photographers clean the sensors of their cameras prior to 
going on a shoot. This is a good idea, but it doesn’t mean that your sensor will 
be clean when you start shooting. When you drive or fly (or both) to get to a 
location, your camera body will be bounced, and this can cause dust to get on 
your sensor. Now, where that dust came from is a mystery to me, but it finds 
its way to the sensor. This is why, when I travel, the first thing I do when I arrive 
onsite is check my sensor for dust. I don’t do this in the field, but in the safety of 
the room. There is always something there and with a couple of squeezes of the 
blower bulb, it’s gone, and the camera is good to go. Those few seconds often 
save lots of time in post later on.

Look at Images Every Night – One of the great blessings digital brings to our 
photography is the ability to look at our images instantly. I’m not talking about 
“chimping.” I’m not a fan of chimping. I’m talking about uploading our images 
into our computer and going through all our day’s shoots that night. Yes, look 
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for those basic things like exposure and focus, and if you see an issue, figure out 
what caused it, and if need be, write yourself a physical note to avoid the issues 
in the future. More important is what looking at our day’s shoot can teach us 
about storytelling. Look at the story you have before you. Do you have all the 
elements? If not, what images are needed to tell that story? When you remove 
yourself from the technical side and look at the story side, you will start seeing 
elements in your photography otherwise overlooked. You will be surprised how 
doing this every night quickly affects your photography.

For Red Skies, Go to Cloudy – Auto White Balance (AWB) is a great feature in 
our digital cameras that, for a majority of our shooting, does a great job. In a 
basic summation of its job, it’s to match the color temperature of the light falling 
on the subject with the color temperature of the digital capture. You can think of 
it as trying to average all the color so what we saw is what we see in our photo. 
But this averaging doesn’t work perfectly all the time, and when that happens, 
we often get a color cast. But when it comes to sunrises and sunsets, AWB aver-
ages out the best color, often leaving us short. So it’s really simple: when I see a 
red sky, I switch the white balance to Cloudy (what is 6000 K). This then forces 
the 3000 K or less kelvin red color in the sky to be captured closer to all its glory.

Can’t Polish a Turd – The tip is as obvious as it sounds. It’s basic human nature 
that, when getting skunked photographically (which happens all the time), we 
feel the need to take some sort of photo because, after all, we’ve put in all that 
time and energy to get to that point to get skunked. Then, once we take that 
horrible photo and are back at the computer, we say to ourselves, “Well, I went 
to all that trouble to get to that place to take that photo and now I have that 
photo, let’s make something out of it in post.” The problem is that the photo still 
sucks. The old adage still applies about computers: garbage in, garbage out. So 
if you don’t put in the garbage to start with…. Train your eye to just see the good 
stuff, which means, don’t take the bad stuff.
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Go Early, Stay Late – there is nothing worse than to wake up and see out the 
window that great color you meant to get out and shoot. Or even worse, see-
ing in your review mirror that great shot that would have been in your camera 
if you’d stayed just five minutes more. Time is one of the greatest and most 
precious elements we can contribute to our photography. I have a well-earned 
reputation for getting up bloody early to go shooting. There is a really good 
reason for that: I hate missing a photo because I wasn’t there. There is an old 
saying in photography: f/8 and be there. I’m not so sure about that f/8 part, 
but that being there is essential. 

Highlight Warning/Blinkies – This is another of the great blessings of digital. 
When it comes to learning light, there are very few visual aids that, at the 
moment of looking at the subject, we can use to teach ourselves more about 
light. But we do have this one and it’s a powerful one. When you turn on your 
Highlight Warning—what I affectionately call “blinkies”—the camera’s LCD 
blinks at you those areas in your photo (if there are any) that are beyond the 
5.1-stop range of your camera. With this knowledge, it’s up to you to either 
ignore this information because it doesn’t affect your storytelling, or if it does, 
effect a solution. In either case, if you’re not sure about the light, you have a 
tool right in your camera to help teach you. That’s simply cool!

Counting Stops of Light – How many stops of light are in your scene? Why is 
that even important? If you take a photo and there are no blinkies in the photo, 
you can say there are less than five stops of light in the scene. If there are blink-
ies, you can say there are more than five stops, but how many more? If you dial 
in –1 exposure compensation and the blinkies all go away, you can say there are 
at most six stops. You dial in –3 exposure comp, and you can say there are at 
most eight stops. And if you’re photographing a scene with clouds, where with 
–3 exp comp you have no more blinkies, you know a 0.9 or 3-stop split gradient 
filter will compress the exposure so you can get it all with one click. Five (the 
range of our sensor) plus the number of stops of exposure comp dialed in to 
make the blinkies go away is the range of light of your scene. 
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Charge Your Batteries – Oh man, this is obvious, but oh man, how often it is 
forgotten. Even more important is to check their status if your camera pro-
vides that feature. If the batteries need to be refreshed, then do it!

iPhone for B&W – Many have a hard time seeing the color world around us in 
B&W (black and white are colors, just for the record). If this is you, take out your 
smartphone, make a click, and then use an app like Photoshop to turn it to B&W. 
You now have right before your eyes a B&W photo, and something you can 
compare real-time with reality. Greatest teaching tool around, your own eyes!

Color Psychology – You have it used against you every day. I think it’s time 
you turn the tables and use it in your favor! It’s really simple: certain colors 
trigger natural responses in humans, and if you know them, you can do the 
same thing. Blue, for example. When we see a predominance of that color, we 
think of cold or night. Red grabs everyone’s attention no matter the subject. If 
you know just some of the basics, you then know what colors you do or don’t 
want in your photograph, or which colors you have that you want to empha-
size. It is photographic manipulation in its purest form!

Stop Sign/Yield Sign – You can take color psychology one step further. There 
are some color combos that naturally grab our attention. You see them every 
day, but probably never thought about why you do. The most powerful color 
combo to us is red and white, the corner stop sign. The next most eye-catch-
ing is yellow and black, the yield sign. I bet if you think about it now, you can 
figure out the third most eye-catching color combo. This is all part of color 
psychology and how wired we truly are to color. Our vision is simply a miracle 
of complication.

“What If” – A question creatives ask themselves a lot. The key to this ques-
tion is to follow the thread. Quite often, as we’re shooting, the “What if…?“ 
question pops into our head, but rarely is it followed. Follow that thread and 
pull on it until the very end. Sometimes, it ends up blowing up on you and 
you learn that wasn’t such a grand idea. But, more often than not, it leads to a 
whole new realm you otherwise would never have explored. The inner creative 
self is pretty smart. Tap its potential and your photography will grow.

Give Yourself a Hand – Ever shot a series of images like an HDR only to get 
back to the computer and not be able to quickly pick out that series? I had 
that problem until I started to use my hand. Whenever you’re starting a series, 
an experiment, or a test, first take a photo of your hand. When you’re done, 
take one more. Just like in the movies, your hand is a clacker, so when you see 
it, you know that up until you see your hand again, you’ve done something 
different in your shooting. This is especially helpful a year later when you go 
back to find that series again.

Play with Gear at Home, Not on a Real Shoot – The time to play is at home 
when it’s not mission critical. All too often, I see photographers try to learn a 
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piece of gear as the photo of a lifetime is biting them in the ^#*(@! Mastering 
takes forever, so I’m not talking about that. Rather, understanding enough of 
the basics so you know where to find things on the camera/lens, so once in the 
field, you’re playing with the photographic possibilities and not the gear itself.

Test – And, while on that note, test! Those times when you’ve been skunked in 
the field, turn the moment around and test. Most of the great photographers 
are self-taught. They do this through learning from the failures and testing. 
Take a picture of your hand, do your test, and then take a picture of your hand 
again. And when you get back to the computer, create a folder called Testing 
or Experiments or Photos No One Else Should See and put a copy of your 
tests in that folder (including the hand shots). You’d be surprised, when you 
get in the habit of doing this, just how often you’ll refer back to that folder 
and teach yourself to take better photos.

Doing the Dance – This is the phrase I use when it comes to the very basics 
of composition. The dance is: including those elements that tell the story and 
excluding those elements that take away from the telling of the story. There 
are lots of ways to accomplish this, but one must understand it is a dance. 
And like learning any dance step, it takes times and practice, but you first 
must understand, it is a dance.

Background Is Everything! – When it comes to arranging the elements in 
the frame, I think of it as a production where the subject is the star and the 
background is the stage for that star to perform on. The background needs to 
perform two important roles in our photograph. It must make the subject pop, 
in part to visually tell the viewer of the photo that this is the subject. The other 
role is in the story telling, the background being the stage where the star acts 
out their part. Your photograph will only be as strong as the background.
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Visual Depth – We live in a three-dimensional world, but our photos are one-
dimensional (yes, technically it’s two, but a piece of paper or a computer 
monitor is flat). Bringing to life that three-dimensional world in the one-dimen-
sional format calls for visual depth. There are many ways to do this, but most 
rely on the simple concept of three planes. By having a foreground, middle 
ground, and background, the mind’s eye translates this into depth, and in our 
photograph, it just sucks the viewer in. And that’s what we want.

Rule #28: Always Look Behind You – This rule started for me decades ago and  
was shared by a friend I was fishing with. It was my first salmon trip in Alaska 
and he said, “You’re in grizzly country, always look behind you!” Well, he didn’t  
have to tell me twice, and now if you watch me shooting anywhere, anytime, 
you’ll see me constantly looking behind myself. There are always photographs 
around us, the trick is to find them. So, constantly looking behind us tends to 
turn up a photo or two. And you never know, it might even be a grizzly!

Composition – Don’t get hung up on it. Yes, I know, many talk about it and its 
importance to a photograph, which is true. But many photographers get so 
frustrated by composition that they simply don’t move on in their photogra-
phy, or worse, stop altogether. Stop buying books on it. stop putting every-
thing in a corner of the photograph, and just let your photography, like life, 
unfold. You will get in the swing of things with time, so give yourself the time 
and have fun!

Worst Weather Can Make for the Best Photos – Weather is such an amaz-
ing creator of killer light and we’re all about light. You’ve just gotta get 
past the weather, which can be a mental and physical barrier. The trick? 
Mentally, know you won’t melt and that you always have someplace warm 
and dry to go. Physically, if you can handle the weather, so can your gear. 
You don’t need to go through a bunch of hoops to cover it, just be sure 
to blot it dry, never wipe it dry. Keeping a clean, dry white towel with you 
then is the trick. And of course, have fun!

Back Button Focusing Must – I was told this for decades, but I didn’t go there. 
I’m a guy who can’t walk and chew gum at the same time, so how was I going 
to push two buttons to take one photo? Well, there are actually times when 
it’s a great benefit and times when it doesn’t work at all.

Exposure Compensation Is Your Best Friend – Exposure is how we commu-
nicate emotion! We control exposure the fastest with exposure compensation. 
Underexposure brings many benefits to our photography—sharpness, blacks, 
and color saturation to name a few. You need to learn this for your own photog-
raphy, so in the beginning, take a photo of your hand, shoot a set with each image 
having a different exposure value, and then shoot your hand again. Head back 
to your computer and look at those photos, and select the one you like the best, 
making a note of the exposure comp you used. Do this enough and you will 
know exactly what comp you want to communicate the emotion in your photos.
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The Idea Folder – There are times when photographic ideas simply aren’t fol-
lowing. You should look at photography all the time. During the course of look-
ing at photography, you should be coming across photos you simply think are 
cool. They might be within your own specialty or totally outside of it. Whatever 
the case, take that photo and print it out, take an iPhone snap, or tear it out of 
the magazine and put it in a folder. Then, when you come up against that cre-
ative wall, pull out that folder and take one of the photos and try to duplicate 
it. You probably won’t be able to duplicate it one for one, but you can duplicate 
the main concepts that attracted you to the photo in the first place. You’ll be 
surprised all you’ll learn and how fast you’ll break through that creative wall.

Read Books – Reading books, any books, other than photographic ones 
improves your photography. How? An author moves us through the story using 
words and phrases to excite and entertain our imagination. This directly trans-
lates to visual communicating. At the same time, if you read books about the 
subjects that excite you photographically, like sports, history, food, critters, or 
locations, you’ll be better versed on that topic. Just as our elementary school 
teachers taught us with our first writing lesson, the better you know a subject, 
the better your writing. This holds true for your photography. The reading of 
those books benefits your photography in so many ways.

Zoom with Your Feet – This is the one tip I have to offer when it comes to 
composition. Simply take one step closer to your subject. That’s it, physically 
take one step closer to the subject, not making the move optically. This one 
simple physical thing helps with doing the dance. Give it a try.
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Bend Over – We see our world, the vast majority of the time, from eye level. 
Most photographers shoot their entire career from eye level. Just bend over 
and see how the whole world can change. Don’t do it all the time, but just 
those moments when you think of it. Changing your perspective even a little 
can improve your photography.

Strap for Safety – Most photographers have a camera strap on their camera 
body. That’s a good thing. You can extend its usefulness by using it slightly dif-
ferently. Wrapping that camera strap around your wrist a few times is an effec-
tive way to prevent your camera from hitting the ground in any circumstance. 
For example, you’re shooting over the railing of a tall building or pier. Wrap that 
strap around your wrist and you’re good to go!

Own a Goof-Off Camera! – This can be anything from your smartphone cam-
era to a small pocket camera. Whatever it is, the point is to always have it with 
you and to just have fun clicking. A camera that really is no more than a point-
and-shoot means you just think about the experience and the subject. You will 
be surprised that when you have this and you use it, your photography will 
improve. The trick is to figure out what it is about this experience that makes 
the photos better and then move that to your “big” camera.

Remove Flying Stress – Getting on a plane with your camera gear can be very 
stressful. You can eliminate a lot of that stress by either gaining status by flying 
on airline continually, or by buying early boarding. The stress comes from over-
head space, so being aware of that and being proactive, you can remove a lot 
of stress.

Learn to Print – If there is one thing that will up your photographic game, it’s 
printing. When you print your images yourself and watch that piece of paper 
come out of the printer, you will see all the good and all the bad elements in 
your photography. It can be brutal sometimes, but it’s an amazing teacher. At 
the same time, it’s the only real method that is easily done to test the quality 
of your work. We’re talking about the quality you get out of your camera and 
out of your post-processing. You don’t have to be a master printer to learn, but 
with time, your printing will improve right along with your photography.

sRGB, Adobe RGB & ProPhoto RGB – Color is so important that you want 
every ounce you can get. I’m not going to get into all the debates, all the science, 
I’m just going to give it to you how I do it. The camera is set to Adobe RGB and, 
in post, all images are converted to ProPhoto RGB. And if an image is going to 
be posted on the web, it’s converted to sRGB. It’s just that simple and it works.

Rent Before You Buy – Camera gear is expensive, as we all know, and I keep 
coming across folks who bought a piece of gear they regret owning. To this 
day, I try out a piece of gear before I buy it. The trick to this is to rent the piece 
of gear for a week and pick a week that you can give totally to that piece of 
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gear, because during that week, you want to do the same thing that I suggest 
you do when you buy a new lens. You want to use that piece of gear for every-
thing possible. By doing this, you will have more confidence in your purchase, 
and in the long run, you’ll save yourself a whole bunch of money

New Lens? Marry Yourself to It – When you buy a new lens, or body for that 
matter, marry yourself to it for at least a couple of weeks. You already did all the 
homework before you bought it, so take this time to get to know it. You want 
to know all it can and can’t do. You want to know how it works for your style 
of photography. This includes using it for something totally outside what you 
bought it for. You will be surprised how, during this exploratory time, you will 
learn not only about the gear but your own photography. 

A Polarizer Is for Reflections – The polarizer is a great tool and its primary 
purpose is to remove reflections. The most common example is with fall color, 
rotating the polarizer to remove the reflection of the blue sky so the fall color 
jumps off the film. Seeing when a polarizer is working, though, can be a chal-
lenge. A polarizer works strictly by physics, so angles are important. In the fall 
color example, all the leaves face different directions, so you can’t remove the 
reflection from all of them at one time. But if you want to see through water or 
a store window, you will see the reflection disappear. Now, in this process, might 
the sky turn bluer? Yes, but when shooting with side angles, you run the risk of 
an uneven blue sky.

Don’t Be in a Hurry to Get Nothing – Haste makes waste and this is especially 
true in photography! Taking a deep breath, looking around, and waiting to make 
the best photo will always serve you well. When it comes to critters, move slow 
and on their time. With landscapes, give the light a moment to work its magic. 
And with models, let them feel comfortable before clicking.

Aperture Priority to Control Your DOF – Sharpness is important, and we can 
control the depth of focus around our subject with the aperture we select. By 
putting our cameras in Aperture Priority, we easily control the DOF by being in 
control of the aperture we’re shooting with. Shooting in Aperture Priority, we 
modify the exposure using exposure compensation. With aperture and exposure 
comp dialed in, the camera will come up with advice of the right shutter speed. 
Computers are a beautiful thing.

Panning, Panning, Panning – This is one of the most important techniques you 
can have in your arsenal. It’s the simple process of moving the camera with the 
subject so the movement of the subject, as far as the film plane is concerned, is 
nullified. This freezes the movement, so you get a sharp image of a moving sub-
ject. The key here is a marriage of other techniques. Proper handholding or long 
lens technique is where you start. A smooth movement of the camera, rolling of 
your finger when firing it, and continuing to track the subject until after the cam-
era stops firing is how you finish. When you do all this correctly, you can capture 
a sharp subject even down to really slow shutter speeds.
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Always Have the Camera with You – This one is obvious, as well. If you need 
good reasons why you should do this, attend Jay Maisel’s class. He’s one of the 
biggest proponents of this and its something he demonstrates 24/7/365. That’s 
good enough for me.

Pick Up the Camera Every Day at Least Once – I’m often asked why one’s pho-
tos are better on Sunday than they are on Saturday. Most normal folks work a 
M-F, 9-5 job, so they partake in their passion, photography, on the weekend. 
On Saturday, they spend some of their time becoming familiar with the camera 
when on Sunday, that’s all over with. This is why you should pick up your camera 
every day, no matter what. That way, you’re always familiar with it and comfort-
able with it, and that one big variable in photography is removed.

Motordrive for the Sharpest Image – Want to guarantee you get at least one 
sharp image, at least sharper than all the rest? Shooting a burst of five images 
or more is the way to do it. When you do this, the odds are that the first and the 
last image in the burst will be the least sharp, and the one in the middle will be 
the sharpest of the burst. This has to do with the harmonics of the whole pro-
cess, which tend to come into harmony around the middle exposure. 

Watch B&W Movies – Photographers are always asking how to get better in 
their black-and-white photography. The best advice I can give is to watch the 
classic B&W movies. I like some of the old ones with Bogie in them. When they 
shot those old movies, they lit them to help tell the story in all the shades from 
black to white. They were masters of this and when you tap into it, you can use 
the same in your still photography. The more you watch it, the more you’ll see it, 
and that’s the whole goal.
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Have Sun and Wind at Your Back – This old adage for has to do with photo-
graphing birds in flight, but can apply to so much. Think of the combo and the 
words of wisdom make perfect sense!

Have Fun! – This, in itself, nearly trumps all the rest of the tips and techniques. 
You can’t help but improve your photography when you’re having fun.

Include Passion! – The last thing the world needs is another technically per-
fect photograph. What the world needs are more photos with passion.
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Demystifying the Photoshop Filter Menu

Matt Kloskowski
Lightroom Guru & Landscape Photographer

Matt is the founder of Matt Kloskowski Photography and Training. He specializes in out-
door, landscape, and nature photography, along with editing with Photoshop, Lightroom, 
and ON1 apps. Matt was inducted into the Photoshop Hall of Fame in 2014 and is the best-
selling author of more than 20 books. Matt loves to educate others and spends much of 

his time teaching seminars around the world. 

The Photoshop Filter menu has well over 100 filters in it. And when you combine 
those filters with other filters, the possible combinations are endless. However, 
because there are so many filters, it’s easy to get caught up thinking that they’re 
all useful or that you’re missing something if you don’t know what they all do. 

In this class, we’re going to dive into the Filter menu and look at most of the 
filters there. But at the same time, we’re only going to spend time on the ones 
that are most useful. Remember, Adobe (like most software companies) doesn’t 
typically take stuff away when it becomes outdated or is replaced by something 
else. They add something new, but leave the old way for people who have devel-
oped workflows around it. So, you’ll find many of the filters in that menu are 
either outdated, or just plain not applicable to photography and photo editing. 

In class, we’ll cover most of the filters, even if it’s just for a few seconds to talk about 
why we’re not using one. However, for purposes of the workbook and keeping it so 
it doesn’t take 50 pages, I’m just going to list the top 10 you’ll use the most. 

1) Camera Raw Filter: For a photographer, this filter is one of the most useful. 
Camera Raw has hundreds of tools in it that surpass and are better than what 
you’d find if you dig around Photoshop. For example, think about what a pain 
it is to use layers to add a graduated filter effect to a photo to darken the sky. 
You’d have to add layers, use blend modes, use the gradient tool, etc., but in the 
Camera Raw filter, you can do it in a couple of clicks. 
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2) Liquify: the Liquify filter is mainly used for retouching portraits, but you’ll 
find thousands of other uses for the tool. It essentially lets you you push pixels 
around as if they were a thick liquid. 

3) Vanishing Point: Vanishing point is an older filter that doesn’t have a ton of 
uses, but when you need it, it can be a huge help. If you’ve ever had a graphic 
that you wanted to paste onto a photo but the perspective didn’t look right, 
Vanishing Point can help you define what the perspective is, and then help you 
paste and move that graphic into place. 
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4) Blur>Gaussian Blur: I know it sounds weird that we would want to blur pho-
tos. Usually we want them sharp. But you’ll find many uses for the Gaussian 
Blur filter for photos as well as graphic design. 

5) Blur>Motion Blur: The Motion Blur filter can be a great way to add some 
motion to your photos. We can use it for blurring the background and keeping 
a subject sharp, or for blurring clouds to give them a long-exposure feel. 

6) Blur Gallery: The Blur Gallery is actually an updated and better version of 
many of the blur techniques we use. You’ll find blurs for blurring a background 
to give it a shallow-depth-of-field look as well as for blurring motion. 
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7) Render>Lens Flare: The Lens Flare filter is a fun way to add artificial flare 
to your photos. You get a few choices, and when you combine it with layers 
and blend modes, you can really do some interesting things. 

8) Render>Lighting Effects: The Lighting Effects filter lets you add “fake” 
light to your photos. You can choose from various lights, as well as directions 
and colors for them. 
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9) Sharpen>Shake Reduction/Sharpening: Most sharpening is done in your 
raw editor first. If you find that’s not enough, Photoshop will allow you to 
oversharpen more than the raw editor will typically allow. 

10) Stylize>Oil Paint: Oil Paint is amazing. It’s one of my favorite filters. I’m 
continually blown away at how it can take a photo and make it look like a tra-
ditional oil painting. Sure, you may not fool someone who’s skilled in oil paint-
ing, but I’ve shown these photos to many people who didn’t know they were 
created digitally. 
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Digital Painting in Photoshop for Beginners 

Victoria Pavlov
Photoshop Painter & Artist

Victoria was born into a musical family and started practicing music at the age of 3. At age 6 
she discovered painting. Victoria spent all of her time in a painting studio to master her craft. 
At age 14 she had her first big exhibit. She was introduced to the camera by her uncle and to 
Photoshop by her teacher. Since that time she became “The Photoshop Artist.” A canvas,  

a camera, a Wacom tablet, and Adobe Photoshop are the clean canvases where she can create her art. One 
of the biggest passions in her life is using Photoshop.

CUSTOMIZE YOUR WORKSPACE:
Custom Toolbar
Step one: Go “Edit” Menu > click on Toolbar 
Step two: Drag any tool that you will not use in your digital painting workflow 
from “Toolbar” side to “Extra Tools” 
Step three: Separate all tools from “Toolbar” side. Click on any tool from the 
group and drag it away from the group 

Colors:
Step one: Window > Color 
Step two: Color Wheel 

CC Library: 
Step one: Window > Libraries 
Step two: Click on Menu icon (top left corner of CC Library panel) > Create New 
Library > Name your new library 
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Brushes:
Step one: Window > Brushes 
Step two: Window > Brush Settings 

Customize Menu:
Step one: Edit > Menus 
Step two: Click on Edit > Click on 
Fade > Click on Color > Apply any 
color you like from drop down menu 
> click OK

Create a new Workspace: 
Step one: Window > New Workspace 
Step two: Give a name 
Step three: Select “Keyboard Shortcuts”, “Menus” and “Toolbar” will be saved 
in your new workspace as well > Click “Save” 

CUSTOMIZE YOUR BRUSHES:
Step one: Click on a Menu (top left corner in Brushes panel) > Click on Get 
More Brushes 
Step two: Click on “Create a new group” > Give a name to a new group” 
Step three: Click on any brush and drug this brush to your new group 
Step four (optional): to customize any brush use “Brush Settings” panel
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DIGITAL PAINTING FOR PHOTOGRAPHERS: 
Step one: Click on The Mixer Brush Tool
Step two: In the Options Bar > Clean the brush after each stroke > Preset : 
Custom > Wet 100%  Load 100% Mix 100%  Flow 100% 

Tip: for a more elegant transition between colors or objects use the following 
options for the Mixer Brush Tool: 
Preset: Custom > Wet 17%  Load 17% Mix 45%  Flow 45% 

Step three: To save the brush > Click on a Menu icon  (top left corner of the 
brush panel) > Select New Brush Preset 

DIGITAL PAINTING FROM SCRATCH

Organizing your CC library:
Colors: Click on any color you want to use in your project in the Color Panel > 
Click on “Add a new swatch for this color” > Rename Color swatch > Click on “Add 
to my current library” box 
Shapes: Click on “Add Content” icon > Click on Graphic 
Brushes (optional): Click on any brush in a Brush panel and drug it into CC library 

Tip: You can create great colors using Adobe Color Themes 
Go Window > Extensions > Adobe Color Theme. Now you will be able to create 
any color, any palette, any shades. Save it to your CC library and use at any time.  
Shades palette will dramatically help with the most accurate transition between 
deferent shades of same color. 

A Few tips to make workflow more enjoyable:
1: To paint inside the object without accidentally 
going outside of the shape you need lock the  
transparent pixels. Highlight the shape’s layer   
> Click on the first icon in Lock area located in 
Layers panel. 
2: Use different layers for different objects.
3: Rename all your layers 
4: You can trace any image for outline purposes. 
Use the reference image you will be tracing as a 
separate layer > create a new empty layer > use 
any pencil or brush tool you more comfortable 
with > trace the reference image 
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SYMMETRY PAINTING 
To enable Symmetry painting feature  > Select the brush or pen tool > Click on 
the Butterfly icon in the Options Bar > from the drop down menu select the 
symmetry style you like 

Tips:
1: Use separate layers for each segment. 
2:The symmetry painting feature currently is not available for the Mixer Brush 
Tool. To blend colors using the Mixer brush Tool > Turn Symmetry Off (you can 
select this option from the drop down menu) 

Tip: with Symmetry painting use the Smoothing option for better painting  
experience. With active brush or pencil tool > click on Smoothing feature in the 
Options Bar > specify the value from 0% to 100 % . To illuminate any lag, try to 
specify smoothing value not more than 17% 
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The Oil Paint Filter 

Step one: Filter > Stylize > Oil Paint 
Step two: Check Preview box
Step three: Change the brush setting to apply oil painting effect 

Tips: 
1: Duplicate the original image’s layer and apply the oil paint effect to the dupli-
cated layer.
2: In the Lighting area, try not to increase Shine value more than  0.5 
3: You can apply as many instances of the oil paint filter to the same image as 
you like (it will help to create different painting effects) but keep in mind that 
many layers with applied oil paint effect will increase the size of your document 
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With TIM WALLACE

Using Alpha Masks To Make Retouching Tools

Tim Wallace
Commercial Photographer Tim Wallace is the driving force and creative thinker behind AmbientLife

An award-winning commercial photographer based in Manchester England and working 
Internationally his work is often described as both creative and dramatic. Tim works internationally 
with many high clients across the globe such as McLaren, Jaguar Land Rover, Peugeot,  
Mercedes and Aston Martin. Over recent years he has also broadened the AmbientLife brand  

to include other transport related work such as HGV Truck and large vehicle photography, Aviation and aircraft  
work, engineering and logistics. 

Tim is a critically acclaimed photographer whose work has spanned both commercial and advertising clients for  
over 12 years. Over the past decade AmbientLife have worked with a who’s who of automotive royalty, and Tim’s 
work is highly sought after, and this is driven also by his string of awards including British Commercial Advertising  
Photographer of the Year, and the acclaimed UK Motor Industry Car Photographer of the Year award to name but a few.

Words I live by in my Business:
“Your Professionalism is your Brand
Your Personality is your business card
How you make your clients feel is your Trademark”
- Tim Wallace

This class is based at the photoshop intermediate user who would like to take 
retouching their images a little further by looking at further options that photoshop 
allows us in making controlled adjustments to areas of tonality within our work.

In this class we are going to be looking at the powerful tool of using Alpha 
masks to make small adjustments to our image in a localised manner by working 
within the ‘tones’ of an image file. Alpha masks give us the ability to make mask 
selections of the differing areas of our image file such as the highlights or  
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shadow areas so that we can affect changes within those without impacting on 
others. We will look at how we create an alpha channel mask and then move on 
to look at using that alpha channel mask to make localised controlled  
adjustments that we can build on and use to improve our images without caus-
ing damage to such elements as colour. 

We will also look at how we can very easily use the ‘actions’ facility within  
photoshop to record a set of actions that we can then use very easily to make 
these required adjustments whenever we wish both quickly and in a controlled 
manner. 

Photoshop and its use are a very personal thing and many people have many 
differing methods to achieve similar results, in many ways that is the beauty of 
photoshop as a very diverse and powerful editing tool. My own personal  
background in photography began in the darkroom printing from film and I 
guess in many ways this has impacted greatly on how I have found my own 
methods that work for me. My own personal approach when editing is to make 
‘small adjustments’ and build on those to create the image that I am after. Using 
alpha masks gives me the ability to make controlled adjustments to ‘tonality’ 
and density within my image in an accurate way that I can then use to build on. 

In the image above, we have a coastal landscape photograph taken in the  
highlands of Scotland and I have chosen this as our working image as example it 
has both low level shadow and midtone areas as well as key highlight areas and 
some important colour tone for the setting sun. 

Firstly, let’s look at what we need to do to create our first alpha channel mask.
We first need to open up the ‘Channels’ menu and here we will see 4 channels 
from RGB through to Red, Green and Blue. 

With TIM WALLACE

Using Alpha Masks To Make Retouching Tools
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Now with the ants still doing their thing you need to move yourself back into the 
‘Layers’ menu. We are now going to create a ‘New Adjustment Layer’ using the 
option that you will see on the bottom right row of icons indicated by the small 
circle that is half white and black. Click on this and select to make a ‘Curves’ 
adjustment. Once done you will note that an Alpha mask has appeared as in the 
image showing below. You will also note that the ‘Curves’ properties  
window is displayed on screen. The mask that has been created is very precise 
and is masking out all the shadow areas on the image so that only the highlighted 
zones will be affected by what we do.  

Firstly, we are going to change the ‘Blend mode’ of our adjustment layer to 
‘Luminosity’ by using the option to the left of the opacity setting. This is by 
default set to Normal so go into there and move all the way down to the bot-
tom to select Luminosity. I would point out at this moment that I am selecting 
Luminosity for this curves adjustment however like most things in Photoshop it’s 

With TIM WALLACE
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always good when you have the time to try other blend modes with different 
adjustments as you may find one that suits what you are trying to achieve a little 
better. My choice for selecting Luminosity in this case is because I want to affect 
the ‘tonality’ in the image but I do not what to affect the colour. 

 
 

Next, we are going to carefully put three anchor points along the curves line as 
shown in the image below. We are doing this because we are going to make a 
small adjustment next to a part of that line and in doing so we do not want to 
affect the opposite end of that line. The anchor points act just as that and will 
prevent that happening. 

Now by taking the upper anchor point we will move that slightly upward above the 
line. How much you do this is purely your choice however if you write this later as 
an action in your photoshop then I would strongly suggest that it is better to do a 
small adjustment and then you can simply ‘apply’ the action several times to build 
up the effect slowly and in a more controlled manner. The increase on the anchor 
point that we have made above the base line is going to gently increase the high-
lights in the overall image but is not going to affect any of the shadow areas. 
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Now let’s look at doing the reverse using the same mask that we already have. 
Firstly we need to rest the curves adjustment and this can simply be done by 
clicking the small horizontal lines icon at the top right of the curves properties 
window and then selecting ‘Reset Curves’ as shown below. 
 

Now we need to change our alpha mask so that we now only affect the shad-
ow areas of our image. To do this we need to click on the curves mask in our 
‘Layers’ stack and then use the command to ‘Invert’ this mask using ‘CMD I’  
Your mask will now take on the opposite appearance to which it did earlier as 
indicated in the example below.  
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With the mask now inverted and our blend mode still set to Luminosity we can 
now place the anchor points back along the curves baseline and then using 
the lower part of the curve we will take the bottom anchor point and drag that 
downward slightly as shown in the image example below. By doing this we 
are now impacting on the shadow areas of our image and making those areas 
denser and therefore accentuating the shadows and removing the amount of 
perceivable light from there. 

During the full live class session, we look at things in a much closer way and 
also work together through the options that are open to us so that we can 
record a set of actions and keep those for later use on any image that we 
bring into photoshop to edit. Alpha mask adjustments are not only tied to 
‘Curves adjustments’ but can be used across a whole range of adjustments 
from ‘Levels’ through to even localised or selective colour and with many blend 
modes at our disposal the possibilities with just this method or retouch can be 
vast and well worth the exploration. 
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With TERRY WHITE

How to Create Tack Sharp Images in Lightroom

Terry White
Terry White, Worldwide Design and Photography Evangelist - Adobe Systems Inc.

Terry has been with Adobe for over 20 years. He has extensive knowledge of Adobe’s Creative 
Professional product line. In his current position as he leads the charge in showing custom-
ers Adobe’s Creative Solutions around the globe. Terry has been active in the industry for over 25 
years and is the founder and past president of MacGroup-Detroit – Michigan’s largest Macintosh 

users group and columnist for Photoshop User Magazine. He is also the author of “Secrets of Adobe Bridge”, 
“InDesign CS2 Personal Seminar” and co-author of “The iPhone Book” and  “InDesign CS/CS2 Killer Tips.” Terry 
is a key presenter at major industry shows around the world. Check out his extensive video tutorial collection on 
YouTube – terrywhite.tv His blog at terrywhite.com Follow him on Twitter @TerryLWhite and Instagram 
@TerryLeeWhite  Like him on Facebook: http://facebook.com/terrywhitefans 

Yes! You should strive to get your images in focus in the camera. However, that 
doesn’t mean that they can’t be made better in post with various sharpening 
techniques. Lightroom has some great features for helping you to get “tack 
sharp” images. Before you go looking for “tack sharp” in the menu, note that 
“tack sharp” is a slang term. Tack Sharp means that main subject is in focus and 
sharp, with crisp details and no blurring. 

There are three types of sharpening that we’ll explore in this class. The first one 
is capture sharpening. While the techniques I’m showing will work on raw or JPG 
images, I’m focusing primarily on raw images as there is simply more data there 
to work with and you’re working with an image that has no lossy compression 
already applied to it. 

Capture Sharpening
When you import raw images into Lightroom guess what? They are being  
sharpened automatically. 

Step one: Click on any raw image that you have imported into Lr (.NEF, 
.CR2, .DNG, etc.). 

Step two: Go to the Develop Module (type D on the keyboard). 

Step three: Click on the Detail Panel to expose if it it’s not already exposed.

Step four: You’ll notice 
that the sharpening 
is already likely set 
to an amount of 40. 
You didn’t choose this 
amount. You didn’t 
apply any sharpening. 
Lr applied the sharp-
ening the minute you 
imported the image in.
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Step five: If you want to see what the image would have looked like without this 
sharpening then you can use the “None” preset under the Sharpening Presets. 
You can even just hover over it to see the difference without even clicking on 
it. Likely the change won’t be much because the image was already in focus 
from the camera. However, the fact that you can see a difference means that 
Lightroom already improved your image the minute you imported. 

When people ask “how did you get your images to look so sharp?” I answer, 
because I sharpened them. 

Step six: Since we exposed the Lr sharpening presets, try each one to see the 
differences between them. 

Restore the original Sharpening presets
Currently in Lightroom we have 4 Sharpening presets under the Sharpening cat-
egory: None, Light, Medium and Heavy. However, those weren’t the original ones 
that Lightroom shipped with. 

Luckily you can get the original ones 
back. Why would you want them? There 
was one that I really like called  
“Sharpen – Faces”. Since I’m a portrait 
shooter I use it all the time. Let’s get it 
back and then I’ll show you want it does:

Step one: Click the + sign to the right of Presets
 
Step two: Choose 
Manage Presets 
from the drop 
down menu 
 
 

Step three: Enable the “Classic – 
General” check box and click save 
 
Step four: You should now see the  
category “Classic – General” in the 
Presets list. 

Step five: Twirl it down and you’ll see 
Sharpen – Faces and Sharpen – Scenic. 

With TERRY WHITE
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Why Sharpen Faces Rocks
Step one: Select an image of a face/person

Step two: Click Sharpen – Faces in the Presets panel
 
Step three: You’ll notice a difference in the Sharpen sliders from what they 
defaulted to and the big difference is that Masking was enabled. 

Step four: Hold down your Option/ALT key on the Keyboard and click and hold on 
the handle for Masking. You should now see the areas in white that are being sharp-
ened and the areas in black that are not being sharpened. This is awesome for (you 
guessed it) faces. This way skin isn’t being overly sharpened but other details are. 

Creative Sharpening
Next up is “Creative Sharpening”. This is when you want to sharpen specific 
details of an image such as jewelry and accessories in a portrait, or rocks, terrain, 
etc. in a landscape image. 

Step one: Bring up an image that has 
details that you’d like to sharpen without 
over sharpening the overall image. 

Step two: Switch to the Develop module. 

Step three: Click on the Adjusment Brush

Step four: Choose the Sharpness preset 
under Effect 

With TERRY WHITE
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Step five: Now use the adjustment brush to paint in the areas that you want to 
add sharpness to. 

Step six: Adjust the Sharpeness slider to taste. 

Step seven: Click done and do a before and after toggle view with the \ (backslash) key.

Output Sharpening
Last but not least is Output Sharpening. This will really depend upon what you 
plan to use the image for after you’re done editing it. If you plan to just share  
it online, then you might have already sharpened it enough. However, if you plan 
to export out a copy for print/high res or you plan to print from Lightroom then 
you might want to add some sharpening for the inherent loss of sharpness  
during the print process. 

NEW Enhance Details
There is a new process in Lightroom called Enhance Details. This process is NOT 
designed to run on all of your images as it can take several seconds to process. It’s 
really designed to run on images that you know you plan to make large print from. 

Step one: Select an image that you want to run Enhance Details on.

Step two: Right click on the image and choose Enhance Details from the 
contextual menu.

Step three: The Enhance Details dialog box will appear and give you the option 
to see a before and after by clicking into the preview window. 

Step four: Click Enhance to run it and then it will create a NEW dng file right next 
to the original and it will have Enhanced in the name of the file. 
 
Printing from Lightroom
Step one: Choose the image you want to print.
 
Step two: Switch to the Print module

Step three: Scroll down to Print Job
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Step five: Enable Print Sharpening (if it isn’t already enabled).

 
Step six: Choose your preferred setting: (Low, Standard or High). Which one? 
You’ll have to experient with a test print of each to see which one YOU like best.

Step seven: Choose the media type (Matte or Glossy)

Step eight: Choose Print to Printer if you plan to print this yourself or choose Print 

to JPEG File if you want to have a JPEG file that you can send to a lab to print. 

Step nine: Click Print/Print to File to initiate the print

Exporting an image or multiple images with sharpening applied
The print module is great and certainly capable of printing or exporting multiple 
images to specific page sizes. However, you may want to export images that 
don’t get cropped or the dimensions altered.

Step one: Select one or more images to export. 

Step two: Choose File->Export

Step three: Choose any options you want in terms of where the images will be 
exported to and any other set-
tings such as renaming.

Step four: Enable Sharpen For 
and then choose the level of 
sharpening you want as well as 
the intended media. 

Step five: Click Export
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How to Manage Your Ever-Growing Lightroom Catalog 

Terry White
Terry White, Worldwide Design and Photography Evangelist - Adobe Systems Inc.

Terry has been with Adobe for over 20 years. He has extensive knowledge of Adobe’s Creative 
Professional product line. In his current position as he leads the charge in showing customers 
Adobe’s Creative Solutions around the globe. Terry has been active in the industry for over 25 
years and is the founder and past president of MacGroup-Detroit – Michigan’s largest Macintosh 

users group and columnist for Photoshop User Magazine. He is also the author of “Secrets of Adobe Bridge”, 
“InDesign CS2 Personal Seminar” and co-author of “The iPhone Book” and  “InDesign CS/CS2 Killer Tips.” Terry 
is a key presenter at major industry shows around the world. Check out his extensive video tutorial collection 
on YouTube – terrywhite.tv His blog at terrywhite.com Follow him on Twitter @TerryLWhite and Instagram @
TerryLeeWhite  Like him on Facebook: http://facebook.com/terrywhitefans 

Your Lightroom catalog is a vital part of your Lightroom workflow and as it  
continues to grow, you need to maintain it.  

Backup your catalog regularly using Lightroom’s built-in backup
It’s obvious that we need to backup our images. However, many forget that 
the Lightroom Catalog also needs to be backed up. For years I’ve always just 
backed up my catalog as part of my regular backup of my whole computer. 
Then one day I was having some issues doing certain functions in Lightroom and 
it ended up being an issue with the catalog itself. Luckily I was able to solve the 
problem by Lightroom repairing the catalog, but this taught me that backing up 
the catalog as part of a data backup isn’t enough. That’s when I started using 
Lightroom’s backup feature. Lightroom not only creates a copy of the catalog 
where you specify but it checks it for integrity and optimizes it. 

Step one: Bring up your 
Catalog Settings

Step two: In the General 
Tab you’ll see the option to 
specify the frequency of the 
catalog backup.  
I do it weekly upon  
closing Lightroom.

 
Step three: when you quit Lightroom it will offer to do the backup.



165

notes

the

Step four: When the backup dialog box appears you can choose the location 
of the backups. This can be another drive or the same drive although it really 
should be another drive. If your hard drive crashed you’d lose your backups too! 

Step five: Make sure you enable Test Integrity and Optimize catalog after  
backing up. 

Step six: Backups will pile up over 
time and start taking up space 
on your drive. There really isn’t 
any reason to keep more that a 
few backups. You’d have to think 
about how far back are you  
willing to go and how much work 
you’d lose if you opened a backup 
from say 6 months ago. Feel free 
to develop your own timeline for 
how often you go to that backup 
folder and delete older backups. 

Optimize the catalog if things start to feel slow
You just learned about backing up your catalog in the steps above. However, if 
you feel that you need to do an optimization of your catalog before your next 
backup, you can do so at anytime. 

Step one: Choose 
Optimize Catalog from 
the File menu

Step two: When the 
dialog box appears you 
will see how long it’s 
been since your last 
optimization. 

With TERRY WHITE
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Build a System of Collections that makes Sense  

Build Smart Previews
You should build Smart Previews for images especially if you want the ability to 
edit images in the Develop Module that you don’t actually have with you. For 
example, if you have a laptop with your Catalog on it but your older images are 
at home/the office on another drive, Smart Previews will let you continue to 
work on the images in Lightroom even though the high res images aren’t with 
you. The edits will be applied to the high res originals when you connect the 
drive that has them. 

Step one: You have the option to build Smart Previews when you import images. 
However, if you want to build them for images that are already in your catalog 
you can. Select the images in the Library module that you want to build Smart 
Previews for.

Step two: Choose Library->Previews->  
Build Smart Previews 

Step three: You will see a progress bar in the upper 
left corner while your previews are being built in the 
background. 
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Build a Smart Collection to identify images that need to go!
Unless you’re contractually obligated to keep every image you ever capture then 
chances are you’ll have thousands of images in your catalog that you’re never 
use. Let’s build a Smart Collection to identify those.

Step one: Click Create Smart Collection from the Collections + menu

Step two: Use the follow criteria:
 

Step three: Click Save

Step four: This will 
identify potential 
deletes. You can go 
through them and 
reject all the ones  
that you actually want 
to delete.

Step five: Click on  
All Photographs

Step six: Hit Command-Delete (PC: CTRL-Backspace) to bring up all the rejected 
images. You can then click Delete from Disk to move them to your system/OS trash. 

Move older shoots/images to an external drive. 
One of the things that new Lightroom Classic users screw up is that they try 
to manage their images outside of Lightroom. Then the next time they launch 
Lightroom they end up with missing images. This can be avoided by letting 
Lightroom do its job!

Step one: Plug in an external drive that you want to move older images to.

Step two: In the operating system create a folder on this drive and call it what-
ever you want “pictures and videos”, for example.

Step three: Launch Lightroom Classic CC and click Add Folder from the Folder + menu.
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Step four: Navigate to that new folder that you created on the new drive and 
add it. This will teach Lightroom about this new drive. 

Step five: From the Library module you can now drag any images/folders you 
want to the NEW folder to MOVE them. They are MOVED. Not merely copied. 
Lightroom will also now reference them on the new drive.  
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With LARRY BECKER

The Video Profit Zone for Photographers

Larry Becker
Camera Technique & Technology Guru

For more than 25 years, Larry has been simplifying technology and helping people understand it 
through books, magazine articles, DVDs, online videos, and live training. Larry has been seen by 
millions of viewers worldwide on web TV shows like DTownTV and Photoshop User TV, but he’s  
most widely known for his work as a trainer and gear reviewer for B&H Photo.

This Approach to Simple, Pro-Looking Video is Totally Unlike Film School

There is one thing that we need to clear up here so we’ll all be on the same page 
when it comes to the kind of video we’re talking about. Terminology. Specifically, 
terminology that defines the three levels of video production available, and the 
one that we, as photographers, can pursue as an additional part of our business.

Obviously there is hack/amateur style video. We’ll just call that Amateur Video 
for now. And that’s not us.

There’s High End video production, which is what all of the local video  
production houses purport to be able to deliver. And of course Hollywood and 
New York commercial productions are all about high end production values.

And then the sweet spot for photographers who do a little bit of simple, 
professional looking video, is right there in the middle. Unfortunately, if you 
Google “middle video production” you get pages and pages of results that 
are all about video production in grades 6, 7, & 8. So there isn’t really a good 
term for this middle level of production. Years ago it used to be referred to as 
Industrial Video production, but that term has zero appeal and probably would 
even turn some people off. So I have a new term we’ll be using from here for-
ward. 

MVP
A synonym for a middle value is the word “mean,” so I call this middle range of 
video production Mean Video Production. And of course the acronym MVP has 
a positive meaning, usually associated with the world of sports (Most Valuable 
Player), so that’s just a bonus. And consider that since you will be the one cre-
ating Mean Video Productions you can use the exact same acronym to refer 
to yourself. You’re gonna be really good at this so you’re a Mean Video Pro. So 
whether you’re referring to the middle level of video production, or the person 
practicing this mid-level video craft, the acronym MVP works. 
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Video: Wow Demo Reel 

Video: Simple Demo Reel

Where Does MVP Fit In the Market
Going Rates for high end video CGI can be $1000 or more per finished second & 
standard “pro” video can be $1000 to $1500 per finished minute (give or take)

Think about a 1 person, single camera shoot with a simple microphone and lights 
vs. a two to four person shoot with 2 or 3 cameras, a slider, a gib setup, a boom 
mic operator, etc.

Think about being a professional photographer with a studio and loads of  
camera and lighting gear vs. a recent high school or college grad who just 

With LARRY BECKER
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moved into their first apartment and they have a laptop with Lightroom and a 
$1500 camera mom and dad bought for them. They can waaay undercut you.

Now the tables are turned and it’s you who have the less expensive gear and 
the market advantage. But you MUST approach the marketplace honestly. For 
example, if somebody asks that new shooter to shoot a wedding, they should 
be honest about their wedding experience and make sure the client understands 
that they’ve never shot a wedding before. In the same way, don’t take on more 
than you can handle. A little talking head video or some sort of company over-
view can be pulled together following a simple formula (I call them recipes). But 
if your client says, we’re holding an event and we need you to film the event and 
the speakers on stage, THAT is a big undertaking! Keep things simple and stick 
with MVP level productions.

If you can find a high end video production company who ‘get’s it,’ consider 
partnering with them and trading projects based on client needs.

The One Thing Most Photographers Don’t Get “Automatically”
The first dead giveaway that a video is amateur is bad audio. There’s a lot that  
photographers will quickly understand about MVP quality video from our  
experience with still shooting, but audio is not something we’ve had to deal with 
before. 

Gear
•  Lights - Constant lights. LEDs. Small. Large fixtures. Battery and/or      

- Consider just daylight LEDs because you won’t often have to match a scene 
     

•  Camera - DSLR/mirrorless. Many lenses have the optical characteristics of  
cinema lenses. 

       - De-clicked aperture is what makes a cinema lens, but you won’t be ‘riding   
          aperture’ during filming 
       - Probably won’t manually zoom or focus during filming.         

With LARRY BECKER
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•  Audio - Corded lapel mic. Shotgun Mics. Wireless UHF vs VHF. Group A, B, C. 
XLR vs. 1/8” TRRS or TRS. A dead cat or dead mouse (fuzzy windscreen) 
can cut strong wind noise. 

Filming
•  Coach your clients on camera. Smile. Hand positions. Casual conversations.
•  People don’t like themselves on camera just like they don’t like their portrait or 

hearing their own voice in a recording.
•  No close-ups. Shoot a little wide, but most upper body with headroom.
•  Use simple lighting. - ‘Flat’ lighting. This is not the same ‘art’ as a portrait session.
•  Simple, clean backgrounds. Shallow DoF when possible.

•  Locked down tripod 1080p - Most of your A-Roll will come from this. Only 
open and close and occasional are critical and lots can be covered w/B-Roll.

•  B- Roll. High speed filming for slow-mo playback. Maybe film with your smart-
phone. Use Ken Burns stills. 

•  Film talent looking at the lens - 6’ or more away, zoomed in allows for prompt-
er below the lens 
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•  Film interview style

•  Makeup - Guys will resist. Understand the dynamic range of your camera. 
Highlights get blown out and make subject look nervous. Foundation powder.

•  Film talent looking at the lens - 6’ or more away, zoomed in allows for prompt-
er below the lens

•  2 ways to get good audio - Direct connection. Garbage Audio + Recorder & 
match in post. 

•  Clapper (even though you don’t need it) shutter speed, ISO, WB
•  Camera settings 

 - Lock as much as possible. Focus (maybe face focus AF), zoom,  
   aperture, shutter speed, ISO, WB

       - Use a neutral picture style
       - Set shutter speed to approx double frame rate.                
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Music
Royalty free is important - Check the terms of your music

Avoid Over Production (and trainers who teach it) 
Some giveaways that something is over-produced:
•  Multi-camera
•  Gibs
•  Sliders
•  Actors
•  Scenes
•  CGI

Potential Clients
•  Real Estate Agents
•  Chiropractors
•  Medical Clinics
•  Insurance companies
•  Construction
•  Dentists
•  Veterinarians 

Video Recipes
•  Link: Larry’s free eBook 6 Profitable Video Recipes for Photographers -  

bit. ly/VideoRecipes
•  Max: 1-in-1 cold | 3-in-3 warm
•  Welcome 
•  Testimonial 
•  Explainer
•  Pro tips as a regular info series
•  Installation/usage
•  Software training

Elements — Video Must Always Be Structured/Written for Audience, Placement
•  Hook
•  Casual language
•  Single CTA
•  End on slide and never fade to black
•  Informal self intro
•  The power of lower thirds
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Do Your Own Video First
•  It will help you understand what's going on with your clients
•  Even the best videographers aren't known for directing people on camera
•  Rick Sammon teaches that the camera looks both ways. That's still and video.

Editing 
•  1080p → 720p
•  Leave little mistakes in
•  Consider a blooper reel
•  Premier Pro
•  Screenflow
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Crack the Code to Marketing

Joel Grimes
Compositing & Lighting Expert

Joel is a commercial advertising photographer whose style of capturing portraits has earned 
him the attention from many of the finest advertising agencies and art buyers. He strongly 
believes in creating images that go beyond the normal commercial application. In 1991, Joel’s 
first national-interest coffee table book, Navajo, Portrait of a Nation, received a number of 

photographic and graphic design awards. 

PRACTICE YOUR CRAFT MORE THAN YOUR COMPETITION
Repeat, Repeat, Repeat!

I can’t emphasize this enough. My success starts with a simple ingredient:  
I put in more hours practicing my craft than 99% of my competition. This is my 
secret. Find someone who is at the top of their field and follow them around 
for a week. They will wear you out. They are the hardest working people on the 
planet. Put in the hours and great things follow.

When I started out in photography, I thought the most talented and brilliant 
photographers would become the most successful. During my college photo 
class critiques, I was no standout. I remember thinking the only hope I had of 
competing with my classmates was to outwork them. I have learned the value of 
repeating the process over and over until I reached a level of craftsmanship that 
puts me at the top of my field. 

I understand that not everyone can dedicate 12 hours a day, seven days a week 
to their craft. However, take a critical look at how much time you waste each day 
on things that can be eliminated. Ten years ago, I set out to reinvent myself, and 
I committed to creating 50 self-assignments (non-paying photo shoots) a year 
to advance my career. It was one of the best decisions I have ever made, and 
literally launched me on a national/international level. To fulfill that commitment, 
I had to give up things. Make a few sacrifices to chase your dream and put every 
free minute you can into repeating the process over and over. 

BUILD A BODY OF WORK IN A SERIES
Create a common thread that tells a story

Over the years, I have learned some invaluable lessons working in the photog-
raphy industry. One is that a body of work stands stronger as a whole than as 
a single image. Repeating a subject matter over and over creates two critical 
effects. First, you become an expert on that subject or a particular genre. When 
I started photographing sports figures, I didn’t start out shooting $100-million 
athletes. I started with the high school kid next door. Then I went to the college 
level, and after two to three years, I was shooting some of the most prominent 
athletes in the industry. I got better and better with each shoot, and my eye 
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began to learn what worked and what didn’t. Over time, I became an expert 
at photographing athletes. And my body of work as a whole won over the art 
directors and potential clients.

Second, a body of work helps brand you in the industry. You become the go-to 
person when it comes to a specific look or genre. If done right, you become a 
trendsetter, and the person everyone is trying to copy. This filters down into the 
industry and the word gets out. Becoming an expert allows you to raise your 
rates, and soon you’re working with the biggest budgets in the industry.

Build a body of work you love. This makes sense, but think about it, chances 
are it will take you a few years before your body of work will start to take hold 
in the marketplace. So pick a subject matter you will stick with for the long 
haul. My observation is that most photographers stick with something for 
about a year and then switch to something entirely new, and never really mas-
ter anything. Put together a five- to ten-year business plan and stick to it. 

AVOID FOLLOWING THE LATEST TRENDS
Become a creative force

It is always easier to follow someone else than to forge your own way. When it 
comes to the industry trends, I see so many photographers jumping from one 
trend to another. There are a few reasons why chasing trends is not a good 
idea. First, a trend normally brings a flood of people doing the same thing. 
You tend to easily get lost in the crowd. Also, by the time you master the look 
of the latest trend, it has become old news. Chances are the artist who has set 
the trend has spent years fine-tuning and mastering that look before it hit the 
marketplace.
 
Second, on the subject of being an artist, you will often hear me say, “You are 
unique, one of a kind, there is nobody on the planet just like you.” You have 
something to offer the world, why waste it on copying someone else’s vision? 
As an artist, you have to believe that if you stick with following your intuition 
and building a body of work that fits your creative vision, you will become a 
trendsetter. There will always be a group of followers that will be influenced 
by your work. 

One day, I had an art director from a prominent ad agency call me. She had 
just left a meeting with a photographer, discussing possible strategies for an 
upcoming ad campaign. During the meeting, the photographer kept show-
ing her some of my sports images as examples of where he would like to take 
the campaign. He kept saying he wanted to shoot the “Joel Grimes three-
light edgy look.” She kept thinking to herself, why hire a photographer who 
is looking to copy someone else when she could hire the real thing? I ended 
up shooting that campaign, which resulted in a lucrative paycheck. Why be a 
copy when the original is worth a whole lot more? 
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RECOGNIZE THAT NOT EVERYONE WILL LOVE YOUR WORK
There is a critic around every corner

Without exception, every human being on this planet suffers to some degree 
from being weak, fragile, and insecure. I will prove it to you: post one of your 
images on a social media platform where people leave a comment. You will 
receive responses that say you rock, you’re a genius, that you’re the greatest 
photographer in the world. Ninety-nine praises and then someone comes along 
and says you suck, that your image is the worst they have ever seen, and that 
you should get out of photography and get a real job. Ninety-nine praises and 
one bad critique. When you go to bed at night, what do you remember, the 
ninety-nine praises? No, you don’t; you remember the one bad critique. 

This is our humanity. We all suffer from it. You may think you are tough as nails. 
Go show your portfolio to an art director at a prominent ad agency and have 
that person tell you to find a new career. That is exactly what happened to me 
on my very first portfolio showing. And how did I react? Probably the same 
way you would: I was crushed and wanted to quit. At the time, I could bench 
press more than 300 pounds and could fight off five attackers in a dark alley 
(okay, I might be exaggerating a bit), but I could not handle one harsh critique. 
What a revelation that was. 

It is impossible to step out into the real world without experiencing a harsh 
criticism that will literally bring you to tears. If you have not experienced that 
yet, then you have not truly stepped out into the real world. It is brutal. But 
there is good news. Understand your humanity and know that not everyone 
will love your work. Rejection is just a part of life, and you have to believe that, 
eventually, someone will fall in love with what you do. In the end, you can make 
a great living off that group of people. Your job is not to win over the masses.  
I survived that first portfolio showing and didn’t let one person steal my dream. 
So can you.

PERSISTENCE WILL WIN OVER MORE CLIENTS THAN A GREAT PORTFOLIO
The goal is to get hired

There are a number of myths that have been shattered over the years as I have 
worked in the photo industry. None is more significant than believing that the 
best photographers make the most money. I believed that if I mastered my 
craft, then the work would follow. When it comes to getting work in the real 
world, persistence will win over more clients than a great portfolio. Now I am 
not advocating sloppy craftsmanship. I want my work to compete with the best 
in the industry. But the question is, how do I get work? 
When I was studying photography in college, if you had asked me what the 
role of a photographer looked like, I would never have thought that being a 
salesperson would be part of that equation. Making cold calls, sending out 
promo packets, and pounding on ad agency doors were not even concepts 
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that crossed my mind. It is hard to believe now, but I am naturally a very shy 
person. When I started out making cold calls, I was literally so nervous that the 
phone was shaking and my tongue felt like it weighed 50 pounds. My first calls 
were a disaster. With time and a whole lot of practice, it got easier. My first year 
in business, I eventually logged in more than 3,000 cold calls and showed my 
portfolio close to 200 times. Overcoming this hurdle launched my photography 
career. 

Every year, more than 100,000 college students graduate with a degree in pho-
tography across the US, and only 11% end up working in their field. Why is that? 
You could say that it is because their work is not up to the industry standards. 
But an 89% failure rate?! If that’s the case, our higher education institutions need 
to offer a refund. The problem lies not necessarily in mastering the tools of the 
trade, but in the inability to exert oneself in the marketplace. What hurdles are 
you willing to overcome to live your dream? Learn the power of persistence. 

GET YOUR NAME INTO THE BRAIN OF THE PERSON YOU  
WANT TO HIRE YOU
Learn the power of eight

Not surprisingly, studies have shown that only 5% of creatives market effectively. 
So what keeps 95% of us from succeeding at marketing? One major hurdle 
stands out above all others: the fear of rejection. Studies have also shown that if 
we do exert ourselves in the marketplace, we will at most make two attempts at 
soliciting a potential client and then give up. The odds of securing any return on 
two attempts is less than 10%. Not good odds. The reason we give up is because 
it hurts to get a cold shoulder or a rude brush off. 

But here is the good news. It takes around eight attempts before someone 
will remember who we are. Once again, this falls under the fact we are human. 
Studies have shown that if we make at least eight attempts to get our name into 
the brain of the person we want to hire us, the odds go up to 80% that we will 
get a return on our marketing investment. I like these odds! 

My whole success as a commercial photographer for 35 years is a direct result 
of knowing this simple principle. Once your name gets lodged into the brain of 
a potential art director, photo editor, marketing communications director, etc., it 
is just a matter of time before they have a crisis and need a photographer to fill 
a slot. The fact that your name is in their brain increases your credibility. This is 
how branding works. Because your name is in their brain, you must be a good 
photographer, reliable, and someone to rescue them from a crisis. It is the most 
magical thing to see, and I have witnessed it over and over my whole career. 
Learn the power of eight!
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HUMAN BEHAVIOR IS VERY PREDICTABLE
Use this to your advantage

I would never have thought that the study of human behavior would play 
a role in my success as a photographer. When I started in this industry, all I 
wanted to do was take pictures. But understanding that human behavior is 
extremely predictable can completely change the way you look at getting 
work, and how to you win over clients.

We have already talked about how we are all, to some degree, weak, fragile, 
and insecure. Understanding this helps reveal why I come undone when I get 
criticized or get a door slammed in my face. But understanding the other side of 
the exchange can help you see why it is so hard to get your foot in the door.

After pounding the streets for more than 35 years, I have learned something 
about the person I am pitching. First, just because they hold a fancy title and 
could be responsible for paying your bills, they are really not much differ-
ent than you. They have a lot on their plate. They generally have a demand-
ing boss or client. They have deadlines, budgets, and are overworked. They 
have a life outside of their workplace. The odds are they are going through 
life challenges, just like you. They could be going through a divorce, loss of 
a loved one, caring for a newborn that is not sleeping through the night, etc. 
You make a cold call, and they are a bit short with you and give you the brush 
off. And how do you respond? You get hurt, get mad, and cross them off your 
marketing list. I have a mindset that, one day, I will get the opportunity to save 
that potential client from a crisis and will become their knight in shining armor. 
But 95% of all other photographers will quit and give up. By sticking with 
them and understanding their humanity, eventually I will win them over. 

BE DRIVEN BY THE PASSION FOR YOUR CRAFT, NOT HOW MUCH 
MONEY YOU WILL MAKE
Clients can see right through your greed

I have known a fair amount of outstanding working photographers over the 
past 35 years. Not one of them that was in it for the money ended up getting 
rich. In fact, many of them ended up burning out or going through bankruptcy. 
The die-hards that are still in the game after 30+ years are in it because they have 
an unending passion for the craft. This passion keeps me current and continually 
growing. In fact, the last 10 years have by far been my most productive. And at 
60, there are no signs of me quitting any time soon. 

Clients can get a sense of who is in it for the money. I’m not saying to charge less 
for your services. On the contrary, those who are in it for the passion end up cre-
ating the best work, which in turn positions them higher up in the food chain. 
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Most of the art directors I have worked for are looking to hire a photographer 
who is a creative force, not a technician watching the clock. My passion for 
creating shows when I am on set working to get the best possible results for 
the client. And it is contagious. In the end, we tend to work toward a common 
goal and deliver a much better product. 

I made a decision years ago to do all my own retouching. My goal was to build 
a brand that I could repeat and be consistent. It is for this brand that the art 
directors end up hiring me. I could farm out my retouching and make a lot 
more money. But in the end, the client knows I am willing to go the extra yard 
to deliver the best possible product.

BUILD A TRUSTWORTHY BRAND
Your reputation will precede you

A brand is a connection or a link between two entities. For example, soft drink 
and Coca-Cola or athletic shoes and Nike. For a brand to be successful, it has  
to make that connection. It takes a lot of exposure in the marketplace for a 
product or service to build a trustworthy brand. Often the most successful 
brands are the ones that become the first in the industry producing something 
new or innovative. 

One of the greatest compliments someone can give me about my work is that, 
when they see one of my images in a publication, they know it is mine before 
they see the credit line. This is because I have developed a look that has been 
repeated over and over. I have spent the last 10 years beating the same drum 
until it has taken root in the marketplace. This takes a whole lot of patience 
and dedication. There are times I feel like moving on to something altogether 
new, but I know that for my brand to succeed, I have to stick with my game 
plan. I often get other photographers criticizing me for doing the same old 
thing. That just tells me they don’t understand the power of building a brand.

Take the risk and build a look that fits your artistic vision, and then set out to 
repeat that look until it becomes refined. Then beat it into the ground until 
that look is linked to your name. It may take three to five years, but in the end 
it will pay huge dividends. Name any rock star photographer, and they have 
branded a look that more than likely took them a few years of repeating it day 
in and day out. There are really no short cuts. The good news is you don’t have 
to be brilliant or a creative genius to brand a look that puts you on the map. 
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SET YOUR SIGHTS ON ACHIEVING SOMETHING YOU BELIEVE 
IS BEYOND YOUR REACH
Prove all the naysayers wrong

How do you see yourself five or ten years down the road? I often ask people, 
“Where do you want to end up?” As a college student studying photography, 
I wanted to be an artist, creating images with a camera. I idolized the masters, 
like Ansel Adams, Irving Penn, Edward Weston, etc., but as to career options,  
I was clueless. After graduation, I had a friend who pointed me in the direction 
of pitching ad agencies. I was like a fish out of water. But I was persistent to 
make it as a working photographer. 

I remember one of my professors in college said that only 0.001% of all the 
photographers on the planet would produce a coffee table book. That stuck 
in my mind. So I set a goal to beat those odds. In 1989, as a naïve 32-year-old, 
I secured a publisher and started a project photographing the Navajo people. 
The project took two years, averaging 200 days each year in the field, living 
and traveling out of a VW camper van. When I started the project, everyone 
I talked to said I would never get it done. It was one of the hardest things 
I have ever done. But after the dust settled, I had a national interest coffee 
table book and an 18-month solo exhibit at the Smithsonian American History 
museum. 

What I learned from that project went well beyond the book project. I learned 
that with hard work, sacrifice, and persistence, I could accomplish anything 
I could set my sights on. That lesson has stuck with me all these years later. 
I see so many people sell themselves short by looking at the glass as half 
empty. Set your sights on achieving something you believe is beyond your 
reach. Then, one day, you’ll end up beating all the odds. 



the

183

notes

With TIM WALLACE

The Dark Art of Quoting

Tim Wallace
Commercial Photographer Tim Wallace is the driving force and creative thinker behind AmbientLife.

An award-winning commercial photographer based in Manchester England and working 
Internationally his work is often described as both creative and dramatic. Tim works interna-
tionally with many high clients across the globe such as McLaren, Jaguar Land Rover, Peugeot, 
Mercedes and Aston Martin. Over recent years he has also broadened the AmbientLife brand 

to include other transport related work such as HGV Truck and large vehicle photography, Aviation and aircraft 
work, engineering and logistics. 

Tim is a critically acclaimed photographer whose work has spanned both commercial and advertising clients  
for over 12 years. Over the past decade AmbientLife have worked with a who’s who of automotive royalty, and 
Tim’s work is highly sought after, and this is driven also by his string of awards including British Commercial 
Advertising Photographer of the Year, and the acclaimed UK Motor Industry Car Photographer of the Year  
award to name but a few.

Words I live by in my Business:
“Your Professionalism is your Brand
Your Personality is your business card
How you make your clients feel is your Trademark”
- Tim Wallace

One of the single most important factors in gaining commissions as we work 
as photographers with both existing and new clients, is the ability to quote for 
work effectively and successfully. A lot of people struggle with this and there are 
many reasons why that happens so frequently, the main one being in my view 
that as photographers we are ‘creatives’ and creatives by their nature are not 
business people generally.  
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The Creative Vs the Businessman
We love what we do, we love to hear appreciation of that and see our work out 
there but we often do not really stop to consider the view of the other person 
that we are talking to when we are dealing with clients and agents. How they 
see a project may well be very different to how we view it. We may be looking 
at a project and thinking about what great shots we can get or how we might 
technically pull off a certain image or lighting setup, while they are looking at 
things such as budgets, how reliable you seem to be so that they can have the 
reassurance that the shoot will be completed on time and as the client wants. In 
many ways one of the most important factors when quoting is actually know-
ing what questions to ask and how to ask those in the right way rather than just 
‘how much should I charge’ 

Creative Person – love my work, hate my work, don’t find it easy to ask for money 
Business Person = costs, revenue, risk, evolution, growth

In this class we are going to discuss the all-important background that you need 
to consider and understand so that you can ‘quote’ in the right way and at the 
right level. After this session you will hopefully also understand that effective 
quoting is not always down to price, indeed if it is purely down to price then you 
are probably shooting for the wrong types of clients and we will discuss that in 
some depth. We all work very hard to succeed in what we do and we all want 
to build on that but you must really look at who you are talking and negotiating 
with, what questions are the right ones to ask and why asking the right ques-
tions matters so very much. 

“You’re in business so ‘be’ in business and think like a business for both  
yourself and your clients”

One of the very first things you must consider is that a quote is not just about 
how much something will cost, its about the breakdown for that, how you work, 
and it also indicates to those that receive your quote how experienced you are 
in working at that level. In many ways a good quote will give your client ‘ 
confidence’ that you are professional, well planned and you have made this 
journey many times before and therefore the project is safe in your hands. 
Asking the right questions and realizing that it is not all about you is a big first 
step. You must show that you understand the clients needs and concerns and 
plan to address those as part of the process. 

 

With TIM WALLACE

The Dark Art of Quoting
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So, we offer our work for less and we are bound to be a winner, WRONG – why?
Offering the same work you see in the market for less is bad business and is not 
a great approach. I hear many photographers all the time complain that people 
are charging less than themselves and they cannot compete with that. When 
this is the case it is more often down to you being in the wrong type of market 
level for what you would like to do and what you would like to earn. It is not 
your customers fault, it is quite simply that you are pitching the wrong level of 
work to the wrong level of client. 

Be your Clients own Customer do research always before you quote. 
If you can demonstrate that you do actually understand your clients’ needs then 
you become an ‘ASSET’ and not a cost…

Cost/Originality
This is one of the big core elements to understanding how to quote and we 
will be discussing this in the live class. In basic terms this is where we look at 
the different levels of business clients, what that actually means and how that 
drastically affects what you quote and how you quote. Your client knows what 
they want, you know what you would like to charge, if you do not match the 
two up then you will always fail at the quote because the two parts will not fit 
together. Your client is not wrong and you are not wrong, its simply mismatched. 
Understanding why that is and how to aim for a more ‘matched’ client type is 
the key, a little complex to explain but once you attend the class and we discuss 
through that you will soon see just what I mean by that and why it is so crucial. 

With TIM WALLACE

The Dark Art of Quoting
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Building relationships with clients is really important, this will allow you to 
become a valuable asset over time as you work together and will also help 
you build knowledge.

Here’s a few things that you should consider might be important to your client.
• Control, can you fulfil the brief the way that they want you to?
• Consistency, is your work consistent and do you demonstrate that?
• �Being client brand aware, are you aware of what photography they have 

already and do you understand what they want now?
• Understanding how commercial visuals need to be, text space, options etc 

Some factors that will help you stand out
• �Displaying a sound knowledge of their industry Understanding their place 

within that industry
• �Outwardly showing an interest in what their problems areas are  

or business goals 
• �Displaying a professional approach to adding ‘value’ to their business through 

your ideas and not being seen purely as a cost 

Clients will not commission you because you take nice pictures, it is a harsh 
reality that most photographers do not grasp at first. You could be creating 
amazing work and charging as little as possible for that but still not getting 
anywhere and struggling to understand why. Consider that your client is run-
ning a business and the work that they are commissioning is really important 
to them, they have a dealine and they have a set idea for exactly what they 
want. If you fail to show that you understand their vision, you fail to ask the 
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right questions in regard to what is expected and you seem to charge very 
little for your work then it is not likely to instill confidence in your client…  

Remember: Good business is a good conversation with  
the right people
 
One of the recurring items that we will constantly discuss in this session is ‘client 
level’. This is a major factor to understand and once you are able to do that then 
you have a much better chance of understanding what level a prospective client 
is at, knowing that means that you can start to be comfortable with what ques-
tions to ask, what to expect yourself and have a good idea for what they will 
expect from you. 

Clients generally break down onto three main levels, each has their own needs 
and expectations, all of them are valid but their ‘business driving factors’ are 
very different. We will discuss these properly in class with some examples of 
each so that you can clearly see what I mean and why quoting for each is so 
very different. 
 
• High-Level Client – Risk and Revenue – Client Campaign Success 
• Mid-Level Client – Ability and Value for Money 
• Low-Level – Volume and Cost 
 
One classic example of this would be the inclusion of ‘usage’ in your quote.  
        This may well be something that you normally do or perhaps you do not… 
If you were to quote for usage then you would first need to fully understand 
what the client’s usage requirements are, it’s amazing how many times you will 
hear from lower level clients that they don’t really understand your questions. 
The response of a lower level client might be that they are paying for the pictures 
so they will just use them however they want, they have paid you they  
own them, right? 

If you were to ask them if they want you to include a license they will probably 
start panicking and wondering why your making it so complicated. In truth they 
want a set of images, as many as they can get for their ‘tight budget’ and they 
want to use them whenever and wherever they like, because they perceive that 
the images are theirs, forever. They are purely interested in large volume 
and low cost. 

However, a high-level client would think it very strange if you did not ask them 
to give you specific details of the ‘exact’ usage required for the project. They 
have factored this into their budget, they expect to be quoted for that by you 
in what you submit and they expect you to understand what those usage terms 
mean and cost out as. You might cost that out as a set additional cost per image 
determined by the usage type and the territories that it will be deployed within. 
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You may factor into the cost an overall percentage cost on the whole project 
and that percentage would differ dependent on the type / level of usage, where 
in the world that usage will occur as well as the duration of that. 

Knowing the right questions to ask is a key factor as well as understanding those 
questions also. A great deal of this comes with experience and the more you 
work with a client the more you will learn what works for them and you.
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Copyright and Usage 
Sometimes people can find the whole area of licensing and copyright very con-
fusing. Here are few examples of terms that are commonly used throughout the 
world today 
• Copyright is about who owns the images.  
• Licensing is about who has the right to reproduce the images.

Traditional Licensing
This can be both Non-exclusive or Exclusive and means that the image is 
licensed for a specific purpose or use. Sometimes referred to as ‘Royalty Free’ 
and ‘Rights Managed’

Non-exclusive 
The buyer pays a license fee for the use of the image. Be aware that another 
buyer can also purchase and use the same image however, hence ‘Non-
Exclusive’ The buyer must specify, each time: intended use, media, territory and 
duration. Pricing is based on intended use, media, duration and territory. 

Exclusive (Rights Managed)
The buyer pays a license fee each time they use the image. The buyer obtains 
exclusive use of an image under the terms of the license: these terms may affect 
the use, media, territory and/or duration in which the image can be used by 
other buyers.  

Rights protection can be an advantage for high-profile projects such as ad cam-
paigns and promotions. Pricing for this type of license varies and very much 
depends on the terms for the image use being requested. If ‘exclusivity’ is required 
then you should typically expect to pay between 25-40% more to guarantee an 
exclusive license against the image / images for the period agreed, normally 6 
months.

Royalty Free licensing

This is the simplest form of licensing and the price is driven by the actual image 
file size to be provided as a customer you will pay a one-off fee. You are not 
required to pay royalties on the use-by-use basis. Be aware however this type of 
license in NOT exclusive and you will not know who else is using the image.

Usage

When we talk about Usage we are referring not only to territories of usage but 
also forms of advertising such as ‘below the line’ and ‘above the line’. 

Above The Line (ATL) and Below The Line (BTL) advertising

Above The Line’ and ‘Below The Line’ came into existence way back in 1954 with 
the company Proctor and Gamble paying their advertising agencies a different 
rate for different forms of advertising Below the line (BTL) advertising is more 
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one to one, and involves the distribution of mailshots to individuals, and promo-
tions, brochures placed at point of sale

Above The Line (ATL) advertising is mass media is used to promote brands and 
reach out to the target consumers. These include conventional media as we 
know it, television advertising, print media, billboards as well as internet.  

This is communication that is targeted to a wider spread of audience, and is not 
specific to individual consumers. ATL advertising tries to reach out to the mass 
as consumer audience.

Territories and Time
GEOGRAPHIC REGION

We need to consider the area’s it will be used;

Example 

This is the area in which the images will be seen.

National: US only. Includes provinces of the US such as Puerto Rico and the 
Caribbean.

North America: Includes the US and its provinces, Canada and Mexico.

Global or International: Throughout the world (internet is automatically global).

Local: Specific city or area (San Francisco Area, etc.)

Regional: Specific region (Midwest, Southeast, etc.)

Europe: Europe is often negotiated as a neat little package that includes Great 
Britain, Spain, France, the Netherlands, Scandinavia, Germany, Italy.

By Country: Specific countries can be purchased, but if the exposure is large, 
such as Europe, it may be wiser to go with Global to make sure you are covered.

TIME

This is the length of time an image or images will be used: one year, two year, 
one time, etc.. It is best to specify “from date of first use” when negotiating a 
contract for an image. Standard use generally 1 year

I will look forward to seeing you in the session to hopefully shed some light on 
this area of quoting to help you understand what the right questions are and 
how to move forward more effectively with your clients. 
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With DAVE BLACK

GAME DAY ... a SPORTS Shooters Guide

Dave Black
Sports Photographer & Light Painting Specialist

As a freelance photographer for over 30 years Dave’s work has primarily centered on the sports  
industry for such publications as Sports Illustrated, Time, Newsweek and the award winning TV show 
Sports Century on ESPN. The list of event coverage includes the Masters, Kentucky Derby, National 
Football League, NASCAR and extensive work regarding the United States Olympic Committee, 

Olympic athletes and coverage of twelve Olympic Games. Known for his creative use of lighting and in particular  
with the artistic technique of Lightpainting, Dave’s portfolio continues to broaden into the commercial and advertising  
industry, and with specialized lighting projects including work for the National Geographic and their book Where Valor 
Rests, Arlington National Cemetery. He is one of Nikon’s “Legends Behind the Lens” photographers and is a prominent 
instructor at a variety of workshops each year. His monthly website tutorial articles “Workshop at the Ranch” attract more 
than 85,000 unique visitors monthly. In 2010 he released his highly acclaimed instructional book, The Way I See It. To see 
Dave’s images, learn more about photography, or purchase his book visit his website www.daveblackphotography.com. 

Welcome to GAME DAY ... a SPORTS Shooter’s Guide
This class is about the important “Game Day Strategies” and Gear used for 
capturing a variety of SPORTS and Action imagery for Editorial & Commercial 
clients, Senior Portraits, Youth Teams, High School and College, and Pro Teams.

Remember these Points and you will make good SPORTS pictures:
•KNOW your SPORT so that you can ...
•ANTICIPATE the Action which makes it easier to ...
•FOLLOW the Action which helps you to ...
•FILL the Frame with the Athlete

FOOTBALL: With so many games being played at night under the lights,  
“Long - Fast” lenses like the 400mm f2.8 are most valuable, but todays super 
high ISO cameras can allow the use of f4 aperture lenses like the 200-400mm 
f4, 500mm f4 and 600mm f4 lenses.  
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Your Goal is to “Fill the Frame” with your marque player and if possible kneel 
on the sideline to get a low angle of view at the players. This will make them 
look bigger and more heroic.

Single point AF is a great choice for Auto Focus but a Group Area AF is more 
forgiving if you are new to SPORTS action shooting. I do not recommend Auto 
ISO for indoor events. Auto ISO can be extremely useful outdoors late in the 
season when players are running into the sunshine from the deep dark shadow 
of the stadium. The ISO will compensate instantly as they break into the bright 
sun or run into the stadium shadow.

FOR THIS IMAGE: I used a 400mm 
f2.8 lens with a 1.4x converter to 
achieve 560mm. By kneeling down 
the athlete is framed in a dark area 
of the stands rather than the white 
jerseys of the team bench. 

GYMNASTICS and FIGURE 
SKATING: Indoor lighting and fast 
action means High ISO cameras 
are a must and “Fast” aperture 2.8 
lenses like 70-200mm f2.8 and 
300mm f2.8 are standard.

These are individual/isolated sports 
where the athlete is not part of a 
team during a game. Watch the 
warm-up session and learn some 
of the athlete’s programs/rou-
tines and skill placement on the 
Gymnastics apparatus or the ice.  
 
This will help you anticipate the 
action and “nail” peak moment  

of the gymnast’s routine and skaters program.

Top ranked athletes at any competition often have a “signature skill” that they 
are known for. Learn where that signature skill occurs on the Balance Beam, 
Uneven Bars and Floor Exercise ... or on the Ice and choose your photo  
position to help you best capture that signature skill.

FOR THIS IMAGE: I had watched the warm-ups and noted that this gymnast  
performed a spectacular skill on the end of the Balance Beam. I used a 70-200mm 
lens to capture Hollie Vise winning her first World Championship GOLD medal.

With DAVE BLACK

GAME DAY ... a SPORTS Shooters Guide
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SOCCER and FIELD 
SPORTS: This is a broad 
subject where Long 
and Short lenses can be 
used effectively. Also, 
while field level access is 
usually helpful, getting 
elevated in the stands is 
sometimes a better angle.

If Soccer, Field Hockey, 
Rugby or Lacrosse are not 
one of your usual SPORTS 
to shoot, walk up the 
bleachers for a high 
angle of view so you can 
see and understand the 
sports and make some 
good pictures right away.  

Once you get a general 
idea of how the Game or 
even the Team play, then 
when you can go down 
on the sidelines you will 
likely be more successful. 
Shoot loose during the 
first quarter so you have 
multiple players in the 

frame. Then start shooting tight for the 2nd and 3rd quarter to give your client 
a different feel for the game. Shoot the 4th quarter with concentration on who 
is the Star Player and also look for the celebration reaction by the team. 

Field sports are a wide open pallet of action, color and emotion, so have a long 
lens on a sturdy monopod and a short lens around your neck so you 
don’t miss anything.

FOR THIS IMAGE: It had been two years since I last photographed Soccer. So 
to regain familiarity with the sport I went up into the stands and used a 600mm 
f4 lens to isolate the players and have “clean” background of green grass.
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SWIMMING and WATER POLO: Swimming and Water Polo is a LONG GLASS 
SPORT: 400mm, 500mm, 600mm and 1.4x converter is really advantageous 
to capturing close, tight images of athletes’ face. 

Getting on the pool deck is good but shooting from the first few rows of the 
bleachers is very helpful with “cleaning up” the background. By shooting 
from an elevated position the background becomes water instead of  
the cluttered pool deck.

I recommend using very fast shutter speeds: 1/2000 - 1/4000...these super-
fast shutter speeds can more precisely freeze the action and every single  
water droplet. 

Single Point AF works best for Water SPORTS. For Freestyle and Backstroke 
place the single AF point just above the middle of a horizontal frame profile 
to the athlete so it clears the water and locks-on to the athletes face. Breast 
Stroke and Butterfly can be shot profile but head-on is usually preferred by 
publications.

FOR THIS IMAGE: I used a 200–500mm f5.6 lens with a Polarizer filter to cut 
down the glare off the water. Using a Single AF point the camera Locks-On  
to the athletes face and not the splashing water.
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BASKETBALL and VOLLEYBALL: Indoor SPORTS challenging enough, but 
sometimes just getting the correct White Balance is the hardest part.

To set my White Balance for indoor SPORTS I will use the Kelvin scale and  
activate LIVE view. Then I simply scroll through the Kelvin scale and watch the 
color change on the camera’s LCD screen until the color looks natural skin tones 
and clean White uniforms. 

For Basketball I use a 16-35mm lens underneath the basket and with a REMOTE 
camera on the station. I use a 24-70mm lens when I shoot on the far outside end 
of the baseline. I use a 300mm or 400mm lens to shoot defensive plays down 
court and also players bringing the ball up court.

As with all SPORTS I shoot with my right eye and also keep my left eye open to 
see peripherally see the play as it forms. This helps me anticipate a charge up the 
lane, a jump shot from way outside or a potential rebound.

FOR THIS IMAGE: Cameras are not usually allowed to rest on the court. Therefore 
I have placed my camera with 16-35mm lens resting on my shoe. The LCD  
screen is tilted out and LIVE VIEW is turned on. I have already Pre-Focused my 
lens on the area directly beneath the basket. I watch the play develop and make 
court level pictures.

All this and MORE will be discussed ... and Q&A from the audience. So step off 
of the field or court for 60 minutes ... there’s a lot to learn about GAME DAY.
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With MARK HEAPS

Speed & Feed Approaches in a Commercial Workflow

Mark Heaps
Executive Director, Heaps LLC, a digital communications studio 

Mark has taken care of clients for over twenty years offering solutions for boutique businesses 
and top listed Fortune 500 clients alike. He’s an Adobe Community Professional and Certified 
Expert, an Adobe MAX Masters Award Recipient, a past Senior Instructor of Brooks College, a 
traveled musician, dad of two great kids, husband, dog owner, and foodie.

When you work in a commercial environment it is inevitable that you’ll be col-
laborating with others at some point. Whether that’s other members of your 
own creative team, or maybe you’re collaborating with another vendor who is 
also producing materials for a project. Another scenario is whether or not you 
have to come back and make changes yourself! This is most common when I 
meet designers who come back to an old file and state “what was I thinking 
when I built it this way?”. Depending on the media we are doing production for, 
printer, web, video, and alike, it’s important that we practice what I refer to as 
“Production Advocacy”. In a nutshell what does this mean? 

Production Advocacy:
• Keep it editable
• Make it easily replicable
• Be non-destructive where possible
• Keep it all clean, and well labeled
• Easily share the production setup 

Keep It Editable
When you finish a file, and test the final output, it’s inevitable at some point a 
change will need to be made. It’s best to build your files in a way where you still 
have “access to the numbers”. This means whether it’s a filter setting, a layer 
property, or something else, you want to have access to those values easily and 
afterwards, just in case.

Adjustment Layers
Using these special layers allows you to apply a wide variety of image adjust-
ments to the images on the immediate layer below the adjustment layer, or to 
all the layers below the adjustment layer. Grouping them is what isolates to the 
immediate layer below. But when you use this rather than applying traditional 

image adjustments, from the image menu, to the 
image layer you can retain all of the editable val-
ues and settings to adjust and tweak later. 
 
Equally you can save your settings for an Image 
Adjustment and load them if you have a style 
or appearance that you need to have replicated 
for assets in a brand, campaign, or large project. 
Share those saved settings with a team member 
for consistency amongst your group. 
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Bonus tip! If you have a 
stack of Adjustment Layers 
that create a look you like, 
put them into a Layer Group 
(folder) and you can copy 
and paste that Layer Group 
into other documents to 
quickly add that set of 
adjustments. 

Smart Filters
Although it’s not a new feature to Photoshop, many people trying to adopt  
efficiency in their workflow aren’t taking advantage of Smart Filters. The first 
step being that you need to convert your image layer into a Smart Object. 
It’s easy enough, simply right click on the layer and choose Convert to Smart 
Object. Once you’ve done this you’re putting your image in a form of encapsu-
lated state, it’s a container protecting the image from being destructively edited. 
But this also means that if you apply a filter of any kind to that Smart Object as 
a layer, it attaches the filter and all of its values to the layer acting like a Layer 
Style.

This means that if you incorporate filters to create a specific look for your 
image it can become embedded with that layer. A trick you can use to speed 
up workflow is to hold down your Option or ALT key, and then click and drag 
the Smart Filters from one layer to another. Rather  than reloading all of those 
filters and entering all those custom values, simply drag them to another layer 
and it will replicate the appearance. Even more importantly, if you output your 
final file and realize that you blurred something too much, you can simply 
double click on that Smart Filter in the stack and adjust those settings.

Smart Image Adjustments
Even though we mentioned earlier that Adjustment Layers are a great tech-
nique, and they are, it has advantages and disadvantages. One being that you 
can drag those independent layers around in, or between, documents. We also 

With MARK HEAPS

Speed & Feed Approaches in a Commercial Workflow
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mentioned they are non-destructive which is good. However, when you  
incorporate a Smart Object into the workflow, now when you use the Image 
menu to choose an Image Adjustment like Levels, Curves, etc…, and apply that 
to a Smart Object Layer, it embeds the values on that layer just like a Smart 
Filter. Which means it will non-destructively move and travel with that layer.  

 
 
 
 

 
 
You can also double click on those attached Image Adjustments (Levels, 
Curves, etc) and modify them afterwards for refinement just like you can the 
Smart Filters. Even cooler, if you have a series of Image Adjustments, let’s say 
a Black and White conversion with a Selective Color stacked on it for some 
split toning. Another time saver is the ability to then hold the Option key and 
drag them to any other existing layers. This duplicates all those settings in one 
motion without ever needing to open, or reload, the original dialog boxes.

Layer Styles
If you’ve been using Photoshop for more than a week you are likely to be 
familiar with Layer Styles. But sometimes the deeper potential of them is less 
obvious. The basics first, is that Layer Styles are essentially appearance  
properties that are being applied to the visible pixels on a layer. They are 
attached to that layer, and only affecting that layer. So, the basics are things 
like adding a Drop Shadow, or putting a Stroke on an image. The usual favor-
ites of Bevel & Emboss or Outer Glow, equally get a lot of attention. 

 
However, if we dive deeper there are a great 
mix of visual styles we can create with Layer 
Styles. For example, color grading an image 
with Layer Styles is as easy as using Color 
Overlay from the Layer Styles option. Choose 
a color like a sky blue for the overlay, set the 
Blend Mode to Exclusion, and at first this gives 
quite an abstract appearance. But notice that it 
uses your sky-blue color to tint half the shades 
of the image while the other half is colored 
with the complimentary hue of your sky blue. 

With MARK HEAPS
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To make this a more effective color grading set the Opacity to a value between 
10-20% and it blends into the image nicely. 

 

Thinking about ways you can mix Layer Styles like Color Overlay, Gradient 
Overlay, and more to build a graphic appearance that is formulaic helps  you can 
apply it to other images on your project. As mentioned earlier, you can easily 
copy and paste a Layer Style (Right click on the layer Copy/Paste Layer Style) 
between documents or onto multiple layers.

Even Faster…Styles Panel
The Styles panel is heavily under-utilized in the workflow for most people. The 
process is really simple, create a visual appearance by using Layer Styles. Similar 
to the color grading appearance we had just created. With that Layer selected, 
go to your Styles panel and press the new button. That’s it, all those values 
and settings are now saved as an easy to use, single click, button for recreating 
that visual appearance. Here you can create single click visual styles for add-
ing frames, color grading, gradients, shadows, and so much more. The creativity 
comes with the depth of Layer Style recipes you build out.

Bonus tip! If you are into running Actions 
and batch processing. It’s a lot faster for 
your system to run an action with a step 
that loads a Style from the Styles panel 
(single item to load) rather than loading 
all the originating dialogue boxes to create 
the visual style. And don’t forget, by gen-
erating the visual style using Layer Styles 
you can go back into any images that 
need adjustment and modify the proper-
ties of the Layer Style.
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With VICTORIA PAVLOV

Creating Fantasy, Photo Manipulation in Photoshop 

Victoria Pavlov
Photoshop Painter & Artist

Victoria was born into a musical family and started practicing music at the age of 3. At age 6 
she discovered painting. Victoria spent all of her time in a painting studio to master her craft. 
At age 14 she had her first big exhibit. She was introduced to the camera by her uncle and to 
Photoshop by her teacher. Since that time she became “The Photoshop Artist.” A canvas,  

a camera, a Wacom tablet, and Adobe Photoshop are the clean canvases where she can create her art. One 
of the biggest passions in her life is using Photoshop.

Make your workflow easier with just a few easy steps:  

1: Photoshop CC > Preferences > General > Check “Always Create Smart  
Objects when Placing” box

2: Photoshop CC > Preferences > Tools > Check “Double Click Layer Mask 
Launches Select and Mask Workspace” box 

3: While the Move tool is selected > Check “Show Transform Controls” Box  
in the Options Bar 

Tips: If you have more than three layers, rename them (even if you think you will 
remember what they’re for).  Apply color labels to the layers. 
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In many cases the quickest way of selecting the object is to use “Select 
Subject” in the Options Bar. First select the Quick Select Tool so that Select 
Subject is an option. After you choose Select Subject Photoshop CC will 
select the subjec. Then you can continue working on your selection and mask-
ing using “Select and Mask” Workspace. While the selection is active click 
on “Select and Mask” button located in the Options Bar next to the “Select 
Subject” Button

My Favorite features in “Select and Mask” workspace 

1: View Mode: Onion Skin 
Check “High Quality Preview” box 

2: Output Settings:
    Check “Decontaminate Colors” box
    Output To : New Layer with Layer Mask 
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To change the color of any object in Adobe Photoshop CC > Select the Subject 
you want to change the color > Adjustments > Hue/Saturation 

How to create a custom tree 
1:Create a new Layer > Filter > Render > Tree 
2: From the drop down menu choose any tree you like 
3: Customize the tree 
4: Use Advanced setting to apply personal touches to the tree 

Add attention to any object
1: Select the background layer > Adjustments > Photo Filter 
Tip: because you are applying Adjustment as a separate layer you can bring 
down opacity or adjust this adjustment at any time (till you will merge adjust-
ment layer(s) with any other layer(s) )
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2: Merge all layers > Filter > Render > Lighting Effects 
3: Specify Lighting Effect properties > Infinite > Colors and intensity 

4: Use the Dodge Tool to highlight specific points in your image (remember: less 
is better) 

Final touches : 
Filter > Camera raw Filter > Profiles > Apply any profile you like 
Tip: Choose Convert for Smart Filters from the Filters menu to work 
non-destructively.
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Using Adobe Camera Raw profiles you can apply a completely different feeling 
to any image. Profiles are very powerful tools not only in photography workflow 
but in digital compositing workflow as well. 

Duplicate the layer > Filter > Render >Lens Flare> Position the Lens Flare  
anywhere you like > Specify the lens Type > Specify the Brightness  

Tip: If the Lens Flare is too bright, bring down opacity of the top layer 
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With KRISTINA SHERK

Masters In Skin

Kristina Sherk
Photo Retoucher, Author

For the past 10 years, Kristina Sherk has been a high-end photo retoucher based out of Washington, 
D.C., and is called the “picture whisperer” by some. She specializes in realistic retouching. She’s a 
contributing educational author for publications like Shutter Magazine, Photoshop User magazine, 
and Lightroom Magazine. She is also the author behind Photoshop Cafe’s Fashion Retouching 

DVD. Her more reputable corporate clients include National Public Radio, Time Inc., XM Satellite Radio, Cotton Inc., 
and most recently, Hasselblad.

The History of FAL
• It was introduced in Photoshop CC 2015.5 and was updated in CC 2017,

How it works
• What is it? It’s face detection software within the Liquify dialog box. 
• �It uses Adobe’s AI, “Adobe Sensei,” as the primary face detection, and  

then if that doesn’t register a face, there is a backup face detection  
software, as well. 

• �This face detection software is also in Photoshop Fix (iOS/Android) and 
also used in Select>Color Range. 

• It can be used on smart objects and video! 
• It can also be used on cartoons and Illustrations! 

 To access FAL, you first need to go into your Liquify dialog.

On the left side of the Liquify dialog, in the toolbar, you have the Face tool. 
And on the right side, you have a section with all of the FAL options. Both are 
pointed out in the screengrab below. 
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Within Face-Aware Liquify on the right, you have the following sub- 
categories: Eyes, Nose, Mouth, and Face Shape. Also, if there are multiple 
faces in the image, you are able to tell Photoshop which face you want to 
modify by using the Select Face menu.

When you open up each sub-category, you’re able to make changes to all 
sorts of aspects of the facial features. For example, you can make the eye size 
larger or smaller, and you can do it for the left eye, or the right eye, or both. By 
default, the feature modifiers for the eyes are unlinked so you can change them 
independently of each other, but if you want to tweak both eyes, simply click 
the chain-link icon between the sliders and that will link the two together. 
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There are two ways to make changes. 
If you are old school like me, you can 
use the sliders in that right-hand panel. 
If you are new school and you work on 
mobile devices, you can use the access 
points on the image itself as you scroll 
over it. The square shape changes the 
size of the facial feature, and the circle 
changes the height and width. 

If you aren’t seeing the access points when you scroll over the face, make 
sure you have activated the Face tool in the toolbar. 

And, make sure that on the right, under View Options, you have Show Face 
Overlay checked. 

To preview the changes between the before and after, simply hit the P key to 
switch between the two states. P stands for Preview. 

FAL Limitations
If you get this error message, make sure your graphics processor is turned 
on. The graphics processor is located inside the top Photoshop menu, under 
Preferences>Performance.

Another limitation the 
software has is that if 
a face is rotated more 
than 30 degrees, it 
won’t register the face. 
It also does not work 
on face profiles. 
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Multiple Faces
If you have an image with multiple faces in it, you will need to first choose 
which face you want to modify. To do this, in the Properties panel on the 
right, go to Face-Aware Liquify, and then click on the Select Face menu to 
make your face selection. To select the face you want to work on, simply click 
on the face and the Select Face menu will switch to the corresponding face. 

Working with Meshes 
If you are going to work smarter, not harder, any opportunity you have to do 
the work once and then re-apply it to subsequent images is something you 
should do. Any opportunity you have to save time is important. 

A mesh is sort of like a preset for liquify. A mesh lays a small grid over the 
image and then warps certain locations of that grid (and the underlying 
image beneath it). 

In the example below, you can see the Show Mesh checkbox is checked 
(located in the View Options). And you can see where I have liquified. Take 
note that the boxes where I have warped the pixels have changed, too, as if 
to show what the change was. 
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This used to not be important for photographers who photographed faces, 
because each face was different and facial features were located in different 
areas of images. Now that the face-aware technology has been incorporated, 
though, it’s a different story. You can now create general mesh presets that 
allow you to open all eyes, or add a smile to whichever image you are work-
ing on, regardless of where the smile falls in the framing of the photograph. 

Before we create a mesh that is going to add a smile to faces, let’s dissect 
what changes happen to our facial features when we smile. The bottom lip 
stays relatively the same, but the top lip raises a lot. Also, the lips get thin-
ner and wider as if they are stretching out. The eyes also change, they get 
shorter from top to bottom and squint a little. 

Here are the changes I made to add smile to this face.
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Now we can save these changes. In the Load Mesh Options section of the 
right-hand panel, there is an option to Save Mesh. Name the file “Add Smile,” 
and then save it somewhere where you can find it easily. 

Next, we can open another image, and in that same Load Mesh Options 
area, we can choose Load Mesh, and the same changes will be added to our 
next file. 

Adding FAL to Video
I have a short video of a girl making expressions for this example. Let’s start 
by bringing this video clip into Photoshop. In your Layers panel, Right-click 
on the video clip icon, and choose Convert to Smart Object, then we can 
take the video layer into Filter>Liquify. 

At this point, we can make any changes we would like to make to the video 
and then click OK. You’ll see the changes update on that frame, but to make 
the changes show up on the other frames, you’ll need to click-and-drag the 
video scrub-head (in the timeline window) slowly from start to finish in order 
to render each frame to see what it looks like. 
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Luminosity Mask Basics In Lightroom & Photoshop

Matt Kloskowski
Lightroom Guru & Landscape Photographer

Matt is the founder of Matt Kloskowski Photography and Training. He specializes in out-
door, landscape, and nature photography, along with editing with Photoshop, Lightroom, 
and ON1 apps. Matt was inducted into the Photoshop Hall of Fame in 2014 and is the best-
selling author of more than 20 books. Matt loves to educate others and spends much of 

his time teaching seminars around the world. 

Luminosity masks have become quite the buzzword over the last few years. 
The funny thing about that is they’ve been around since the very early days of 
Photoshop. These masks can be really helpful for editing landscape/outdoor 
photos and challenging lighting in a variety of photos. The one thing that I like 
to tell people before we start, though, is that they’re only a tool that gets pulled 
out of the toolbox sometimes. Every photo doesn’t require the time and com-
plexity of a luminosity mask—we’ll talk more about that as we go on. 

Part 1 - Basic Luminosity Masking

Step 1: Open a photo that has some challenging exposure areas in the high-
lights, as well as some areas in the shadows. These are the best types of pho-
tos to work on when it comes to luminosity masks. Now, whether you’re using 
Lightroom or Camera Raw, at this point I only do basic changes like cropping, 
color correction, and some sharpening. The fact that you’re doing luminosity 
masking means you don’t want to use the overall Shadows and Highlights slid-
ers. When you’re done with those basic edits, open the photo into Photoshop.
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Step 2: Next, we’re going to make some selections. But we’re going to use the 
Channels panel to do it. Head to Window>Channels, if you don’t know where it’s 
located, to open the panel. 

Step 3: Now, hold down the Command (PC: Ctrl) key and click once on the RGB 
channel. This puts a selection around the “luminance” values in the photo. This is 
approximately the 50% bright stuff in the image.

With MATT KLOSKOWSKI

Luminosity Mask Basics In Lightroom & Photoshop
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Step 4: Then, click on the Save Selection as Channel icon at the bottom of 
the Channels panel (the second icon from the left). This creates a new chan-
nel, which essentially is a way to save that selection you just created. It’s not 
required, but to keep things tidy, you can name this “Brights 1” (double-click on 
the channel’s name to rename it). Do not deselect yet.

Step 5: Go to the top menu to Select>Inverse. This reverses the selection you 
had and is now the opposite of selecting the luminance values in the photo. 
Now it’s the darkest 50% of the image. Again, click the Save Selection as 
Channel icon to create a new channel and call this “Darks 1.” Now you can press 
Command-D (PC: Ctrl-D) to deselect. 

With MATT KLOSKOWSKI

Luminosity Mask Basics In Lightroom & Photoshop
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Step 6: Now that we have the brightest and darkest parts of the image select-
ed, we need to do something with them. Go ahead and Command-click (PC: 
Ctrl-click on the Brights 1 channel you created earlier to load it as a selection. 
Then click on the RGB channel at the top. (SUPER IMPORTANT: You have to 
click on RGB before moving on.) Head back to the Layers panel and add a 
Curves adjustment layer. This will automatically use the selection that’s active. 
Now you can use the Curves adjustment to darken the bright areas and the 
adjustment will only affect the luminance, or bright, parts of the photo since 
that is the luminosity selection/mask you created it from.

Step 7. You can also do this in reverse. If you want to make the darks brighter, just 
follow the same steps (6 and 7) with the Darks 1 channel, using the Curves adjust-
ment to lighten it. There you go! You just created some basic luminosity masks. 
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Part 2 - Refined Luminosity Masks

Step 1: Go ahead and create the basic Brights 1 luminosity mask like before. 
Before deselecting, we’re going to create more masks, though. Hold down 
Command-Option-Shift (PC: Ctrl-Alt-Shift) and click on that top RGB channel 
again. This will create a refined selection that doesn’t contain quite as many 
brights as the first selection did. You can click the Save Selection as Channel 
icon to make a new channel and name this Brights 2.

Step 2: Repeat this four more times. So, you should end up with six channels, 
Brights 1 through Brights 6. Each channel, when you click on it, should show 
less and less white (the luminance/selected areas). That means each channel’s 
lightness is further refined than the previous channel. 
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Step 3: Press Command-D (PC: Ctrl-D) to deselect. Now Command-click (PC: 
Ctrl-click) again on the RGB channel to put a selection around the luminance. 
Then go to Select>Inverse to reverse the selection and create your Darks 1 
channel.

Step 4: Just like before, hold down Command-Option-Shift (PC: Ctrl-Alt-Shift) 
and click on that Darks 1 channel to further refine the darks mask. Create a 
new channel from it. Then repeat this process four more times, each time 
clicking on the Darks 1 channel to further refine it.

Step 5: At this point, you’ve got more masks than before, but the concept is 
exactly the same. As you look at your photo and determine what you need to 
do to it and where the tones lie, you have more masks to refine those adjust-
ments with. Just remember it this way: When you click on a mask and look 
at it, the white areas are what is selected and what will be affected by your 
adjustments. The more white areas, the more will be adjusted. Only a small 
white area means your adjustment will only affect a small area. 
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NOTE: Although we’re using Lightroom, you can do the 7-point-system entirely in 
Photoshop’s Camera Raw, since Lightroom’s Develop Module actually is Camera 
Raw with a different name.  

1ST POINT: CHOOSING A BETTER STARTING PLACE
If you shoot in Raw format, one of the first things you’ll probably notice is that your 
images look much flatter, less contrasty, less sharp and less colorful than they did when 
you saw the image on the LCD screen on the back of your camera. That because when 
you shoot in JPEG your camera adds contrast, enhances the color, and adds sharpening 
(and other stuff) to make your images look their very best. But when you shoot in Raw, 
you’re telling the camera, “Don’t do all that color correction and sharpening stuff—I’ll do 
all that stuff myself later in Lightroom—so turn all that stuff off and just give me the raw 
un-enhanced photo.” 

So, that’s what you’re seeing in Lightroom—the 
raw, un-enhanced, un-sharpened photo, which 
looks flat and un-enhanced versus the JPEG pre-
view you see on the back of your camera (even 
when you shoot in Raw, you still see the sharper, 
more vibrant, enhanced JPEG preview on your 
camera’s screen). Adobe applies a RAW color 
profile called “Adobe Color” which isn’t nearly as 
bad as the RAW profile we’ve been using for the 
last 10 years (called “Adobe Standard”) but while 
Adobe Color is better than Adobe Standard, it’s 
a still kind of a flat-conservative look for your 
image. However, you don’t have to start at such 
a flat look — I recommend applying a different 
RAW Profile in Lightroom to get you a better 
starting place — one that’s more like the JPEG 
preview you saw on the back of your camera. These are found at the top of the Basic 
panel. You’ll see a pop-up menu for “Profile” and you’ll see a list of RAW profiles, and 
you try each one to see which one makes your Raw image look more like your JPEG 
image (or at least which ones better as your starting place, depending on your sub-
ject). Either way, a better starting place is one menu away.

notes

With Scott Kelby

Scott’s Seven-Point System for Lightroom

You Can’t Beat the System
11-years ago I released a book called “Scott Kelby’s Seven-Point System for  
Adobe Photoshop” and the idea behind the book was that if you just learned 
to master seven key techniques in Photoshop (a few of which were actually in 
Lightroom), that not only would you know what to do when, but you’d also be 
able to tackle most any photo that comes your way. After feedback from thou-
sands of users around the world (it was the #1 selling Photoshop book that year), 
and since the way we process our photos has changed so dramatically since  
then I’ve refined “The System” so you can do the whole thing — all Seven Points 
— right within Lightroom itself, and it actually works better than I had hoped.
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2ND POINT: GETTING YOUR COLOR RIGHT 
If your color doesn’t look right…it’s wrong. It’s most likely because your White 
Balance isn’t right, which makes your photo either too yellow, too green, or too 
blue. Luckily, this is amazingly easy to fix (especially compared to what it would 
take to remove these color casts in Photoshop itself, using either Curves or Levels). 

Another reason it is important to fix your white balance first because it changes 
your exposure (drag either the Temp or Tint sliders and look at the Histogram 
as you do and you’ll see what I mean). Also, I find it hard to work on an image 
where the color is way off. If you fix this first, most of your color problems will 
go away. White Balance, for the most part (unless you’re doing product pho-
tography), is a creative decision. For example, I generally make people warmer 
(people look better with warmer skin, so while it’s not accurate, it looks better). 
 
THERE ARE three different ways to set your 
White Balance (but I generally use the third 
method myself).   
 
(1) Choose one of the built-in White Balance 
presets from the pop-up menu in the Basic 
Panel of Lightroom (as seen here). If you’re not 
sure which one is right — try them all. Chances 
are one of them will probably look pretty 
decent. If you find one that looks good to you 
—you’re done.  
 
(2) If you don’t find one you totally like, pick the 
White Balance preset that looks the most right, 
then tweak it by dragging the Temperature or 
Tint slider toward the color you want more of (so, 
if you image looks too yellow or warm, drag the 
Temperature slider away from yellow — to the left, 
toward blue). These Temp and Tint sliders are also 
where I go when I want to choose a “Creative” 
white balance; where perhaps the white balance 
isn’t accurate, but it looks better (like on a land-
scape sunrise that I want to look color-wise much 
more awesome than it really 
did when I was there). 
 
(3) The way I most-often set my white balance is to grab the White Balance 
Selector tool (it’s icon looks like an eyedropper). Just take this tool and click it 
on something in your photo that is supposed to be a light gray (or some neutral 
color), and that sets your white balance. If it doesn’t look good the first time you 
click the tool, click it somewhere else. Keep clicking in light gray neutral places 
until your white balance looks right. Also, to see a preview of how the white bal-
ance would look if you clicked the eyedropper in that spot, just look over at the 
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Navigator panel (top of the left side panels)  and as you move your cursor and it 
gives you a live preview. Super handy. By the way; if you have an obnoxious color 
panel that follows your white balance eye-dropper tool around, or if you click the 
tool once and it returns back to the Basic Panel, go down to the Toobar at the bot-
tom (turn off ‘Show Loupe’ and ‘Auto Dismiss’).

3RD POINT: GETTING YOUR EXPOSURE RIGHT 
To do this right, you’re going to use more than just the Exposure slider. We’re 
going to start by having Lightroom automatically expand our tonal range, using 
kind of a “secret handshake.” By that, I mean this feature is hidden unless some-
body tells you that it even exists, and then you have to know the shortcut. This 
“expanding the tonal range” is something we did routinely back  
in Photoshop, usually using Levels, by setting the white point and the black point 
there. We can do the same thing here in Lightroom (and Lightroom will do all the 
work for us, finding the brightest white point and the darkest black point in the 
image, usually without clipping either one). 

(1) WHITE POINT 
Press-and-hold the Shift key on your keyboard 
and double-click directly on the word “Whites” 
(or on the little “nub” for the Whites slider). This 
will have Lightroom automatically set the Whites 
up as far as they can go without clipping the 
brightest areas in your image. Depending on the 
actual current exposure of your image, it might 
move that slider a lot, a little, or not at all—in one direction or another (to the 
right brightens the whites in your image; to the left darkens them). 

(2) BLACK POINT 
Do the same thing for the Blacks—press- 
and-hold the Shift key on your keyboard and dou-
ble-click directly on the word “Blacks,”  
and Lightroom will set the Blacks as far as  
they can go without clipping the darkest  
areas in your image. That’s it—you’ve  
expanded your tonal range as a start.
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EXPOSURE: IT CONTROLS THE MIDTONES 
After you’ve set the white and black points, now it’s time to tweak the Exposure 
slider. It controls the midtones and the upper shadow and the lower highlight areas 
(in other words, it affects a big range of your overall image). Because you already 
set your white and black points, you probably won’t have to move this slider a 
whole bunch, which is why I said you’ll just “tweak” the Exposure slider. If you drag 
it to the left your image get darker, and if you drag it to the right (as shown here), it 
gets brighter. 

SO, HERE’S the whole process:  
(1) Set the white point with the Whites sliders (well, let Lightroom do it for you).

(2) THEN the black point.

(3) THEN tweak the Exposure slider to get 
the overall exposure where you want it. Easy 
enough. Here, you can see I had Lightroom set 
the Whites to +20, the Blacks to –59, and then I 
dragged the Exposure slider to +0.60 because 
I thought the overall image was a little too 
dark. 

OKAY, THAT’S setting your exposure. 

AVOIDING CLIPPING 
When tweaking your exposure, there’s one big 
thing to keep an eye out for: highlight clipping! 
You’ll know if you have a clipping problem, if 
the triangle in the upper-right corner of the 
Histogram turns white. That means the high-
lights have gotten so bright that there’s actually 
no detail whatsoever in the very brightest parts 
of photo. Now, is 
that a bad thing? 
Well, it depends. 

FOR EXAMPLE, 
if the part that’s 
clipping is on your 
subject’s skin, that’s 
an area with very 
important detail, so 
you’ll have to deal 
with it. However, 
if the part that’s clipping is the sun, or a reflection on the chrome bumper of the car, 
those aren’t areas with real detail, so we just ignore those. So, how do we know which 
areas are actually clipping? Click directly on the white triangle (shown circled here) 
and any areas in your photo that are clipping will appear in bright red. 
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IF YOU do have an important area clipping, you 
could lower the Exposure until the white triangle 
turns black, but now you’re sacrificing the overall 
exposure just to fix one small problem. That’s why, 
instead, we drag the Highlights slider to the left 
until the white triangle turns black (and your clip-
ping problem is gone). This slider just affects the 
very brightest highlights, so usually, just dragging 
it a little to the left (as shown here) will do the 
trick. This works so well because now we have the 
best of both worlds—your overall exposure stays 
the same, but the Highlights slider brought back 
the clipped problem areas. However, you only 
need to use it if you have clipping. If there’s no 
clipping, you don’t need to use it.

NOTE: EVEN when you shoot in RAW, you will still see the JPEG preview on your 
LCD. If you see just a reasonable amount of clipping, when you open the file in 
Lightroom, you will likely not see any clipping at all. The JPEG image will clip soon-
er than the RAW file will since the RAW file takes in a wider tonal range. 

TIP: CRUSHING the highlights (setting the slider 
at –100, all the way to the left) can work great 
for skies in landscape and travel shots. Doing this 
can bring back great detail and definition in the 
clouds. Give it a try and see how it looks on your 
particular shot. 

OPENING UP DARK SHADOW AREAS
THIS IS like the Highlights slider in that you won’t 
use it for every photo—just photos where you 
have a problem (for example, if your subject is 
backlit, unless you added a fill flash when you 
took the shot, chances are your subject is too 
dark. That’s when you use the Shadows slider—it 
brings out shadow details big time). 

I ONLY drag the Shadows slider to the right (opening up the shadows, rather than 
darkening them to the left). If you have to open the slider a  
lot or all the way up to the right, it can look a bit flat, so just add a little bit of con-
trast to get that back. Remember, your eyes see a much broader range of tones 
than your camera can expose for. So it exposes for the sky or the foreground—it 
can’t do both (even tough while we’re looking at the scene, it looks perfectly fine. 
That’s because our eyes are way more advanced than the sensors in our cameras). 
The Shadows slider helps bring out those details that are hidden in the darkest 
parts of our image.
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FOURTH POINT: ADDING CONTRAST 
THE BIGGEST issue I see in when people have me critique their post-processing 
is that their images look flat. It’s probably because when we shoot in Raw, the 
camera does not add any contrast — we need to do it yourself in post, and a lot of 
folks just don’t. 

SO GO to the contrast slider, and drag it to the right 
(of course, do this after your Exposure, White and 
Blacks, and White Balance are all set first). 

IF I had to point to one big thing that I do to make 
a difference in my images, this is it. It makes the col-
ors more saturated and vibrant (without using the 
Vibrance or Saturation sliders); it makes the bright-
est parts of the image brighter and the darkest parts 
of the image darker, and it has a marvelous effect 
on most images (try really cranking the contrast on 
black and white images —you’ll love it!). 

SOME PEOPLE move the Contrast slider just a bit. I slide it to the right a lot. By 
the way — setting the Whites and the Black points also adds some contrast, so 
you do this on top of the contrast it adds. 

THAT IS not enough, you can use the adjustment brush to paint in even more 
contrast (as seen at right) — just zero out all the other sliders then crank up the 
contrast and paint over any areas that need even more contrast. Only do this after 
you’ve added contrast in the Basic Panel and you still feel there are some areas 
that could use more contrast. This won’t happen often, but when it does you’ll be 
glad you know how to do this. 

IN EMERGENCY contrast situations (I haven’t had 
to do this in years), you could use the Tone Curve 
pane’s pop-up menu (seen here) to create a curve 
in the shape of an “s” which creates more contrast 
(this is added on top of anything you did in the 
Basic panel), but again — this is a “break the glass 
and pull the alarm” type of situation if you see me 
in the Tone Curve panel adding contrast. 

THERE”S ANOTHER form of contrast: Midtone Contrast

ENHANCING TEXTURE AND MAKING THE IMAGE 
“POP!” 

WHEN I’M working on an image that has lots of detail or texture (anything from 
landscapes to travel photography to portraits of men to cityscapes), my first 
thought is to increase the amount of Midtone Contrast using the Clarity slider. 
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THE CLARITY slider enhances the detail, and 
makes the image a bit brighter at the same time. 
It makes the midtone blacks get blacker and the 
midtone whites get whiter, so that makes the 
entire image look sharper, even though you didn’t 
sharpen it.  

I GENERALLY apply a Clarity amount between 15 
and 40 of Clarity to every image I edit using “The 
System” with the exception of:  
 
(a) Images that you want to look softer, like a por-
trait of a mother-daughter, or a photo of a puppy, 
so something where you really don’t want your 
subject to look too snappy and punchy.  
 
(b) Images that you really want to look punchy (like Landscapes, cityscapes, 
and shots with lots of intense details, like a photo of a car, a motorcycle, 
machinery, and old barn—any type of image where you want the details really 
contrasty and super sharp). In these cases, I’ll crank the Clarity amount to 
around 75, or perhaps even higher.  
 
TIP: How do you know if you’ve applied too much Clarity? You’ll start to see 
a black glow start to form around the outside edges of your subject. If your 
clouds suddenly start to have drop shadows, you know you’ve gone too far. 



225

Scott’s Seven-Point System for Lightroom
With SCOTT KELBY notes

the

FIFTH POINT: Adjusting individual Areas of your Image
SO FAR, the edits we’ve made have affected the entire image at once (called 
“global adjustments”). But, sometimes you need to make one part of your image 
brighter, or one part darker (usually just using the Exposure slider), and that’s 
when we switch to the Adjustment Brush to do “localized adjustments”. 

USING THE Adjustment Brush is pretty straightforward, but there’s one thing that 
takes a little getting used to: you start by choosing what you want the brush to do 
first (like make the area where you’re going to paint brighter or darker), but you have 
to choose an arbitrary amount to start with. It really doesn’t matter what amount you 
choose to start with, because you can change the amount after you’ve painted with 
the brush (which is much different than how Photoshop usually works, right?). 

HERE’S WHAT to do:
(1) Get the Adjustment Brush (K) from the 
toolbox right above the Basic panel. Now, if 
you think you want to brighten the exposure, 
for example, you’d drag the Exposure slider 
to some random amount over on the right, 
then paint over the area you want brighter. 
At this point, don’t worry about whether it’s 
bright enough, or even if it’s too bright—just 
keep painting over the area you want to 
adjust. When you’re done painting, then grab 
the Exposure slider and drag it until you get 
just the right amount (either more or less 
than the amount you started painting with). 

TIP: To reset all the sliders, just double-click on 
the word “Effect,” near the top left of the panel, 
and they all set back to the center (to zero).

(2) If you want to adjust a different area, click 
on New, at the top of the panel, then start paint-
ing in a new area. Now, you can edit this area 
separately. If you want to go back and tweak 
the first area you adjusted, move your cursor 
over that area and an Edit Pin (a round circle) 
will appear in that area (which shows where you 
first clicked when you started painting over that 
area). Click on that pin and now you’re adjusting your first edit. So, any time you want 
to switch to a different area, just move your cursor over that area, click the Edit Pin, 
and then grab the sliders.  

TIP: Once you’ve added an adjustment, you can add more adjustments to that 
same area (like Sharpness or Contrast) by just dragging other adjustment sliders, 
and they’ll all be applied to that area at once. 



226

Scott’s Seven-Point System for Lightroom
With SCOTT KELBY notes

the

The Graduated Filter
This one is designed to mimic an actual gradu-
ated filter (the type you’d add to your lens 
when taking landscape shots to compensate 
for washed-out skies, where you exposure for 
the foreground and that makes the sky too 
dark). Those filters have a dark gradient at the 
top and graduate down to clear in the center 
of the image. Well, this filter does essentially 
the same thing. If you click on the Graduated 
Filter tool (M; as shown here) in the toolbox 
above the Basic panel, you’ll notice that you 
have access to pretty much the same sliders in 
the same order (and some other features, too—
more on that later today). 

The way I generally use this filter is to zero 
out all the sliders, then I lower the Exposure 
amount to about –1.00, and then I click-and-
drag the filter from the top of the image 
down to the horizon line (or wherever I want 
the transparent area to begin). You can 
reposition it by clicking-and-dragging the center Edit Pin, and you can make the 
area it covers smaller by grabbing the bottom line and dragging upward. When it 
comes to skies, another thing I’ll often do is add some blue white balance into the 
sky, and it works really well for making the sky look awesome. 

The Radial Filter
This tool allows you to put an oval (or a circle) of light right where you want it (well, 
that’s what I use it for). Basically, you get the tool (Shift-M), drag out an oval and, using 
the sliders, adjust what happens (a) outside the oval, like darkening the exposure for 
everything outside it, or (b) inside the oval. You do this by turning the Invert Mask 
checkbox, at the bottom of the panel, off/on. You can reposition the oval by clicking-
and-dragging the Edit Pin in the center; change its shape by dragging the white points 
around the outside of it; or rotate it by clicking outside the oval, by one of the white 
points (as seen here), and your cursor will change into a two-headed rotation arrow.
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SIXTH POINT: FIXING LENS PROBLEMS 
There are a number of problems that can be caused by your lens, and if you see one 
(like barrel distortion, with something bowing in or out), go to the Develop module’s 
Lens Corrections panel. Most lenses cause some kind of a lens problem, even if it’s just 
edge vignetting or a little bowing. If you can fix these, you will be amazed at how much 
it changes and improves the image (well, in most cases anyway). 

THE FIRST step is to enable the profile correction. 
That way, you’re giving Lightroom a crack at fixing 
the problem by applying a profile that addresses 
known issues with the lens that was used when you 
took the shot. Doing this also helps with what you’ll 
have to do if you have to take things a little further. 
So, to me, it’s always worth at least turning on this 
option. To do that, you turn on the Enable Profile 
Corrections checkbox on the Profile tab (Basic tab, 
in Lightroom 6), and it will usually detect the lens 
you used and apply a profile fix automatically. If it 
doesn’t find your lens, then choose the Make and 
Model of your camera and lens from the pop-up 
menus in the Lens Profile section. 

THAT WILL usually do the trick, if you had a little 
lens distortion or edge vignetting, but if your image 
is crooked, or has horizontal or vertical distortion, 
or lots of barrel distortion, then you’ll want to try 
the Upright feature, which is found in the Transform 
panel. Upright works best with the Enable Profile 
Corrections checkbox turned on, so you’re already 
ahead of the game. The Auto choice does what 
Adobe calls “a balanced correction,” and it’s the 
one I wind up using the most by far. It many cases, 
it will be just what you need. Level will try to 
straighten your image; Vertical will correct an image 
that is tall and leaning; and Full tries to fix the entire 
perspective, but sometimes it’s a bit over the top. I 
click on them all because you never know which one will look best until you do (but 
again, to me, Auto usually looks the best). Guided Upright lets you manually click-
and-drag out straight lines over parts of the image that need to be horizontally and 
vertically straight, and it applies the correction based on where you place those lines.

IF THE profile and Upright features still don’t fix the problem, then it’s time to do it ourselves 
using the Transform sliders. This is going to sound like a cop-out on my part, but the best way to 
learn what these sliders do is to literally drag them back and forth. Once you see how they affect 
your image, they will totally make sense. Do don’t little drags, though—drag them all the way to 
the left and then all the way back to the right. Once you do this, you’ll see a visual representation 
that makes it really clear.
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SEVENTH POINT: FINISHING MOVES 
Here’s some important finishing moves to wrap up the editing process:

SHARPENING  
IN the Detail panel, the Amount slider con-
trols  how much capture sharpening is applied 
(Capture sharpening is what we add right up 
front to make up for the fact that our camera 
doesn’t apply sharpening to RAW photos, so 
there’s an inherent loss of sharpness that needs 
to be addressed right up front in Lightroom). 
Most of the time, you just need to adjust that 
Amount slider. To see the effects of sharpening, 
Adobe recommends viewing your sharpening at 
100% size. The Radius and Detail sliders I usually 
leave right where they are. The Radius is set to 
1.0 by default, and unless I really need to apply 
some serious sharpening (for images with lots of detail and edges). The Detail slider 
however is set in the perfect place right where it is, as the default setting allows you 
to apply more sharpening without the problems (like halos and artifacts) we get 
when sharpening in Photoshop using the Unsharp Mask filter. If you drag the Detail 
slider all the way to the right, you lose all those benefits and it applies sharpening 
just like Photoshop’s Unsharp Mask. Instead, leave it where it is to have Lightroom’s 
smarter sharpening. 

NOW THE next slider, Masking, is 
magic when it comes to images 
of people. Press-and-hold the 
Option (PC: Alt) key and drag 
this slider all the way to the left 
and it will apply the sharpen-
ing to the detail areas and not 
the skin, which is why I use it on 
portraits of women or children. 
It applies it just on the areas of 
a woman’s face right where you 
want it, like the lips, the eyebrows, hair, and the eyes. As you drag it to the right (with 
the Option/Alt key held down), it starts to apply the mask and only the white areas in 
the preview are being sharpened (the black areas are protected by the mask). By the 
way, here’s a quick recap of the sliders: 

AMOUNT: The higher you drag this slider, the more sharpening is applied.
RADIUS: How many pixels out the sharpening is applied (I usually leave mine set at 1.0). 
DETAIL: This is basically a halo-avoidance slider, and its goal is to let you apply more 
sharpening without having a glow or halo appear around the edges of your subject. 
MASKING: This helps to restrict the sharpening to just the detail areas. 
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CREATIVE SHARPENING  
Creative sharpening is optional, and you 
apply it using the Adjustment Brush. 
There’s a single slider called Sharpness 
and you can increase the amount and 
paint sharpness over areas that you want 
to visually emphasize. 

OUTPUT SHARPENING  
The third type of sharpening is Output Sharpening, and you apply this when 
you’re exporting your image outside of Lightroom, or if you’re printing your 
image from within Lightroom’s Print Module. You tell Lightroom what your final 
output media will be (screen, glossy or mat paper), and based on the size and 
resolution of your image, it calculates and applies the proper amount of sharpen-
ing based on whether you want a low amount of Output sharpening, Medium or 
High. I can’t really see the effects of the “Low” sharpening setting, so I use either 
Medium or High (mostly High). 
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ENHANCING COLOR USING VIBRANCE
The Vibrance slider, near the bottom of the Basic 
panel, is dramatically better than the Saturation 
slider (which just makes everything more colorful, 
and unfortunately, it’s rare that you need every-
thing more colorful). That’s why the Vibrance has 
slider (for me, and for this system) has completely 
replaced the need to use the Saturation slider for 
anything other than removing color (desaturating). 

The Vibrance slider actually does three things at once: 
(1) It makes any colors in the image that are dull, 
more vibrant.
(2) It does very little to colors that are already vibrant.
(3) It does its best to avoid skin tone altogether, so 
it’s safe to use on portraits.

Grab for this slider any time you want to make the 
colors in your image more vibrant, without totally 
trashing the color of your image. 

SUBTLE EDGE DARKENING 
Although the Vignetting feature was put in 
Lightroom to remove edge vignetting (a lens prob-
lem that makes the corners of your image look 
darker than the rest of the photo), adding an inten-
tional, more visible darkening to the edges of an 
image has become really a popular look, but the 
version I use is so subtle, you don’t even realize I’ve 
added one, but it makes a surprisingly big differ-
ence in many cases. 

You remove vignette problems in the Lens Corrections panel but to add one, we 
use the Effects panel, instead using its Post Crop Vignetting feature. All I person-
ally do (this is just my own thing here—you can add as much vignetting as you 
deem fit) is simply add an Amount of –11,  
with the style set to Highlight Priority (I don’t recommend using any of the styles 
accept Highlight Priority). This darkens the edges all the way around and kind of 
creates a spotlight effect in the center of your image, if you move the Midpoint 
slider way over to the right (I don’ t generally touch the Midpoint slider, because I 
add such a subtle vignette). 
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Tim Wallace
Commercial Photographer Tim Wallace is the driving force and creative thinker behind AmbientLife

An award-winning commercial photographer based in Manchester England and working 
Internationally his work is often described as both creative and dramatic. Tim works internationally 
with many high clients across the globe such as McLaren, Jaguar Land Rover, Peugeot,  
Mercedes and Aston Martin. Over recent years he has also broadened the AmbientLife brand  

to include other transport related work such as HGV Truck and large vehicle photography, Aviation and aircraft work, 
engineering and logistics. 

Tim is a critically acclaimed photographer whose work has spanned both commercial and advertising clients for  
over 12 years. Over the past decade AmbientLife have worked with a who’s who of automotive royalty, and Tim’s 
work is highly sought after, and this is driven also by his string of awards including British Commercial Advertising  
Photographer of the Year, and the acclaimed UK Motor Industry Car Photographer of the Year award to name but a few.

Words I live by in my Business:
“Your Professionalism is your Brand
Your Personality is your business card
How you make your clients feel is your Trademark”
- Tim Wallace

As a working commercial photographer I am often in a situation where a client 
may require a certain feel or mood to an image that means it needs to have a 
‘look’ that may involve the need to create a composite image so that I can fully 
control the background or environment. It’s also common that the ‘look’ that we 
are seeking for the scene that the image will be shot in just does not exist in real 
life or the budget will not allow us to travel to wherever that might be. It is also 
very common as a transport photographer that what we often shoot can not be 
taken to location, this is perhaps purely down to time and logistics or may well 
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be because of other reasons, either way the need to use composites in my work 
is often based around the ‘need,’ rather than the wish to do so. My own personal 
feelings are that when its possible to actually shoot the object in the desired 
scene then that is always my preference.

This class will look at some composites and take you behind the scenes of the 
elements that make up that, a deconstruction of a completed piece of work 
back to its origins with all the paths along the way. As this is very much a ‘live’ 
class looking through completed work it is not really possible to give you  
comprehensive notes on each one step by step and to some degree the main 
points being looked at here for me are to display the ‘mindset’ and approach to 
making a composite. It is very important that when you start to look at making 
these composites that you learn to plan out what you want to do before you 
even start shooting any frames. By doing this properly we can plan out exactly 
what we need to shoot, how we need to shoot that and where that will fit into 
our final piece of work correctly.

One really good example of that is my constant need as a transport photogra-
pher to have a firm grasp on both distance and perspective when I shoot so that 
my elements can blend together in the best way possible. This is something that 

I will talk through a little during the class and how I manage those factors.
There are however a few things that I feel are really important to get to grips 
with when looking at just about any composite so we will be concentrating on 
these in our class together.
 
n � Perspective of the image elements

n � Colour matching of subject to the background

n � Contrast matching of the subject to the background

n � Shadow creation

With TIM WALLACE
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We will be talking through these in class but let’s have a look at one of these 
now in this workbook now so that you can get a taste of what I am talking  
about in class.
 
Colour matching your elements.
If we look at a basic setup for a composite being that we shoot a background 
and then shoot our subject separately seeking to blend those two items 
together we will note that often it is the case that the two elements have 
a slightly different colour balance to them, or indeed a slightly different colour 
cast. The cast may well be a by-product of the surrounding light or background 
of the main subject that we shot, regardless of the reason this is something that 
we can work on to improve with a very simple technique that can be seen below 
that I will take you through step by step. It is very simple but also very effective. 
 

In the image above, we have a Ligier Le Mans Race Car that is sat within a clean 
concrete contemporary background. When the Race Car was shot for the client 
it had to be shot at the manufacturer in a safe area with no disturbance so that 
I could shoot and light the car in several different positions over the course of 
about 4 hours. The client wanted the final images to be with the car seated 
within a clean contemporary background, this would allow space for text and 
branding etc This meant that I had to use a different background to ‘create’ the 
scene that the car images would finally be placed into, these backgrounds that 
are used for this purpose are often referred to as ‘backplates’  

You can see with the image below that the layers panel is showing a few little 
tweets and adjustments as the elements are all brought together but the one 
that is important to note here for this run through on ‘Colour Matching’ is the 
very top layer that reads ‘Colour Match Viewer’. This layer is the one that you will 
create that will help you see the actual difference in the colours of your elements 
and help you to blend those together so that they look like they were all shot in 
the same scene.  
 

With TIM WALLACE
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Firstly, you will need to create a new layer and add that to the very top of your 
layer stack. This layer will be stand alone and will not be connected to any other 
layer directly beneath it so that it takes on the values of all the layers beneath. 
Let me show what I mean by that. 

So, let’s start by making the new layer

MENU - LAYER > NEW LAYER 
We will then give this layer a name, here I have called it Colour Matching, that’s 
colour with the British spelling ;) lol I have then selected the options to have the 
blending mode set to ‘Soft Light’ and ticked the option at the very bottom of that 
pop-up window to ‘Fill with Soft-neutral colour (50% grey) Once you have done 
this just click ok and that layer will appear at the top of your stack. 

We now need to change the blending mode of that, but hey I here you shout! 
Why not just set the right blending mode when we created it? Well the reason is 
simply that we are going to choose ‘Luminosity’ and under that option we would 
not have been able to set the 50% grey fill and we need that. 

So with your layer selected now go to blend modes and change that to 
‘Luminosity’. Wooooow – it all got a but funky on the image!

Now its hard to see clearly in a printed workbook while you sip on your skinny 
latte but what you are looking at below is a view that will indicate to you the 
colour tones and hues of all the elements in your image. We will be able to see 
this much clearer in class live when we do this. I have added briefly a further layer 
under the ‘Colour Matching’ top level layer that I have called ‘Global Sat Boost’ 
this is purely a global saturation boost across the entire range of elements and 
layers in the file so that you can see the effect of the ‘Colour Matching’ layer 
at the top of the stack more clearly here. This Sat Boost layer will be removed 
before we finish. 
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So what do we do with this now? 
Well now the magic happens, because what we can now do is start to make 
adjustments to our colour tones in our image elements individually and by using 
the layer filter to view through we will be able to see much more accurately-
which colour tones are out of whack with others and therefore make some local 
layer adjustments on them. 

We might look at the car and note that its mid tones seem to have a lot more 
‘blue’ in them than the surrounding background midtones, so we can start to 
make adjustments by selecting the car layer as in the image below and then 
opting to do adjustment on that using ‘selective colour’ as shown below. Be sure 
to opt for this adjustment from the little icons at the very bottom of your panel 
on the right hand side as shown here. 

NOTE – You need to make sure that your selective colour adjustment layer has 
that little down arrow showing on it to the left, this means that it is only going 
to affect the layer that its connected to directly underneath it. If it has not got 
this then start again by making sure that you click on the layer that you want 
to apply the adjustment to first ‘and then’ click on the adjustment icon at 
the bottom. You can also link unconnected layers with the arrow by having the 
adjustment layer directly placed above the layer that you want to impact on and 
then with your cursor between the two layers hold your ‘ALT KEY’ down for mac 
and click, you will then see the arrow appear connecting those together. 
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Once you have done this you will get the ‘selective colour’ panel display as seen 
here below. This panel lets us adjust lots of the colour groups from red through 
to magenta but also shows us whites, blacks and NEUTRALS, and it is here 
where we are going to start. 

 
 
 
 
 
 

With our NEUTRALS active you can start to move the sliders for the colour 
groups below, Cyan, Magenta, Yellow and the last one showing is Black.  
Now as we said earlier the car had what appeared to be a bit ‘bluer’ than  
the background it was placed into, so let’s start there and move the CYAN  
adjustments down a little. Please note that this is an example of how I do this 
and the theory behind how it works so these are all just example settings. When 
you do this my best advice is to make little adjustments and you will see the 
colour tones start to even out and blend through that layer filter we put into 
place at the top of the stack.

You can also click that on and off so that you can see the image normally in 
colour and see what effect that your changes are having. Start with the neutrals 
first and then the whites, you can opt to impact on individual colours like red or 
blue too if you wish and lastly there is the black option. We will be discussing 
and doing a demo of this live in the class. 
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Just One Flash

This class is for you if you’re not in love with your flash

I imagine, if you’re coming to this class, you probably already 
have a flash, but overall you’re frustrated with flash. You’re 
getting inconsistent results from your flash (sometimes it 
looks at least good, but sometimes it doesn’t seem to work 
right at all, and it’s never awesome) or your flash works, but 
it just looks “OK.” You’re not getting the results you see other 
photographers online are getting, and so you’re just not lov-
ing using flash. If that sounds like you, you’re in the right 
place, because in one hour we’re going to fix all that (and it’s 
easier than you’d think).

I’m going to assume that you already have a hot-shoe flash of 
some sort (either a Nikon, Canon, or maybe a Yongnuo or a 
Phottix), but if you don’t, we’ll talk about inexpensive flashes  
that will do the trick at a really great price in a few minutes.

STEP ONE: GET YOUR FLASH OFF YOUR CAMERA 
You know that awful little pop-up flash on the top of your camera? The one you 
never use because it’s so awful? It’s awful mostly because it’s right on top of 
your camera, which is the worst possible place to put a flash if you want to make 
beautiful, meaningful portraits. Putting a larger, more powerful flash on top of 
your camera just makes the problem worse. It’s brighter, even harsher light in 
the worst possible place to put a flash. So, would you ever put a flash on top of 
your camera? Only if you just need to document who was at an event (i.e., you’re 
shooting a meet-and-greet or someone speaking onstage at a conference). That’s 
pretty much it. So, Step One is that you have to get your flash off the top of 
your camera, so it’s not hitting your subject from directly on top of your camera. 

Scott Kelby
Editor and Publisher of Photoshop User magazine, Lightroom Magazine, and co-host of  

The Grid, the weekly talk show for photographers. 

Scott is President of KelbyOne (an online educational community teaching Photoshop, 
Lightroom, and photography, and organizer of Photoshop World 2019). He is a photog-
rapher, designer, and award-winning author of more than 80 books, including The Flash 
Book; Light It, Shoot It, Retouch It; The Lightroom Classic Book for Digital Photographers; 
How Do I Do That in Lightroom?; The Photoshop Book for Digital Photographers, The 
Photoshop Book for Lightroom Users, and The Digital Photography Book series.

For the six years straight, Scott has been named the #1-bestselling author of photography technique books. His 
books have been translated into dozens of different languages, including Chinese, Russian, Spanish, Korean, Polish, 
Taiwanese, French, German, Italian, Japanese, Dutch, Swedish, Turkish, and Portuguese, among others.

Scott is the Conference Technical Chair for this conference, Training Director for the Adobe Photoshop Seminar 
Tour, and he’s featured in a series of Adobe Photoshop, Lightroom, and photography online courses, and has been 
training Adobe Photoshop users since 1993. For more information on Scott, visit his blog at scottkelby.com.
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Getting the camera off to the side and up higher will create shadows, depth, and 
dimension in your shots. Now, how to do that?

THERE’S A RIGHT WAY AND THE FREE WAY 
While there are a number of ways to trigger your flash, and a number of meth-
ods to control your flash, I’m going to show you the way I do it when I’m shoot-
ing hot-shoe flash. I honestly think it’s the best, most reliable, and easiest way to 
use hot-shoe flash wirelessly—especially for absolute beginners because it’s easy 
to learn, and you’ll get pretty darn consistent results, which is more challenging 
than you might think. Plus, you absolutely want to go “wireless” with this—don’t 
go all “old school” and connect a wire 
because either your or your subject 
are guaranteed to step on that wire 
and break your flash, or you’ll trip and 
break a hip, or both. Probably both. 
Certainly both. Both!

DO NOT TRIGGER YOUR FLASH 
USING YOUR POP-UP FLASH:  
This is the “free way.” If your camera 
has a pop-up flash, you can generally 
use it to trigger your off-camera flash. 
There’s a setting on your camera that 
changes that pop-up flash from a flash that sends out enough light to light your 
subject, to one that instead just sends a tiny “pulse” of light—not enough to light 
your subject, but enough for your off-camera flash to detect it and fire some-
times. Ahhhh, that’s the kicker. It doesn’t always fire. It fires a decent amount of 
the time. It fires a lot when you’re just doing test flashes, but then when you really 
need it, it can be either very sporadic, or just flat not fire 
at all for no apparent reason (it has happened to me more 
times than I can count). That’s why I don’t ever recommend 
using your pop-up flash to trigger your off-camera flash. It 
will only bring you misery.

USE A WIRELESS TRIGGER: 
Instead of dealing with that pop-up flash mess, use a real 
RF wireless trigger and you instantly remove an entire level 
of frustration from your experience because your flash will 
pretty much fire every time. This, by itself, will keep you from 
pulling your hair out, and from looking unprofessional in front 
of your client and/or subject when you can’t get your flash 
to fire consistently. These wireless triggers slide into the hot-
shoe mount on top of your camera, so they’re right there for 
easy access and they help eliminate any temptation to put a 
hot-shoe flash there. Many flashes today have a receiver built 
right in (more on this in a moment), so you might only need 
a single transmitter, not two.

Just One Flash
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Okay, Which Wireless Triggers? 
Option #1: Of course, you can use the ones made by your camera manufacturer 
if you’re using their brand of flash (so, for example, Canon wireless triggers for 
Canon 600RT flashes; these have a receiver built right into the flash, so you only 
need the transmitter). Besides the house brands, the gold standard in wireless 
transmitters has always been PocketWizard—they’re a bit more expensive than 
other options, but they are incredibly solid, have great range, and they just flat 
out work. You don’t have to spring for their top-of-the-line 
transmitters; you can get their PocketWizard Plus X, and 
they’re just $80 each (you need two, so get the bundle deal 
from B&H). They’re simple to use (they only have one but-
ton—a test button). You connect one to your flash (using a 
short cable that comes with the transmitter), and then the 
other one goes in your camera’s hot-shoe mount on the 
top of your camera. Again, you only need these if your flash 
doesn’t have a wireless receiver built into the flash itself.

Other Options: There are so many inexpensive wireless trigger options out there 
today, from Yongnuo to Godox to Impact to the Cactus trigger shown here. Just 
make sure you get one that works with your make and model of camera (and 
below, you’ll learn about one other feature you want your wireless trigger to have 
that will make your flash life easier).

This is probably the main reason your flash looks bad 
It’s because you’re using your flash in TTL mode (also known as iTTL or eTTL). 
Flash manufacturers say TTL is an acronym for “Through The Lens” metering, which 
basically means your flash looks (through the lens) at the exposure for the scene 
you’re about the shoot and automatically sets the proper amount of flash for a bal-
anced exposure. I believe that this is very misleading, and I’m convinced the acro-
nym TTL stands for “Truly Terrible Light.” TTL is there to help beginners and that’s 
the result it creates—it looks like a beginner lit the scene. It’s the most inconsistent, 
bland-looking, mediocre light you’ll ever experience, and just turning TTL off is 
almost guaranteed to give you better results. 

STEP TWO: Do this instead: switch your flash to 
Manual mode That’s right, this is the easiest way 
to get consistent results. Turn off TTL and switch 
your flash to Manual mode. All this means is that 
you take a test shot and if the flash looks too 
bright, you turn it down. If the light from the flash 
isn’t bright enough, you’ll turn the power up a bit. 
That’s it. Simple. Theoretically, TTL mode on your 
flash is supposed to do this for you, and some-
times it works decently, and sometimes it doesn’t 
work at all, and when it doesn’t work, well…now what do you do? Exactly! That’s why 
I shoot in Manual mode. It’s predictable. It’s simple. It works.

Just One Flash
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TIP: Get a Flash Trigger That Controls Your Flash Power Right from the Trigger Itself
Since you’re shooting your flash in Manual mode, you want a flash trigger that lets you 
wirelessly control the power of the flash without having to walk over to the flash unit 
itself and turn the power up and down every time you need to adjust the flash power. 
Instead, you’ll use the power up/down buttons right on your trigger (you’re seeing a 
Phottix Odin II trigger here, used for triggering Phottix wireless flashes that have a built-
in wireless receiver right in the flash itself). Now you 
can change the power of your flash and turn it on/
off, all without leaving your shooting position. That’s 
freakin’ awesome.

STEP THREE: Setting Your Flash Power 
If we’re using our flash anywhere indoors, we’re going 
to keep our flash power set very low. My starting 
point indoors is to set my power at 25% power. I know 
that seems incredibly low, but even at 25%, it may be 
more than you need; you might need to go down to 1/8 power. One of the biggest mis-
takes I see when people use off-camera flash like this is that their flash is too bright, and 
the shot looks “flashy.” Your goal is to make the light look natural, soft, and beautiful, like 
light from a north-facing window. Not a bright beam like you’re lighting your subject with a 
Coleman Rechargeable Worklamp from Home Depot. So, that’s our setting (even outdoors, 
I still start at 25% and chances are I’ll leave it there, or pretty darn close to it).

STEP FOUR: Making the Light Soft & Beautiful 
All flashes, no matter which brand you buy, are going to give you a bright, harsh flash 
of light, so it’s not so much about the brand of flash as 
it is what you put in front of that flash to make it soft 
and beautiful. I use two different modifiers: a relatively 
small one for everyday use, and a much larger one for 
those times where, for the particular subject I’m shoot-
ing, I need really super-mega soft, creamy light. That, or 
I’m shooting more than one person (a couple, wedding 
formals, a family portrait, etc.). Of course, you can also 
just use a $9 1-stop diffuser and shoot your flash through 
that to make it soft. Will that really work? Like a boss!

Option #1 — The Westcott 26” Rapid Box Octa:  
Hands down the easiest, most portable, just darn best 
pop-up softbox I’ve ever used for flash. These things 
are a miracle of engineering, and I cannot recommend 
them enough (ask anybody who owns one). So small 
and lightweight, and they set up in like 90 seconds 
from start to finish, which is pretty amazing. They’re 
very sturdy and well made, and I know I’m gushing 
here, but I’ve been searching for the perfect flash soft-
box for many years, and I’ve finally found it. Around 
$149 at B&H Photo.

Just One Flash
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Option #2 — The Westcott 7’ Parabolic White Diffusion Umbrella:  
This bad boy is huge! It’s 7’ of soft, beautiful light, and it folds into an umbrella 
so it’s incredibly portable. If you need to light anything, from a group shot to full-
length fashion, this will get the job done, and believe it or not, you can get it in a 
kit from B&H Photo with a light stand to hold it, and a tilt bracket, and a hot-shoe 
adapter to hold your flash, all for $99 (at least that’s the price I saw on the day 
I wrote this workbook). Come on, under $100 for a kit with all that? That is just 
insane!

AN INEXPENSIVE ONE-FLASH SETUP 
Okay, just a quick checklist of what we need equipment-wise: 

> A hot-shoe flash of some kind.
> A wireless trigger that lets you change the power of the flash.
> �Something to make the light soft (either a 1-stop diffuser, or a Rapid Box 

Octa, or a parabolic umbrella).
> A light stand to hold your flash and softbox.

You probably already have a flash, so all you’ll need is a wireless trigger, a 
softbox, and a light stand. Less than $220 and you’ve got a slick flash pho-
tography rig. Not bad.

STEP FIVE: CAMERA SETTINGS FOR FLASH 
When it comes to your camera settings, everybody’s gotta have a starting place, 
right? Well, when I’m shooting hot-shoe flash, I pick the same starting place for my 
settings every time. It’s amazingly simple—just three simple settings: 

FIRST, SET YOUR CAMERA TO MANUAL MODE: because we’re going to need 
to set the shutter speed and f-stop separately. If you’ve never used Manual mode 
before, don’t sweat it. This is going to be really easy, because these are pretty 
much “set it and forget it” type of settings.

Just One Flash
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(1) SET YOUR SHUTTER SPEED TO: 1/125 of a second. 
Not only is this a good, safe starting point for your shutter speed, but if you’re 
shooting indoors, you won’t change this setting at all. You set it at 1/125 of a sec-
ond and forget it. Just an FYI: If you go above 1/250 of a second, your flash gets 
out of sync with your camera and you’ll see a black gradient appear along the 
bottom of your image. The higher above 1/250 you go, the higher that gradient 
goes, so staying at 1/125 of a second totally keeps you out of trouble. 

(2) SET YOUR F-STOP TO: f/5.6 
Everybody’s gotta have a starting place, and this is mine. It gives you a little 
breathing room if you need to move your setting up/down (although I rarely 
change it), and if you zoom in on your subject with a long lens at f/5.6, you’ll still 
have a nice, soft, out-of-focus background behind your subject.

(3) SET YOUR ISO TO: 100 ISO 
Well, that or whatever the cleanest native ISO of your camera is (some might be 
50 ISO; some older Nikons, for example, are 200 ISO— it just depends on the make 

and model of your camera, but if you’re not sure, just choose 100 ISO).

REMINDER: SET YOUR FLASH POWER to 1/4 POWER 
For shooting indoors, my starting place is 1/4 power (as I mentioned earlier). 
It’s almost time to take a test shot, but first, we need to know where to put the 
softbox in relation to our subject. 

NOTE: If you’re shooting by yourself (meaning 
no assistant or friend to help out with the shoot), 
you’ll want to mount your flash and softbox on a 
light stand. The Rapid Box Octa comes with a tilt 
bracket and flash mount that fit right on top of 
any standard light stand. However, if you either 
have a friend (or assistant), or you’re shooting 
on location, or you’re “running and gunning” at 
a wedding, I would recommend mounting your 
flash and softbox rig either on the end of a mono-
pod (like Impact’s Impact QuikStik Telescopic 
Handle for $44) or on the end of a regular ol’ 
painter’s pole—the kind you buy at Home Depot 
or Lowe’s (you can get a little adapter from B&H Photo, called the ClickSnap 
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ProPole Painters Pole Adapter, for $21 that is designed to let you easily mount a 
flash head and/or softbox to a painter’s pole).

WHERE TO POSITION YOUR SOFTBOX 
It’s one of the most-asked ques-
tions I get about lighting. Luckily, 
it’s pretty easy to answer.

POSITION #1: Probably the most 
popular place to position your 
softbox is in front of your subject, 
but to the side at a 45° angle from 
them (as shown here at right). This 
creates some nice shadows on the 
far side of your subject’s face, and 
these shadows help create depth 
and dimension. If your subject was 
at the center of a clock, and you’re 
shooting from 6:00, you’d want 
your light over around 7:30 (as 
seen here). This is a very flattering 
lighting position for most people, 
so it’s not surprising it’s the most 
popular.  Also, remember, we’re try-
ing to give the impression of natu-
ral light, so the light should be up 
high—higher than your subject, and 
aiming down at them, like natural 
light from the sky would fall.

POSITION #2: If you want more 
shadows on other side of your 
subject’s face, then rotate your 
softbox back closer to the side 
of your subject, to around 8:00 
(as seen here). This makes more 
shadows on the other side of 
her face, and a more dramatic 
look. The closer you get to 9 :00 
(where her face would be lit just 
on that side, and the other side 
of her face would be completely 
in shadow—called “split lighting”), 
the more shadows you get.

POSITION #3: Positioning the light 
directly in front of your subject (and 
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you ducking down under it), minimizes the shadows on their face (now you’ll really just 
have shadows under the chin). So, you’re shooting from around 6:00 on the clock face, 
and your light is right there, too. It’s a flatter look (less depth and dimension), but it 
can be very flattering for some people (like people with facial wrinkles). So, if shooting 
right in front (at 6:00) gets rid of shadows, what if you wanted a little bit of shadow? 
Rotate around to 6:30 or 7:00. The more you rotate around that imaginary clock face, 
the more shadows you get.

POSITION #4: Well, the light’s really in 
the same position for this one, but to 
take the straight-on shot a step further, 
you could fill in the shadows under your 
subject’s chin and under their eyes by 
putting a circular silver reflector right 
in front of your subject, aiming slightly 
up at their face to bounce some of that 
light from your light in front back into 
their face. That does a great job of fill-
ing in those shadow areas.

POSITION #5:  
This is a trick we use to get even 
softer light from our softbox. First, the 
closer the light is to our subject, the 
softer the light becomes (of course, it 
becomes brighter, too, so if you move 
the light really close to get really soft, 
you’ll probably have to drop the power 
of the flash down to 1/4 power). The 
other trick is a positioning trick called 
“feathering” the light, which is based 
on the fact that flash is in the center 
of our softbox, so our “hot spot” (the 
brightest, harshest area) will be right 
in the center where that flash is. The 
closer you get to the edges of the softbox, the softer the light gets. Take a look 
at the diagram here. Notice how my subject is at the very back of the softbox? It 
looks like the light is aimed right past her, but that’s what we’re trying to do—let 
the harder center of the flash blow right past her, and the softer light on the edge 
is what winds up illuminating our subject. This is feathering the light. Although I 
like to put the light right beside my subject like this, you can feather any light, just 
aim it past your subject so just the edge of the light from the softbox hits them.

STEP SEVEN: DO A TEST SHOT AND EVALUATE THE BRIGHTNESS OF THE FLASH 
Now the fun, easy part begins. Your flash is in position, your softbox is making 
the light soft, your camera settings are in place (f/5.6, 1/125 shutter speed, 100 
ISO), and now it’s time to take a test shot. Take your shot and look at the image 
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on the back of your camera; in particular, look at the brightness of the flash. If it’s 
too bright, go to the wireless transmitter on the top of your camera and take the 
power down a little bit, then take another test shot. Make sure the light isn’t too 
bright or it will look too “flashy.” It should look natural and beautiful. If the light 
isn’t bright enough, raise it up a little bit and take another test shot. It might take 
three or four test shots before you dial in just the right brightness, but once you 
do, stop messing with the flash and start working with your subject to get expres-
sion and connection and emotion.

LOCATION FLASH
So far, everything we’ve done has been in a controlled environment, using a  
pop-up background where the only thing lighting our subject is the flash. I greatly 
prefer to shoot location flash later in the day, and if you’re shooting an hour or so 
before sunset, you can keep your flash power at the same 1/4 power setting. If it’s 
earlier in the day, you might have to crank it up to 1/2 power or more, but just be 
careful not to get too bright or, again, the light will look “flashy.”
  When we go on location, three things change:

Change #1 - We position 
our subject with their back 
toward the sun.

Change #2 - Underexposing 
for the scene:  
Here’s what I do: I’m still in 
Manual mode on my camera; 
still at f/5.6; still at 1/125 of a 
second on my flash, still at 100 
ISO. I turn my flash off and try 
to get a regular exposure as if I had no flash at all by just changing my f-stop. I use 
the meter inside my viewfinder (shown circled here) to get my exposure right at 
the center of the range (when that white bar in the center is in the center; that’s 
the proper non-flash exposure). Then, I intentionally underexpose the scene by a 
stop or two (which makes the sky and background darker and richer) so the flash 
does most of the lighting on my subject, and not the existing light. In other words, 
I don’t want the existing light outside to be what lights my subject; I want my flash 
to be what lights my subject. My goal at this point is to make my subject look like 
a silhouette with whatever light source (usually the sun) positioned behind them. 
Only then do I turn my flash on at 1/4 power.
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Change #3 - Controlling the Ambient Light:  
Your goal is to make the light from your flash look natural and balanced with the 
existing light in the room or on location. Believe it or not, you can control the 
amount of existing light (called “ambient light”) that appears in your shot by rais-
ing or lowering the shutter speed. For example, if you’re at 1/125 of a second and 
you take a test shot, and the background behind your subject seems too bright, 
you can raise the shutter speed to 1/200 of a second. Now the area gets darker. 
You can go as high as 1/250 with a hot-shoe flash if you need to. If you want 
more light in the scene instead, you can lower the shutter speed from your start-
ing place of 1/125 down to 1/60 or 1/30, then take a test shot. It’ll take a few test 
shots to find that perfect balance where the existing outdoor light and the flash 
both look natural, but at least you now know how to control it.

PUTTING IT ALL TOGETHER: 
Okay, here’s the whole three-step process: 
Step One: Position the subject with the sun at their back. Find out the  
regular daylight exposure.
Step Two: Underexpose those settings by two f-stops (or even more) to darken 
the available light and make your subject look like a silhouette.
Step Three: Now turn on your flash on, set the power at a low power setting (like  
1/4 power), and do a test shot. Then adjust the power of your flash if it’s too bright 
or dark. That’s it!

ADDING A GEL FOR A MORE NATURAL LOOK ON 
LOCATION
We are used to seeing white light indoors. We don’t 
think a second thing about it, but when we move out-
doors, white light suddenly looks odd and out of place. 
It screams, “I used a flash.” That’s why, when I go on 
location, I always put a thin piece of orange gel over the 
front of my flash. Besides just making the light look more 
natural, gels give skin a more natural look. The later in 
the day you’re shooting, the yellower the light.

You can buy large sheets of this orange gel in different 
thicknesses (called CTO [Color Temperature Orange] “cuts”) and then trim them 
down so they’re a little larger than the head of your flash. B&H Photo sells 21x24" 
sheets of Rosco E-Colour #206 1/4 CT Orange gel for just $7.95 a sheet. Get a 
pair of scissors, cut ‘em out, and then leave a 1/40-cut gel taped (with gaffer’s 
tape) over the front of your flash any time you use your flash outdoors. As it gets 
later in the day, and the existing light outside gets warmer and more orange, put 
another 1/4-cut over that (to get a 1/2-cut total) to make your light appear more 
orange and match the surroundings, yet still look natural. Right around sunset, you 
might need to add another layer of gel, or maybe two. In short, don’t let the light 
from your flash ever turn white on location—it needs to match the basic color of 
the sun and your surroundings as the sun goes down. 
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